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Executive Summary 1 

For decades, cybersecurity attacks have highlighted the dangers of having computers with unpatched 2 
software. Even with widespread awareness of these dangers, however, keeping software up-to-date 3 
with patches remains a problem. Deciding how, when, and what to patch can be difficult for any 4 
organization. Each organization must balance security with mission impact and business objectives by 5 
using a risk-based methodology. To address these challenges, the NCCoE is collaborating with 6 
cybersecurity technology providers to explore approaches for improving enterprise patching practices 7 
for general information technology (IT) systems. These practices are intended to help your organization 8 
improve its security and reduce the likelihood of data breaches with sensitive personal information and 9 
other successful compromises. The practices can also play an important role as your organization 10 
embarks on a journey to zero trust. 11 

CHALLENGE 12 

There are a few root causes for many data breaches, malware infections, ransomware attacks, and other 13 
security incidents, and known—but unpatched—vulnerabilities in software is one of them. 14 
Implementing a few security hygiene practices, such as patching operating systems, applications, and 15 
firmware, can prevent many incidents from occurring, lowers the potential impact of incidents that do 16 
occur, and increases the cost to the attacker. Unfortunately, security hygiene is easier said than done. 17 
Despite widespread recognition that patching is effective and attackers regularly exploit unpatched 18 
software, many organizations do not adequately patch. There are myriad reasons why, not the least of 19 
which are that it’s resource-intensive and that the act of patching can reduce system and service 20 
availability. Many organizations struggle to prioritize patches, test patches before deployment, and 21 
adhere to policies for how quickly patches are applied in different situations. Delaying patch deployment 22 
gives attackers a larger window of opportunity.  23 

This practice guide can help your organization: 
 overcome common obstacles involving enterprise patching for general IT 

systems 

 achieve a comprehensive security hygiene program based on existing standards, 
guidance, and publications 

 enhance its recovery from incidents that occur, and minimize the impact of 
incidents on the organization and its constituents 

 

SOLUTION 24 

To address these challenges, the NCCoE is collaborating with cybersecurity technology providers to 25 
develop an example solution. It will demonstrate how tools can be used to 1) implement the inventory 26 
and patching capabilities organizations need to handle both routine and emergency patching situations, 27 
as well as 2) implement workarounds, isolation methods, or other alternatives to patching. The solution 28 
will also demonstrate recommended security practices for patch management systems themselves. 29 
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The NCCoE is assembling existing commercial and open source tools to aid with the most challenging 30 
aspects of patching. The NCCoE is building upon previous NIST work documented in NIST Special 31 
Publication (SP) 800-40 Revision 3, Guide to Enterprise Patch Management Technologies and NIST SP 32 
800-184, Guide for Cybersecurity Event Recovery.  33 

Collaborator Security Capability or Component 

 
 

Asset discovery and inventory; network access control; network 
policy enforcement 

 
 

Hardware and firmware inventory; firmware vulnerability 
assessment; firmware integrity monitoring; firmware software 
updates 

 
 

Asset discovery and inventory; security policy enforcement 

 
 

Asset inventory; configuration management; software updates; 
vulnerability scanning for source code as part of a DevOps pipeline 

 
Security policy enforcement; vulnerability scanning and reporting; 
software discovery and inventory; firmware vulnerability assessment 
and policy enforcement  
 

 
 

Asset discovery; configuration management; software updates 

 
 

Asset discovery and inventory; vulnerability scanning and reporting 

 
Vulnerability scanning and remediation; configuration management; 
software updates 

 

While the NCCoE is using commercial and open source products to address this challenge, the practice 34 
guide will not endorse these particular products, nor will it guarantee compliance with any regulatory 35 
initiatives. Your organization's information security experts should identify the products that will best 36 
integrate with your existing tools and IT system infrastructure. Your organization can adopt this solution 37 
or one that adheres to these guidelines in whole, or you can use this guide as a starting point for 38 
tailoring and implementing parts of a solution. 39 

HOW TO USE THIS GUIDE 40 

Depending on your role in your organization, you might use this guide in different ways: 41 
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Business decision makers, including chief information security and technology officers can use this 42 
part of the guide, NIST SP 1800-31A: Executive Summary, to understand the drivers for the guide, the 43 
cybersecurity challenge we address, our approach to solving this challenge, and how the solution could 44 
benefit your organization. Business decision makers can also use NIST SP 800-40 Revision 4 (Draft), 45 
Guide to Enterprise Patch Management Planning: Preventive Maintenance for Technology. It 46 
complements the implementation focus of this guide by recommending creation of an enterprise 47 
strategy to simplify and operationalize patching while also reducing risk.    48 

Technology, security, and privacy program managers who are concerned with how to identify, 49 
understand, assess, and mitigate risk can use NIST SP 1800-31B: Security Risks and Capabilities, which 50 
describes what we built and why, including the risk analysis performed and the security capabilities 51 
provided by the example implementation. NIST SP 800-40 Revision 4 (Draft), Guide to Enterprise Patch 52 
Management Planning: Preventive Maintenance for Technology may also be helpful. 53 

IT professionals who want to implement an approach like this can make use of NIST SP 1800-31C: How-54 
To Guides, which provide specific product installation, configuration, and integration instructions for 55 
building the example implementation, allowing you to replicate all or parts of this project.  56 

SHARE YOUR FEEDBACK 57 

You can view or download the guide at https://www.nccoe.nist.gov/projects/building-blocks/patching-58 
enterprise. Help the NCCoE make this guide better by sharing your thoughts with us as you read the 59 
guide. If you adopt this solution for your own organization, please share your experience and advice 60 
with us. We recognize that technical solutions alone will not fully enable the benefits of our solution, so 61 
we encourage organizations to share lessons learned and best practices for transforming the processes 62 
associated with implementing this guide. 63 

To provide comments or to learn more by arranging a demonstration of this example implementation, 64 
contact the NCCoE at cyberhygiene@nist.gov. 65 

 
COLLABORATORS 66 

Collaborators participating in this project submitted their capabilities in response to an open call in the 67 
Federal Register for all sources of relevant security capabilities from academia and industry (vendors 68 
and integrators). Those respondents with relevant capabilities or product components signed a 69 
Cooperative Research and Development Agreement (CRADA) to collaborate with NIST in a consortium to 70 
build this example solution. 71 

Certain commercial entities, equipment, products, or materials may be identified by name or company 72 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 73 
experimental procedure or concept adequately. Such identification is not intended to imply special 74 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 75 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 76 
for the purpose. 77 

https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
https://www.nccoe.nist.gov/projects/building-blocks/patching-enterprise
https://www.nccoe.nist.gov/projects/building-blocks/patching-enterprise
mailto:cyberhygiene@nist.gov
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DISCLAIMER 1 

Certain commercial entities, equipment, products, or materials may be identified by name or company 2 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 3 
experimental procedure or concept adequately. Such identification is not intended to imply special sta-4 
tus or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it in-5 
tended to imply that the entities, equipment, products, or materials are necessarily the best available 6 
for the purpose. 7 

 

National Institute of Standards and Technology Special Publication 1800-31B, Natl. Inst. Stand. Technol. 8 
Spec. Publ. 1800-31B, 49 pages, (November 2021), CODEN: NSPUE2 9 

 

FEEDBACK 10 

You can improve this guide by contributing feedback. As you review and adopt this solution for your 11 
own organization, we ask you and your colleagues to share your experience and advice with us.  12 

Comments on this publication may be submitted to: cyberhygiene@nist.gov. 13 

Public comment period: November 17, 2021 through January 10, 2022 14 

All comments are subject to release under the Freedom of Information Act. 15 

 

 

 

 

 

 

National Cybersecurity Center of Excellence 16 
National Institute of Standards and Technology 17 

100 Bureau Drive 18 
Mailstop 2002 19 

Gaithersburg, MD 20899 20 
Email: nccoe@nist.gov   21 

mailto:cyberhygiene@nist.gov
mailto:nccoe@nist.gov
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 22 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 23 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 24 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 25 
public-private partnership enables the creation of practical cybersecurity solutions for specific 26 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 27 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 28 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 29 
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity 30 
solutions using commercially available technology. The NCCoE documents these example solutions in 31 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 32 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 33 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 34 
Maryland. 35 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 36 
https://www.nist.gov. 37 

NIST CYBERSECURITY PRACTICE GUIDES 38 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 39 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 40 
adoption of standards-based approaches to cybersecurity. They show members of the information 41 
security community how to implement example solutions that help them align with relevant standards 42 
and best practices, and provide users with the materials lists, configuration files, and other information 43 
they need to implement a similar approach. 44 

The documents in this series describe example implementations of cybersecurity practices that 45 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 46 
or mandatory practices, nor do they carry statutory authority.  47 

ABSTRACT 48 

Despite widespread recognition that patching is effective and attackers regularly exploit unpatched 49 
software, many organizations do not adequately patch. There are myriad reasons why, not the least of 50 
which are that it’s resource-intensive and that the act of patching can reduce system and service 51 
availability. Also, many organizations struggle to prioritize patches, test patches before deployment, and 52 
adhere to policies for how quickly patches are applied in different situations. To address these 53 
challenges, the NCCoE is collaborating with cybersecurity technology providers to develop an example 54 
solution that addresses these challenges. This NIST Cybersecurity Practice Guide explains how tools can 55 
be used to implement the patching and inventory capabilities organizations need to handle both routine 56 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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and emergency patching situations, as well as implement workarounds, isolation methods, or other 57 
alternatives to patching. It also explains recommended security practices for patch management 58 
systems themselves. 59 

KEYWORDS 60 

cyber hygiene; enterprise patch management; firmware; patch; patch management; software; update; 61 
upgrade; vulnerability management 62 
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Technology Partner/Collaborator Build Involvement 
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Cisco Identity Services Engine (ISE) 

Eclypsium Eclypsium Administration and Analytics Service 
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DOCUMENT CONVENTIONS  70 

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the 71 
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that 72 
among several possibilities, one is recommended as particularly suitable without mentioning or 73 
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in 74 
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms 75 
“may” and “need not” indicate a course of action permissible within the limits of the publication. The 76 
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal. 77 

CALL FOR PATENT CLAIMS 78 

This public review includes a call for information on essential patent claims (claims whose use would be 79 
required for compliance with the guidance or requirements in this Information Technology Laboratory 80 
(ITL) draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication 81 

https://www.cisco.com/
https://eclypsium.com/
https://www.forescout.com/
https://www.ibm.com/
https://www.lookout.com/
https://www.microsoft.com/
https://www.tenable.com/
https://vmware.com/
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or by reference to another publication. This call also includes disclosure, where known, of the existence 82 
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant 83 
unexpired U.S. or foreign patents. 84 

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in writ-85 
ten or electronic form, either: 86 

a) assurance in the form of a general disclaimer to the effect that such party does not hold and does not 87 
currently intend holding any essential patent claim(s); or 88 

b) assurance that a license to such essential patent claim(s) will be made available to applicants desiring 89 
to utilize the license for the purpose of complying with the guidance or requirements in this ITL draft 90 
publication either: 91 

1. under reasonable terms and conditions that are demonstrably free of any unfair discrimination; 92 
or  93 

2. without compensation and under reasonable terms and conditions that are demonstrably free 94 
of any unfair discrimination.  95 

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its 96 
behalf) will include in any documents transferring ownership of patents subject to the assurance, provi-97 
sions sufficient to ensure that the commitments in the assurance are binding on the transferee, and that 98 
the transferee will similarly include appropriate provisions in the event of future transfers with the goal 99 
of binding each successor-in-interest.  100 

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of 101 
whether such provisions are included in the relevant transfer documents.  102 

Such statements should be addressed to: cyberhygiene@nist.gov  103 
  

mailto:cyberhygiene@nist.gov


DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems viii 

Contents 104 

1 Summary .............................................................................................. 1 105 

1.1 Challenge ....................................................................................................................... 1 106 

1.2 Solution.......................................................................................................................... 2 107 

1.3 Benefits .......................................................................................................................... 2 108 

2 How to Use This Guide ......................................................................... 2 109 

2.1 Typographic Conventions .............................................................................................. 4 110 

3 Approach ............................................................................................. 5 111 

3.1 Audience ........................................................................................................................ 5 112 

3.2 Scope ............................................................................................................................. 5 113 

3.3 Assumptions .................................................................................................................. 6 114 

3.4 Scenarios ....................................................................................................................... 6 115 

3.4.1 Scenario 0: Asset identification and assessment .......................................................... 6 116 

3.4.2 Scenario 1: Routine patching ........................................................................................ 6 117 

3.4.3 Scenario 2: Routine patching with cloud delivery model ............................................. 7 118 

3.4.4 Scenario 3: Emergency patching ................................................................................... 7 119 

3.4.5 Scenario 4: Emergency workaround (and backout if needed) ..................................... 7 120 

3.4.6 Scenario 5: Isolation of unpatchable assets.................................................................. 7 121 

3.4.7 Scenario 6: Patch management system security (or other system with administrative 122 
privileged access) .......................................................................................................... 8 123 

3.5 Risk Assessment ............................................................................................................ 8 124 

3.5.1 Threats, Vulnerabilities, and Risks ................................................................................ 8 125 

3.5.2 Security Control Map .................................................................................................... 9 126 

4 Components of the Example Solution ................................................ 13 127 

4.1 Collaborators ............................................................................................................... 13 128 

4.1.1 Cisco ............................................................................................................................ 13 129 

4.1.2 Eclypsium .................................................................................................................... 13 130 

4.1.3 Forescout .................................................................................................................... 13 131 

4.1.4 IBM .............................................................................................................................. 14 132 



DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems ix 

4.1.5 Lookout ....................................................................................................................... 14 133 

4.1.6 Microsoft ..................................................................................................................... 14 134 

4.1.7 Tenable ....................................................................................................................... 15 135 

4.1.8 VMware ....................................................................................................................... 15 136 

4.2 Technologies ................................................................................................................ 15 137 

4.2.1 Cisco Firepower Threat Defense (FTD) & Firepower Management Center (FMC) ..... 17 138 

4.2.2 Cisco Identity Services Engine (ISE) ............................................................................. 17 139 

4.2.3 Eclypsium Administration and Analytics Service ........................................................ 17 140 

4.2.4 Forescout Platform ..................................................................................................... 18 141 

4.2.5 IBM Code Risk Analyzer .............................................................................................. 19 142 

4.2.6 IBM MaaS360 with Watson ........................................................................................ 19 143 

4.2.7 Lookout ....................................................................................................................... 20 144 

4.2.8 Microsoft Endpoint Configuration Manager ............................................................... 20 145 

4.2.9 Tenable.io ................................................................................................................... 20 146 

4.2.10 Tenable.sc and Nessus ................................................................................................ 20 147 

4.2.11 VMware vRealize Automation SaltStack Config ......................................................... 21 148 

Appendix A Patch Management System Security Practices .................... 22 149 

A.1 Security Measures ....................................................................................................... 22 150 

A.2 Component Support of Security Measures ................................................................. 26 151 

A.2.1 Cisco FTD Support of Security Measures .................................................................... 26 152 

A.2.2 Cisco ISE Support of Security Measures...................................................................... 28 153 

A.2.3 Eclypsium Administration and Analytics Service Support of Security Measures ....... 30 154 

A.2.4 Forescout Platform Support of Security Measures..................................................... 32 155 

A.2.5 IBM Code Risk Analyzer Support of Security Measures .............................................. 34 156 

A.2.6 IBM MaaS360 with Watson Support of Security Measures ....................................... 37 157 

A.2.7 Lookout MES Support of Security Measures .............................................................. 38 158 

A.2.8 Microsoft Endpoint Configuration Manager (ECM) Support of Security Measures ... 40 159 

A.2.9 Tenable.sc Support of Security Measures .................................................................. 42 160 

A.2.10 VMware vRealize Automation SaltStack Config Support of Security Measures ......... 44 161 

Appendix B List of Acronyms .................................................................. 47 162 



DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems x 

 

List of Tables 163 

Table 3-1: Mapping Security Characteristics of the Example Solution for Scenarios 0-5 ...................... 10 164 

Table 3-2: Mapping Security Characteristics of the Example Solution for Scenario 6 ........................... 12 165 

Table 4-1: Technologies Used in the Build ......................................................................................... 16 166 

 

 



DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems 1 

1 Summary 167 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 168 
Technology (NIST) recognizes the challenges that organizations face in keeping software up to date with 169 
patches. Patches correct security and functionality problems in software and firmware. From a security 170 
perspective, patches are most often of interest because they are mitigating software flaw vulnerabilities; 171 
applying patches to eliminate these vulnerabilities significantly reduces the opportunities for 172 
exploitation. 173 

Patches serve other purposes than just fixing software flaws; they can also add new features to software 174 
and firmware, including security capabilities. Sometimes there are alternatives to patches, such as 175 
temporary workarounds involving software or security control reconfiguration, but these workarounds 176 
are not permanent fixes and they may impact functionality. 177 

The NCCoE developed the Critical Cybersecurity Hygiene: Patching the Enterprise (Patching) project to 178 
provide approaches for improving enterprise patching practices for general information technology (IT) 179 
systems. The aim is to help organizations balance security with mission impact and business objectives. 180 

This project utilizes commercial tools to aid with functions that include asset discovery characterization 181 
and prioritization, and patch implementation tracking and verification. It includes actionable and 182 
prescriptive guidance on establishing policies and processes for the entire patching lifecycle. This 183 
volume explains why we built the example solution to address patching challenges, including the risk 184 
analysis we performed and the security capabilities that the example solution provides. 185 

1.1 Challenge  186 

There are a few root causes for many data breaches, malware infections such as ransomware, and other 187 
security incidents, and known—but unpatched—vulnerabilities in software are one of them. 188 
Implementing a few security hygiene practices, such as patching operating systems, applications, and 189 
firmware, can address those root causes. That prevents many incidents from occurring by minimizing 190 
the attack surface and lowers the potential impact of incidents that occur. In other words, security 191 
hygiene practices make it harder for attackers to succeed and reduce the damage they can cause.  192 

Unfortunately, security hygiene is easier said than done. Despite widespread recognition that (a) 193 
patching is effective and (b) attackers regularly exploit unpatched software, many organizations do not 194 
adequately patch. There are myriad reasons why, not the least of which are that it is resource-intensive 195 
and that the act of patching is perceived to reduce system and service availability. However, delaying 196 
patch deployment gives attackers a larger window of opportunity to take advantage of the exposure. 197 
Many organizations struggle to inventory their assets, prioritize patches, have defined and consistent 198 
process and procedures for deployment, and adhere to policies and metrics for how quickly patches are 199 
applied in different situations. Also, deploying enterprise patch management tools that operate with 200 
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privileged access within an enterprise can itself create additional security risks for an organization if the 201 
tools are not secured properly. 202 

1.2 Solution 203 

To address these challenges, the NCCoE is collaborating with cybersecurity technology providers to 204 
develop an example solution. It will demonstrate how tools can be used to 1) implement the inventory 205 
and patching capabilities organizations need to handle both routine and emergency patching situations, 206 
as well as 2) implement workarounds, isolation methods, or other alternatives to patching. The solution 207 
will also demonstrate recommended security practices for protecting the patch management systems 208 
themselves against threats. 209 

This draft covers both phases of the example solution, which involves patching, updating, and 210 
configuring two types of general IT assets. Phase 1 focuses on desktop and laptop computers and on-211 
premises servers, and phase 2 adds mobile devices and containers. 212 

The NCCoE has also created a companion publication, NIST Special Publication (SP) 800-40 Revision 4 213 
(Draft), Guide to Enterprise Patch Management Planning: Preventive Maintenance for Technology. It 214 
complements the implementation focus of this guide by recommending creation of an enterprise 215 
strategy to simplify and operationalize patching while also reducing risk. 216 

1.3 Benefits 217 

The demonstrated approach offers several benefits to organizations that implement it, including the 218 
following: 219 

 Vulnerabilities in the organization’s IT systems that are susceptible to cyber attacks are 220 
addressed more quickly, which reduces risk and lowers the likelihood of an incident occurring. 221 

 Increased automation provides a traceable and repeatable process and leads to a decrease in 222 
hours worked by the organization’s security administrators, system administrations, and others 223 
who have patching responsibilities. 224 

 It improves compliance with laws, regulations, mandates, local organization policy, and other 225 
requirements to keep the organization’s software patched. 226 

 The practices it demonstrates can play an important role as your organization embarks on a 227 
journey to zero trust. 228 

2 How to Use This Guide 229 

This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and provides 230 
users with the information they need to replicate the proposed approach for improving enterprise 231 

https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
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patching practices for general IT systems. This design is modular and can be deployed in whole or in 232 
part. 233 

This guide contains three volumes: 234 

 NIST SP 1800-31A: Executive Summary – why we wrote this guide, the challenge we address, 235 
why it could be important to your organization, and our approach to solving the challenge 236 

 NIST SP 1800-31B: Security Risks and Capabilities – why we built the example implementation, 237 
including the risk analysis performed and the security capabilities provided by the 238 
implementation (you are here) 239 

 NIST SP 1800-31C: How-To Guides – what we built, with instructions for building the example 240 
implementation, including all the details that would allow you to replicate all or parts of this 241 
project 242 

Depending on your role in your organization, you might use this guide in different ways: 243 

Business decision makers, including chief security and technology officers, will be interested in the 244 
Executive Summary, NIST SP 1800-31A, which describes the following topics: 245 

 challenges that enterprises face in mitigating risk from software vulnerabilities 246 

 example solution built at the NCCoE 247 

 benefits of adopting the example solution 248 

Business decision makers can also use NIST SP 800-40 Revision 4 (Draft), Guide to Enterprise Patch 249 
Management Planning: Preventive Maintenance for Technology.  250 

Technology or security program managers who are concerned with how to identify, understand, assess, 251 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-31B, which describes what we 252 
did and why. The following sections will be of particular interest: 253 

 Section 3.5.1, Threats, Vulnerabilities, and Risks, provides a description of the risk analysis we 254 
performed. 255 

 Section 3.5.2, Security Control Map, maps the security characteristics of this example solution to 256 
cybersecurity standards and best practices. 257 

You might share the Executive Summary, NIST SP 1800-31A, with your leadership team members to help 258 
them understand the importance of adopting standards-based, automated patch management. Also, 259 
NIST SP 800-40 Revision 4 (Draft), Guide to Enterprise Patch Management Planning: Preventive 260 
Maintenance for Technology may be helpful to you and your leadership team. 261 

IT professionals who may be interested in implementing an approach similar to ours will find the entire 262 
practice guide useful. In particular, the How-To portion of the guide, NIST SP 1800-31C could be used to 263 
replicate all or parts of the build created in our lab. Furthermore, the How-To portion of the guide 264 
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provides specific product installation, configuration, and integration instructions for implementing the 265 
example solution. We have omitted the general installation and configuration steps outlined in 266 
manufacturers’ product documentation since they are typically made available by manufacturers. 267 
Instead, we focused on describing how we incorporated the products together in our environment to 268 
create the example solution. 269 

This guide assumes that the reader of this document is a seasoned IT professional with experience in 270 
implementing security solutions within an enterprise setting. While we have used a suite of commercial 271 
products to address this challenge, this guide does not endorse these particular products. Your 272 
organization can adopt this solution or one that adheres to these guidelines in whole, or you can use this 273 
guide as a starting point for tailoring and implementing parts of an automated enterprise patch 274 
management system. Your organization’s security experts should identify the products that will best 275 
integrate with your existing tools and IT system infrastructure. We hope that you will seek products that 276 
are congruent with applicable standards and recommended practices. Section 4.2, Technologies, lists 277 
the products we used and maps them to the cybersecurity controls provided by this example solution. 278 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 279 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 280 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 281 
cyberhygiene@nist.gov. 282 

2.1 Typographic Conventions 283 

The following table presents typographic conventions used in this volume. 284 

Typeface/Symbol Meaning Example 

Italics file names and path names; references 
to documents that are not hyperlinks; 
new terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, command 
buttons, and fields 

Choose File > Edit. 

Monospace command-line input, onscreen 
computer output, sample code 
examples, and status codes 

mkdir 

Monospace Bold command-line user input contrasted 
with computer output 

service sshd start 

mailto:cyberhygiene@nist.gov
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Typeface/Symbol Meaning Example 

blue text link to other parts of the document, a 
web URL, or an email address 

All publications from NIST’s NCCoE are 
available at 
https://www.nccoe.nist.gov. 

3 Approach  285 

The NCCoE issued an open invitation to technology providers to participate in demonstrating how 286 
organizations can use technologies to improve enterprise patch management for their general IT assets. 287 
Cooperative Research and Development Agreements (CRADAs) were established with qualified 288 
respondents, and a build team was assembled. The team fleshed out the initial architecture, and the 289 
collaborators’ components were composed into an example implementation, i.e., build. The build team 290 
documented the architecture and design of the build. As the build progressed, the team documented 291 
the steps taken to install and configure each component of the build.  292 

Finally, the team verified that the build provided the desired capabilities. This included conducting a risk 293 
assessment and a security characteristic analysis, then documenting the results, including mapping the 294 
security contributions of the demonstrated approach to the Framework for improving Critical 295 
Infrastructure Cybersecurity (NIST Cybersecurity Framework), NIST SP 800-53, the Security Measures for 296 
“EO-Critical Software” Use Under Executive Order (EO) 14028, and other relevant standards and 297 
guidelines. 298 

3.1 Audience  299 

This guide is intended for chief information officers (CIOs), chief information security officers (CISOs), 300 
cybersecurity directors and managers, and others who are responsible for managing organizational risk 301 
related to patch management. It also contains information of use for security engineers and architects, 302 
system administrators, security operations personnel, and others who are involved in enterprise patch 303 
management. 304 

3.2 Scope  305 

This project only covers general IT systems: desktops/laptops, servers, virtual machines and containers, 306 
and mobile devices running current software. There are additional challenges with patching legacy IT 307 
systems, as well as industrial control systems (ICS), Internet of Things (IoT) devices, and other 308 
technologies stemming from operational technology (OT), so they will not be covered in this project.  309 

All aspects of security hygiene other than those related to patching are out of the scope of this project. 310 

https://www.nccoe.nist.gov/
https://www.federalregister.gov/documents/2019/02/21/2019-02977/national-cybersecurity-center-of-excellence-nccoe-critical-cybersecurity-hygiene-patching-the
https://www.nist.gov/system/files/documents/2021/07/09/Critical%20Software%20Use%20Security%20Measures%20Guidance.pdf
https://www.nist.gov/system/files/documents/2021/07/09/Critical%20Software%20Use%20Security%20Measures%20Guidance.pdf
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3.3 Assumptions 311 

This project is guided by the following assumptions: 312 

 An IT endpoint for an enterprise would have firmware, operating system(s), and application(s) to 313 
be patched. The endpoint may be in a fixed location within the organization’s own facilities or in 314 
a fixed location at a third-party facility (e.g., a data center), or it may be intended for use in 315 
multiple locations, such as a laptop used at the office and for telework. The proposed approach 316 
for improving enterprise patching practices would have to account for all these possibilities.  317 

 Problems sometimes occur with patches, such as a failure during installation, a patch that 318 
cannot take effect until the endpoint is rebooted, or a patch that is uninstalled because of 319 
operational concerns or because an attacker rolled it back in order to have an entry point to the 320 
system. This project follows a “verify everything and trust nothing” philosophy that does not 321 
assume installing a patch automatically means the patch is successfully and permanently 322 
applied.   323 

 There are no standard protocols, formats, etc. for patch management, including patch 324 
distribution, integrity verification, installation, and installation verification. It is also highly 325 
unlikely for a single patch management system to be able to handle all patch management 326 
responsibilities for all software on IT endpoints. For example, some applications may handle 327 
patching themselves and not be capable of integrating with a patch management system for 328 
patch acquisition and installation.  329 

3.4 Scenarios  330 

This project will address all the scenarios described below. 331 

3.4.1 Scenario 0: Asset identification and assessment 332 

This scenario identifies the assets and classifies them based on vulnerability impact levels to prioritize 333 
the order of remediation. It leverages tools to discover assets across the enterprise and the cloud and to 334 
enumerate their firmware, operating systems (OSes), and applications. Knowing which software and 335 
software versions are in use and predetermining remediation priorities are critically important to all 336 
other patching processes. Without accurate, up-to-date, and comprehensive information, an 337 
organization will have difficulties effectively and efficiently performing patching processes, thus 338 
increasing risk. While many enterprises have constant asset attrition, it is important to have full and 339 
accurate inventory of critical assets and the best possible inventory for the full enterprise. 340 

3.4.2 Scenario 1: Routine patching 341 

This is the standard procedure for patches that are on a regular release cycle and haven’t been elevated 342 
to an active emergency status (see Scenario 3). Routine patching includes endpoint firmware, OS, and 343 
applications, and server OS and applications hosted on-premises or in the cloud (e.g., Infrastructure as a 344 
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Service). Most patching falls under this scenario or Scenario 2. However, because routine patching does 345 
not have the urgency of emergency patching, and routine patch installation can interrupt operations 346 
(e.g., device reboots), it is often postponed and otherwise neglected. This provides many additional 347 
windows of opportunity for attackers. 348 

3.4.3 Scenario 2: Routine patching with cloud delivery model 349 

This is the standard procedure for patches that are delivered through a cloud delivery model, such as a 350 
mobile device or a “Windows as a Service (WaaS)” model with Windows operating systems, Apple 351 
Software Update, and mobile device software updates for Android and iOS devices provided by device 352 
manufacturers or mobile operators. This scenario is similar in importance to Scenario 1, Routine 353 
Patching. However, organizations may not be as accustomed to cloud-delivered patches (which are 354 
frequently cumulative for the whole system vs. discrete patches), so this scenario is somewhat more 355 
likely to be overlooked by organizations, which increases risk. 356 

3.4.4 Scenario 3: Emergency patching 357 

This is the emergency procedure to address active patching emergencies in a crisis situation, such as 358 
extreme severity vulnerabilities like MS17-010, as well as vulnerabilities that are being actively exploited 359 
in the wild. The scope of targets is the same as scenario 1. Emergency patching needs to be handled as 360 
efficiently as possible to prevent imminent exploitation of vulnerable devices. Key characteristics include 361 
identifying vulnerable assets, triaging and applying patches based on a priority list, and tracking and 362 
monitoring the state of those assets. 363 

3.4.5 Scenario 4: Emergency workaround (and backout if needed) 364 

This is the emergency procedure in a crisis situation to temporarily mitigate risk for vulnerabilities prior 365 
to a vendor releasing a patch. It is typically required when the vulnerability is being actively exploited in 366 
the wild. The workaround can vary and may or may not need to be rolled back afterward. The scope of 367 
targets is the same as scenario 1. Organizations need to be prepared to quickly implement a wide 368 
variety of emergency workarounds to protect vulnerable devices. Without processes, procedures, and 369 
tools in place to implement workarounds, too much time may be lost and vulnerable devices may be 370 
compromised before workarounds are in place. This may require disabling system functionality, having 371 
automated mechanisms to apply these changes, and having capabilities to revert back these changes 372 
when a permanent and approved patch is released. 373 

3.4.6 Scenario 5: Isolation of unpatchable assets 374 

This is the reference architecture and implementation of isolation methods to mitigate the risk of 375 
systems which cannot be easily patched. This is typically required if routine patching is not able to 376 
accommodate these systems within a reasonable timeframe (usually X days or less). Most systems in 377 
this scope are legacy unsupported systems or systems with very high operational uptime requirements. 378 
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Isolation is a form of workaround that can be highly effective at stopping threats against vulnerable 379 
devices. Organizations need to be prepared to implement isolation methods when needed and to undo 380 
the isolation at the appropriate time to restore regular device access and functionality. 381 

3.4.7 Scenario 6: Patch management system security (or other system with 382 
administrative privileged access) 383 

This is a reference architecture and implementation of recommended security practices for systems like 384 
patch management systems which have administrative privileged access over many other systems. This 385 
will include practices like least privilege, privileged access workstations, and software updates. 386 

3.5 Risk Assessment 387 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, states that risk is “a measure of the 388 
extent to which an entity is threatened by a potential circumstance or event, and typically a function of: 389 
(i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of 390 
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and 391 
prioritizing risks to organizational operations (including mission, functions, image, reputation), 392 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 393 
an information system. Part of risk management incorporates threat and vulnerability analyses, and 394 
considers mitigations provided by security controls planned or in place.” 395 

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level, 396 
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for 397 
Information Systems and Organizations—material that is available to the public. The Risk Management 398 
Framework (RMF) guidance, as a whole, proved to be invaluable in giving us a baseline to assess risks, 399 
from which we developed the project, the security characteristics of the build, and this guide. Also, the 400 
NIST Cybersecurity Framework and NIST SP 800-53 Revision 5, Security and Privacy Controls for 401 
Information Systems and Organizations informed our risk assessment and subsequent 402 
recommendations from which we developed the security characteristics of the build and this guide. 403 

3.5.1 Threats, Vulnerabilities, and Risks 404 

The objective of this project is to demonstrate example solutions for each of the scenarios described in 405 
Section 3.4. Scenarios 0 through 5 collectively address improving the mitigation of software 406 
vulnerabilities in small to large IT enterprises for general IT assets. The last scenario, Scenario 6 (see 407 
Section 3.4.7) focuses on the security of the patch management technologies themselves. Scenario 6 has 408 
a different set of threats, vulnerabilities, and risks than the other scenarios, so it is discussed separately 409 
in this section. 410 

https://nvlpubs.nist.gov/nistpubs/Legacy/SP/nistspecialpublication800-30r1.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
http://csrc.nist.gov/groups/SMA/fisma/Risk-Management-Framework/
http://csrc.nist.gov/groups/SMA/fisma/Risk-Management-Framework/
https://www.nist.gov/cyberframework/framework
https://doi.org/10.6028/NIST.SP.800-53r5
https://doi.org/10.6028/NIST.SP.800-53r5
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Scenarios 0 through 5 411 

Collectively, the objective of Scenarios 0 through 5 is to ensure that software vulnerabilities are 412 
mitigated, either through patching or by using additional security controls, for firmware, operating 413 
systems, applications, and any other forms of software. The pertinent threats encompass the enormous 414 
range of attackers and attacks that target software vulnerabilities. Major risks can be grouped into three 415 
categories: 416 

 Vulnerabilities aren’t mitigated, leaving them susceptible to compromise. Potential causes of 417 
this include organizations being unaware of vulnerabilities or vulnerable assets, patching being 418 
delayed because of limited resources, users declining to install patches or reboot devices in 419 
order for patches to take effect, and organizations choosing not to implement workarounds or 420 
isolation techniques to protect unpatchable assets. 421 

 Installing patches causes unintended side effects. Examples include breaking the patched 422 
software or other software on the asset, inadvertently altering configuration settings to weaken 423 
security, adding software functionality without adequately securing that functionality, and 424 
disrupting interoperability with other software or assets.  425 

 Patch integrity is compromised. A patch’s integrity could be compromised at several places in 426 
the path from vendor to asset. Examples include the software vendor itself being compromised, 427 
the organization downloading patches from an unauthorized source, patches being tampered 428 
with while in transit to the organization, and patches being altered in storage at the 429 
organization. 430 

Scenario 6 431 

The objective of Scenario 6 is to protect the example solution itself from compromise. To be effective, 432 
the example solution requires administrative privileged access for many assets, so this makes it an 433 
attractive target for attackers. The example solution also holds sensitive information regarding what 434 
computing assets the organization has and what vulnerabilities each asset has, so safeguarding this 435 
information from attackers is important. Vulnerabilities that the example solution might have include 436 
software vulnerabilities in its own components, misconfigurations, and security design errors, such as 437 
not encrypting its network communications.  438 

3.5.2 Security Control Map 439 

Table 3-1 provides a security mapping for Scenarios 0 through 5. It maps the characteristics of the 440 
commercial products that the NCCoE has applied to the applicable standards and best practices 441 
described in the Framework for Improving Critical Infrastructure Cybersecurity (Cybersecurity 442 
Framework) [1] and NIST SP 800-53 Revision 5. This exercise is meant to demonstrate the real-world 443 
applicability of standards and recommended practices, but does not imply that products with these 444 
characteristics will meet your industry's requirements for regulatory approval or accreditation. 445 
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Table 3-1: Mapping Security Characteristics of the Example Solution for Scenarios 0-5 446 

Cybersecurity Framework 
Category 

Cybersecurity Framework 
Subcategory 

SP 800-53 Revision 5 
Controls 

Asset Management (ID.AM): 
The data, personnel, devices, 
systems, and facilities that 
enable the organization to 
achieve business purposes are 
identified and managed 
consistent with their relative 
importance to organizational 
objectives and the 
organization’s risk strategy.  

ID.AM-1: Physical devices and 
systems within the organization 
are inventoried  

CM-8, System Component 
Inventory 

ID.AM-2: Software platforms and 
applications within the 
organization are inventoried 

CM-8, System Component 
Inventory 

Identity Management, 
Authentication and Access 
Control (PR.AC): Access to 
physical and logical assets and 
associated facilities is limited to 
authorized users, processes, 
and devices, and is managed 
consistent with the assessed 
risk of unauthorized access to 
authorized activities and 
transactions. 

PR.AC-4: Access permissions and 
authorizations are managed, 
incorporating the principles of 
least privilege and separation of 
duties 

AC-3, Access Enforcement 

PR.AC-5: Network integrity is 
protected (e.g., network 
segregation, network 
segmentation) 

AC-3, Access Enforcement 

Data Security (PR.DS): Infor-
mation and records (data) are 
managed consistent with the 
organization’s risk strategy to 
protect the confidentiality, in-
tegrity, and availability of infor-
mation. 

PR.DS-6: Integrity checking 
mechanisms are used to verify 
software, firmware, and 
information integrity 

SI-7, Software, Firmware, and 
Information Integrity 



DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems 11 

Cybersecurity Framework 
Category 

Cybersecurity Framework 
Subcategory 

SP 800-53 Revision 5 
Controls 

Information Protection 
Processes and Procedures 
(PR.IP): Security policies (that 
address purpose, scope, roles, 
responsibilities, management 
commitment, and coordination 
among organizational entities), 
processes, and procedures are 
maintained and used to manage 
protection of information 
systems and assets.  

PR.IP-3: Configuration change 
control processes are in place 

CM-3, Configuration Change 
Control 

PR.IP-12: A vulnerability 
management plan is developed 
and implemented  

RA-3, Risk Assessment  
RA-5, Vulnerability 
Monitoring and Scanning  
RA-7, Risk Response 
SI-2, Flaw Remediation  

Protective Technology (PR.PT): 
Technical security solutions are 
managed to ensure the security 
and resilience of systems and 
assets, consistent with related 
policies, procedures, and agree-
ments. 

PR.PT-1: Audit/log records are 
determined, documented, 
implemented, and reviewed in 
accordance with policy 

AU-6, Audit Record Review, 
Analysis, and Reporting 

Security Continuous 
Monitoring (DE.CM): The 
information system and assets 
are monitored to identify 
cybersecurity events and verify 
the effectiveness of protective 
measures. 

DE.CM-1: The network is 
monitored to detect potential 
cybersecurity events 

CA-7, Continuous Monitoring 

DE.CM-8: Vulnerability scans are 
performed 

RA-3, Risk Assessment 
SI-4, System Monitoring 

 

Table 3-2 provides a security mapping for Scenario 6. Although it has the same format as Table 3-1, the 447 
two tables have different functions. Table 3-1 lists the Cybersecurity Framework Subcategories and SP 448 
800-53 Revision 5 security controls that the example solution supports. Table 3-2 lists the Cybersecurity 449 
Framework Subcategories and SP 800-53 Revision 5 security controls that are needed to support the 450 
example solution—to mitigate the risks of the solution itself. 451 
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Table 3-2: Mapping Security Characteristics of the Example Solution for Scenario 6 452 

Cybersecurity Framework 
Category 

Cybersecurity Framework 
Subcategory 

SP 800-53 Revision 5 
Controls 

Identity Management, 
Authentication and Access 
Control (PR.AC): Access to 
physical and logical assets and 
associated facilities is limited to 
authorized users, processes, 
and devices, and is managed 
consistent with the assessed 
risk of unauthorized access to 
authorized activities and 
transactions. 

PR.AC-4: Access permissions and 
authorizations are managed, 
incorporating the principles of 
least privilege and separation of 
duties 

AC-3, Access Enforcement 
AC-5, Separation of Duties 
AC-6, Least Privilege 

PR.AC-7: Users, devices, and other 
assets are authenticated (e.g., 
single-factor, multi- factor) 
commensurate with the risk of the 
transaction (e.g., individuals’ 
security and privacy risks and 
other organizational risks) 

AC-2, Account Management 
IA-2, Identification and 
Authentication 
(Organizational Users) 
IA-3, Device Identification 
and Authentication 
IA-4, Identifier Management 
IA-5, Authenticator 
Management 
IA-9, Service Identification 
and Authentication 

Data Security (PR.DS): 
Information and records (data) 
are managed consistent with 
the organization’s risk strategy 
to protect the confidentiality, 
integrity, and availability of 
information. 

PR.DS-1: Data-at-rest is protected SC-28, Protection of 
Information at Rest 

PR.DS-2: Data-in-transit is 
protected 

SC-8, Transmission 
Confidentiality and Integrity 

Protective Technology (PR.PT): 
Technical security solutions are 
managed to ensure the security 
and resilience of systems and 
assets, consistent with related 
policies, procedures, and 
agreements. 

PR.PT-3: The principle of least 
functionality is incorporated by 
configuring systems to provide 
only essential capabilities 

CM-7, Least Functionality 

  

 



DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems 13 

4 Components of the Example Solution 453 

This section highlights the components of the example solution and the collaborators who contributed 454 
those components and participated in the solution design, implementation, configuration, 455 
troubleshooting, and/or testing. More information on each component, including instructions for 456 
installing and configuring it as part of the example solution, is provided in NIST SP 1800-31C, How-To 457 
Guides. 458 

4.1 Collaborators 459 

Collaborators that participated in this build and the capabilities of their contributions to the example 460 
solution are described briefly in the subsections below. 461 

4.1.1 Cisco 462 

Cisco Systems is a provider of enterprise, telecommunications, and industrial networking solutions. Cisco 463 
Identity Services Engine (ISE) enables a dynamic and automated approach to policy enforcement that 464 
simplifies the delivery of highly secure, micro-segmented network access control. ISE empowers 465 
software-defined access and automates network segmentation within IT and OT environments. Cisco 466 
Firepower Threat Defense (FTD) is a threat-focused, next-generation firewall with unified management. 467 
It provides advanced threat protection before, during, and after attacks. By delivering comprehensive, 468 
unified policy management of firewall functions, application control, threat prevention, and advanced 469 
malware protection from the network to the endpoint, it increases visibility and security posture while 470 
reducing risks. Learn more about Cisco Systems at https://www.cisco.com.  471 

4.1.2 Eclypsium 472 

Eclypsium is the enterprise firmware security company. The cloud-based solution identifies, verifies, and 473 
fortifies firmware and hardware in laptops, servers, network gear, and devices. Eclypsium 474 
Administration and Analytics Service secures against persistent and stealthy firmware attacks, provides 475 
continuous device integrity, delivers firmware patching at scale, and prevents ransomware and 476 
malicious implants. Eclypsium also provides an on-premises version that has parity with the cloud-based 477 
platform. 478 

4.1.3 Forescout 479 

Forescout assesses device security posture in real time upon connection and initiates remediation 480 
workflows with your existing security tools to enforce compliance. It continuously monitors all devices 481 
for new threats and reassesses their patch level hygiene every time the device leaves and returns to the 482 
corporate network. Forescout works to assess all device types, including transient devices often missed 483 
by point-in-time scans, without requiring agents. Forescout’s solution goes beyond simple device 484 
authentication to identify every device, assess its security posture, trigger remediation workflows, and 485 

https://www.cisco.com/
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implement access control across heterogeneous networks to unpatched assets. It continuously monitors 486 
all connected devices and automates response when noncompliance or unpatched assets are detected. 487 

4.1.4 IBM 488 

IBM MaaS360 with Watson is a unified endpoint management (UEM) solution that transforms how 489 
organizations support users, apps, content, and data across every type of mobile device: laptops, 490 
smartphones, tablets, and IoT. IBM MaaS360 was built almost twenty years ago as a cloud-based 491 
Software-as-a-Service (SaaS) platform that integrates with preferred security and productivity tools, 492 
allowing modern business leaders to derive immediate value. IBM MaaS360 is the only UEM platform 493 
that leverages the power of the Watson Artificial Intelligence engine to deliver contextually relevant 494 
security insights for administrators, while ensuring continuous monitoring of the riskiest end users. 495 

IBM Code Risk Analyzer was developed in conjunction with IBM Research projects and customer 496 
feedback. It enables developers to quickly assess and remediate security and legal risks that they are 497 
potentially introducing into their source code, and it provides feedback directly in Git artifacts (for 498 
example, pull/merge requests) as part of continuous delivery in a DevOps pipeline. IBM Code Risk 499 
Analyzer is provided as a set of Tekton tasks, which can be easily incorporated into delivery pipelines. 500 

4.1.5 Lookout 501 

Lookout is an integrated endpoint-to-cloud security solution provider with mobile endpoint protection 502 
offerings. Lookout’s Mobile Endpoint Security (MES) solution provides cloud-centric behavior-based 503 
detection capabilities; it performs behavioral analysis based on telemetry data from nearly 200 million 504 
devices and over 120 million apps. This analysis enables Lookout to deliver efficient protection with a 505 
lightweight app on the device that optimizes processor speed and battery life. In addition, continuously 506 
monitoring changes to the endpoint enables detection of risks that span from jailbreaking or rooting a 507 
device to advanced device compromise. With insight into both real-time changes on a device and the 508 
aggregate view of behavior across the broader mobile ecosystem, Lookout endpoint protection can 509 
detect zero-day threats.  510 

4.1.6 Microsoft 511 

Microsoft Endpoint Manager helps deliver the modern workplace and modern management to keep 512 
your data secure in the cloud and on-premises. Endpoint Manager includes the services and tools you 513 
use to manage and monitor mobile devices, desktop computers, virtual machines, embedded devices, 514 
and servers. Endpoint Manager combines several services, including Configuration Manager (Microsoft 515 
Endpoint Configuration Manager), an on-premises management solution for desktops, servers, and 516 
laptops that are on your network or internet-based. Endpoint Configuration Manager can be integrated 517 
with Intune, Azure Active Directory (AD), Microsoft Defender for Endpoint, and other cloud services. 518 
Endpoint Configuration Manager can deploy apps, software updates, and operating systems, and also be 519 
used to monitor compliance and to query and act on clients in real time. 520 
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4.1.7 Tenable 521 

Tenable.sc is Tenable’s on-premises vulnerability management solution. Built on Nessus technology, the 522 
Tenable.sc family of products identifies, investigates, and prioritizes vulnerabilities. You get real-time, 523 
continuous assessment of your security and compliance posture so you can discover unknown assets 524 
and vulnerabilities, monitor unexpected network changes, and prioritize weaknesses to minimize your 525 
cyber risk and prevent breaches. Tenable.sc includes over 350 pre-built, highly customizable dashboards 526 
and reports to give you immediate insight into your security compliance, effectiveness, and risk. You can 527 
continuously measure, analyze, and visualize the effectiveness of your security program, based on high-528 
level business objectives and underlying customizable policies that executives care about. 529 

Powered by Nessus technology and managed in the cloud, Tenable.io provides the industry’s most 530 
comprehensive vulnerability coverage with the ability to predict which security issues to remediate first. 531 
Using an advanced asset identification algorithm, Tenable.io provides the most accurate information 532 
about dynamic assets and vulnerabilities in ever-changing environments. As a cloud-delivered solution, 533 
its intuitive dashboard visualizations, comprehensive risk-based prioritization, and seamless integration 534 
with third-party solutions help security teams maximize efficiency and scale for greater productivity. 535 

4.1.8 VMware 536 

VMware vRealize Automation includes SaltStack Config, a modern configuration management platform 537 
with the performance, speed, and agility IT teams need to manage large, complex IT systems and 538 
improve efficiency at scale. For this project, vRealize Automation SaltStack Config provides device 539 
configuration and software distribution capabilities. Specifically, it allows for configuration changes to be 540 
made to devices by updating or removing software as well as updating settings such as network 541 
information.  542 

SaltStack SecOps, an add-on to the vRealize products, gives system administrators the ability to create 543 
security policies and scan assets to determine whether they are compliant with supported, industry-544 
recognized security benchmarks. SaltStack SecOps also has the ability to scan your system for Common 545 
Vulnerabilities and Exposures (CVEs), then immediately apply the updates or patches to remediate the 546 
advisories. 547 

4.2 Technologies 548 

Table 4-1 lists all the technologies used in this project, the primary functions that each technology 549 
provides to the project, and the Cybersecurity Framework Subcategories that the technology supports in 550 
this project. Please refer to Table 3-1 for an explanation of the NIST Cybersecurity Framework 551 
Subcategory codes. 552 
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Table 4-1: Technologies Used in the Build 553 

Technology Primary Functions Cybersecurity Framework 
Subcategories 

Cisco Firepower Threat 
Defense (FTD) and Cisco 
Firepower Management 
Center (FMC) 

Network policy enforcement PR.AC-4, PR.AC-5, DE.CM-1 

Cisco Identity Services 
Engine (ISE) 

Asset discovery and inventory; 
network access control 

ID.AM-2, PR.AC-4, PR.AC-5  

Eclypsium Administration 
and Analytics Service 

Hardware and firmware inventory; 
firmware vulnerability assessment, 
integrity monitoring, and updating 

ID.AM-1, ID.AM-2, PR.DS-6, 
PR.IP-12 

Forescout Platform Asset discovery and inventory; 
security policy enforcement  

ID.AM-2, PR.AC-4, PR.AC-5, 
PR.IP-3, PR.PT-1 

IBM Code Risk Analyzer Vulnerability scanning for source code PR.IP-12 

IBM MaaS360 with Watson   Asset inventory; configuration 
management; software updates 

ID.AM-2, PR.IP-3, PR.IP-12 

Lookout Mobile Endpoint 
Security (MES) 

Security policy enforcement; 
vulnerability scanning and reporting; 
software discovery and inventory; 
firmware vulnerability assessment and 
policy enforcement 

PR.AC-4, PR.IP-3, PR.IP-12 

Microsoft Endpoint 
Configuration Manager 

Asset discovery; configuration 
management; software updates 

ID.AM-2, PR.IP-3, PR.IP-12 

Tenable.sc, Tenable.io, and 
Nessus 

Asset discovery and inventory; 
vulnerability scanning and reporting 

ID.AM-2, PR.PT-1, DE.CM-8 

VMware vRealize 
Automation SaltStack 
Config and SaltStack 
SecOps 

Vulnerability scanning and 
remediation; configuration 
management; software updates 

PR.IP-3, PR.IP-12, DE.CM-8 

 

The following sections summarize the security capabilities that each technology provided to the 554 
example solution. 555 
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4.2.1 Cisco Firepower Threat Defense (FTD) & Firepower Management Center 556 
(FMC) 557 

Cisco Firepower Threat Defense (FTD) is a virtual firewall that was utilized as the networking backbone 558 
that connected all of the lab subnets. This build also used the Cisco FTD firewall to provide network 559 
access management capabilities, including enforcing network access control using firewall rules. Cisco 560 
FTD was deployed and managed in the lab via a separate Cisco Firepower Management Center (FMC) 561 
virtual machine. 562 

To support the unpatchable asset scenario (Scenario 5), the integration between Cisco FTD and Cisco 563 
Identity Services Engine (ISE) via pxGrid allowed for the firewall to ingest security group tags (SGTs) that 564 
were applied by ISE. SGTs were then used in custom firewall rules to restrict network access to any 565 
machine that was given a quarantine tag. Section 4.2.2 has more information on this integration. 566 

4.2.2 Cisco Identity Services Engine (ISE) 567 

In this build Cisco Identity Services Engine (ISE) provided asset discovery and inventory, and network 568 
access control to enforce administrator-created security and access control policies. Cisco ISE had 569 
integrations with several other example solution technologies, including the following: 570 

 An integration between ISE and AD allowed the user of a device to be identified. This 571 
information could then be used in custom policy. 572 

 A Dynamic Host Configuration Protocol (DHCP) relay was established between ISE and the lab 573 
DHCP server. This integration allowed for ISE to identify any device that was assigned an IP 574 
address. This allowed devices to be discovered as they joined the network. 575 

 Cisco ISE was configured to integrate with Tenable.sc via an adapter. Cisco ISE leveraged this 576 
adapter to prompt Tenable to scan devices newly connected to the network. Cisco ISE could 577 
then ingest this scan data to find the Common Vulnerability Scoring System (CVSS) scores of 578 
device vulnerabilities. An ISE policy was written to apply a quarantine action, via SGTs, to any 579 
device with a CVSS score equal to or greater than 7 (corresponding to high and critical 580 
vulnerabilities). 581 

 Cisco Platform Exchange Grid (pxGrid) was configured to share contextual information about 582 
authenticated devices to the firewall. Cisco ISE was utilized to apply SGTs to devices as they 583 
were assessed for vulnerabilities. These SGTs were then passed to the lab firewall via pxGrid, 584 
where they could be used in custom firewall rules. PxGrid was also used to share 585 
communications between Forescout and Cisco ISE. Forescout could apply a quarantine tag to 586 
observed devices, which would then be shared with ISE. 587 

4.2.3 Eclypsium Administration and Analytics Service 588 

In this build, we utilized Eclypsium Administration and Analytics Service to provide agent-based 589 
identification of hardware and firmware for our laptop, desktop, and server endpoints while also 590 
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monitoring the firmware for vulnerable or end-of-life versions. Eclypsium monitored laptop and virtual 591 
machine (VM) firmware integrity, and alerted if a component or its associated firmware has changed. It 592 
also monitored endpoints for known security vulnerabilities from out-of-date firmware. Finally, we 593 
utilized Eclypsium’s beta firmware update script, which automatically finds the latest known Basic 594 
Input/Output System (BIOS) firmware version for the system, downloads the update, and executes it to 595 
update the BIOS. 596 

4.2.4 Forescout Platform 597 

In this build the Forescout platform was configured to perform endpoint discovery by detecting 598 
endpoints and determining software information about those endpoints based on a set of attributes. 599 
Forescout also provided the capability to isolate or restrict assets that cannot be patched and to 600 
respond to emergency scenarios, such as providing a workaround or deploying an emergency patch. 601 
Forescout had several integrations with other example solution technologies: 602 

 The User Directory plugin was configured so that the Forescout platform integrated with the 603 
lab’s AD Domain Controller. This plugin provided Lightweight Directory Access Protocol (LDAP) 604 
services to Forescout, allowing directory-based users to log in into Forescout as well as providing 605 
user directory information such as the current active domain users logged into each endpoint.  606 

 The Domain Name System (DNS) Query Extension configuration setting allowed Forescout to 607 
query the DNS server to determine the hostnames of devices identified by Forescout. 608 

 The Tenable VM plugin provided the Forescout platform with vulnerability and scan status 609 
information which can be used to create custom policies. This plugin also enabled Forescout to 610 
utilize vulnerability management information that Tenable.sc collected from endpoints, and 611 
allowed Forescout to determine if scans had been performed on endpoints within the lab. 612 

 The Microsoft Systems Management Server (SMS)/System Center Configuration Manager 613 
(SCCM) module was configured to allow the Forescout platform to integrate with Microsoft 614 
Endpoint Configuration Manager. This module allowed for a custom policy to be created that 615 
used data from Microsoft Endpoint Configuration Manager.  616 

 The Linux plugin was configured to collect information from and manage Linux-based endpoints 617 
via two methods: secure shell (SSH) access to the endpoint, and agent-based integration with 618 
the endpoint.  619 

 The HPS Inspection Engine was configured to collect information from Windows endpoints via 620 
two methods. The first method utilized a directory-based integration with the lab’s AD Domain 621 
Services instance, which collected domain-based information on the Windows endpoint. The 622 
second method utilized an agent-based integration called SecureConnector that allowed 623 
Forescout to collect and manage Windows endpoints. 624 

 The pxGrid plugin was configured to integrate with Cisco ISE. This plugin gave the Forescout 625 
platform the ability to utilize Cisco ISE to apply adaptive network control (ANC) policies to 626 
endpoints for restricting their network access. 627 
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 The Switch plugin was configured to integrate Forescout with the physical Cisco switch located 628 
in the lab. The plugin used information from the switch to collect information about endpoints 629 
that were physically connected to the switch. 630 

Our implementation utilized multiple policies to support the use case scenarios. Examples of capabilities 631 
that the policies provided are described below: 632 

 Check for a particular application running on Windows; if present, stop execution and uninstall 633 
it. 634 

 Check an endpoint for known critical vulnerabilities; if any are present, use Cisco ISE to 635 
quarantine the endpoint via the pxGrid plugin. 636 

 Force a Windows update to occur on an endpoint with Windows Update enabled. 637 

 Determine if a Windows endpoint has the Microsoft Endpoint Configuration Manager agent 638 
installed. 639 

4.2.5 IBM Code Risk Analyzer 640 

IBM Code Risk Analyzer was used to demonstrate vulnerability scanning and reporting for pre-deployed 641 
code as part of a DevOps pipeline to deliver a cloud-native application. Integration with Git allowed the 642 
Code Risk Analyzer to perform vulnerability assessments against applications and base images. The Code 643 
Risk Analyzer would then print a bill-of-materials, which indicates the composition of a deployment. This 644 
allows an administrator to see all of an application’s dependencies and their sources, providing visibility 645 
into application components which could have vulnerabilities. 646 

4.2.6 IBM MaaS360 with Watson 647 

IBM MaaS360 with Watson was used to demonstrate how to securely manage an enterprise’s devices by 648 
enabling deployment, control of content, and policy controls. Enterprises can manage organization-649 
owned and user-owned devices using this product. The lab used MaaS360 for asset identification and 650 
assessment, routine patching and emergency patching, emergency workarounds, and isolation of assets 651 
that cannot be patched. The first phase of this lab build used MaaS360’s comprehensive enterprise 652 
mobility management (EMM) capability to manage a MacBook Pro and a Windows 10 virtual desktop. 653 
The second phase used MaaS360’s Mobile Device Manager (MDM) capability to manage Android and 654 
Apple iOS devices. 655 

This build also used Maas360’s Cloud Extender, which allows enterprises to integrate mobile devices 656 
with corporate on-premises and cloud-based resources. The Cloud Extender was installed on the AD 657 
server to allow users to log in with AD accounts. 658 
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4.2.7 Lookout 659 

Lookout MES was used in this build to perform security compliance, vulnerability scanning, and 660 
firmware/software discovery for mobile endpoints. Our implementation of Lookout MES was integrated 661 
with IBM MaaS360. Lookout MES shared custom device attributes, such as device threat, with MaaS360, 662 
which could in turn provide policy enforcement. The Lookout for Work mobile client was able to provide 663 
firmware and application vulnerability assessment for mobile endpoints. Administrators could use 664 
Lookout to see which vulnerabilities were affecting deployed endpoints and find risk grades (i.e., A, B, C, 665 
D, or F) for installed applications.  666 

4.2.8 Microsoft Endpoint Configuration Manager 667 

Microsoft Endpoint Configuration Manager was used in this build to perform configuration 668 
management, including software and firmware patching, for Windows-based hosts. Our implementation 669 
of Endpoint Configuration Manager included Windows Server Update Services (WSUS), an update 670 
service primarily used for downloading, distributing, and managing updates for Microsoft Windows-671 
based systems. The example build used Microsoft Endpoint Configuration Manager to demonstrate the 672 
identification of endpoints utilizing Heartbeat discovery and Windows Domain discovery methods, the 673 
patching of Windows endpoints via Microsoft updates and third-party update sources, and the 674 
deployment of custom scripts to endpoints. 675 

4.2.9 Tenable.io 676 

In the example build, Tenable.io was used to provide vulnerability scanning and reporting for Docker 677 
container images. Containers are built from images and vulnerabilities are patched in images, not 678 
deployed containers, so images are the focus of scanning. Tenable.io scanned the repository of a Red 679 
Hat OpenShift cluster in the lab environment. Tenable.io was scheduled to routinely pull the latest 680 
images from the OpenShift cluster and perform vulnerability scans on them. Scan information was 681 
reported in the container security section of the Tenable.io Web Console. Administrators could see 682 
vulnerability information for containers deployed in their respective networks.  683 

4.2.10  Tenable.sc and Nessus 684 

This example build utilized two Tenable products in the first phase of this project, Nessus and 685 
Tenable.sc. We used Nessus to scan Linux, Windows, and macOS endpoints and network switches for 686 
vulnerability data, and then feed this information to Tenable.sc for reporting. Tenable.sc, a vulnerability 687 
management product, collected the information from Nessus and reported that information to 688 
administrators using dashboards and reports. Also, Tenable.sc had integrations with other example 689 
solution technologies: 690 
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 An integration between Tenable.sc and Cisco ISE was performed to initiate scans of any newly 691 
connected network devices. Tenable.sc would pass scan data to Cisco ISE, where a custom policy 692 
was written to quarantine devices based on their CVSS scores. 693 

 An integration between Forescout and Tenable was leveraged to scan devices as hosts joined 694 
the network. Forescout could prompt Tenable to scan hosts to determine if an endpoint had 695 
critical vulnerabilities. This information was ingested by Forescout for the purpose of 696 
quarantining endpoints. 697 

4.2.11  VMware vRealize Automation SaltStack Config 698 

In this example build, vRealize Automation SaltStack Config was used to provide configuration 699 
management and patch deployment. In the first phase of the build, it was used to manage Windows 700 
workstations and servers, a macOS laptop, and Linux/Unix-based VMs and servers. SaltStack Config was 701 
configured to run jobs, applying different states or configurations, on endpoints. The job that was 702 
written for this project, in support of the emergency workaround scenario, could uninstall an application 703 
based on the current version of the product. SaltStack Config also had an add-on component called 704 
SaltStack SecOps which was utilized to scan devices for known vulnerabilities and provide mitigation 705 
actions, including missing updates for endpoints. 706 
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Appendix A Patch Management System Security Practices 707 

Section 3.4.7 describes Scenario 6, “Patch management system security (or other system with 708 
administrative privileged access).” In support of Scenario 6, this appendix describes recommended 709 
security practices for systems like patch management systems which have administrative privileged 710 
access over many other systems as defined as “critical software” in Executive Order (EO) 14028. It then 711 
summarizes how the example solution components described in this practice guide could support each 712 
of those recommended security practices.  713 

A.1 Security Measures 714 

The table below defines security measures for software of critical importance. Note that these security 715 
measures are not intended to be comprehensive. They are based on those in the NIST publication 716 
Security Measures for “EO-Critical Software” Use Under Executive Order (EO) 14028. A security measure 717 
(SM) is a high-level security outcome statement that is intended to apply to critical software or to all 718 
platforms, users, administrators, data, or networks (as specified) that are part of running critical 719 
software. The security measures are grouped by five objectives: 720 

1. Protect critical software and critical software platforms (the platforms on which critical software 721 
runs, such as endpoints, servers, and cloud resources) from unauthorized access and usage. 722 

2. Protect the confidentiality, integrity, and availability of data used by critical software and critical 723 
software platforms. 724 

3. Identify and maintain critical software platforms and the software deployed to those platforms 725 
to protect the critical software from exploitation. 726 

4. Quickly detect, respond to, and recover from threats and incidents involving critical software 727 
and critical software platforms. 728 

5. Strengthen the understanding and performance of humans’ actions that foster the security of 729 
critical software and critical software platforms. 730 

Each row in the table defines one security measure and lists mappings to it from the NIST Cybersecurity 731 
Framework and NIST SP 800-53 Revision 5, Security and Privacy Controls for Information Systems and 732 
Organizations. These mappings are in the forms of Cybersecurity Framework Subcategories and SP 800-733 
53 security controls, respectively. The mappings are general and informational; any particular situation 734 
might have somewhat different mappings. 735 

https://www.nist.gov/system/files/documents/2021/07/09/Critical%20Software%20Use%20Security%20Measures%20Guidance.pdf
https://www.nist.gov/cyberframework/framework
https://www.nist.gov/cyberframework/framework
https://doi.org/10.6028/NIST.SP.800-53r5
https://doi.org/10.6028/NIST.SP.800-53r5
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Security Measure (SM) 
Cybersecurity 
Framework 
Subcategories 

SP 800-53 Rev. 
5 Controls 

Objective 1: Protect critical software and critical software platforms from unauthorized access and 
usage. 

SM 1.1: Use multi-factor authentication that is verifier 
impersonation-resistant for all users and administrators of 
critical software and critical software platforms. 

PR.AC-1, 
PR.AC-7 

AC-2, IA-2, IA-
4, IA-5 

SM 1.2: Uniquely identify and authenticate each service 
attempting to access critical software or critical software 
platforms. 

PR.AC-1, 
PR.AC-7 

AC-2, IA-9 

SM 1.3: Follow privileged access management principles for 
network-based administration of critical software and critical 
software platforms. Examples of possible implementations 
include using hardened platforms dedicated to administration 
and verified before each use, requiring unique identification of 
each administrator, and proxying and logging all administrative 
sessions to critical software platforms. 

PR.AC-1, 
PR.AC-7, 
PR.MA-1, 
PR.MA-2 

AC-2, IA-2, SC-
2, SC-7 
enhancement 
15 

SM 1.4: Employ boundary protection techniques as appropriate 
to minimize direct access to critical software, critical software 
platforms, and associated data. Examples of such techniques 
include network segmentation, isolation, software-defined 
perimeters, and proxies. 

PR.AC-3, 
PR.AC-5 

SC-7 

Objective 2: Protect the confidentiality, integrity, and availability of data used by critical software and 
critical software platforms. 

SM 2.1: Establish and maintain a data inventory for critical 
software and critical software platforms.  

ID.AM-3, 
DE.AE-1 

CM-8, PM-5 

SM 2.2: Use fine-grained access control for data and resources 
used by critical software and critical software platforms to 
enforce the principle of least privilege to the extent possible. 

PR.AC-4 AC-2, AC-3, AC-
6 

SM 2.3: Protect data at rest by encrypting the sensitive data used 
by critical software and critical software platforms consistent 
with NIST’s cryptographic standards. 

PR.DS-1 SC-28 

SM 2.4: Protect data in transit by using mutual authentication 
whenever feasible and by encrypting sensitive data 
communications for critical software and critical software 
platforms consistent with NIST’s cryptographic standards. 

PR.AC-3, 
PR.AC-7, 
PR.DS-2, PR.PT-
4, DE.CM-7 

AC-4, AC-17, 
SC-8 



DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems 24 

Security Measure (SM) 
Cybersecurity 
Framework 
Subcategories 

SP 800-53 Rev. 
5 Controls 

SM 2.5: Back up data, exercise backup restoration, and be 
prepared to recover data used by critical software and critical 
software platforms at any time from backups. 

PR.IP-4 CP-9, CP-10 

Objective 3: Identify and maintain critical software platforms and the software deployed to those 
platforms to protect the critical software from exploitation. 

SM 3.1: Establish and maintain a software inventory for all 
platforms running critical software and all software (both critical 
and non-critical) deployed to each platform. 

ID.AM-1, 
ID.AM-2, ID.SC-
2 

CM-8, PM-5, 
RA-9 

SM 3.2: Use patch management practices to maintain critical 
software platforms and all software deployed to those platforms. 
Practices include: 
 rapidly identify, document, and mitigate known vulnerabili-

ties (e.g., patching, updating, upgrading software to sup-
ported version) to continuously reduce the exposure time  

 monitor the platforms and software to ensure the mitigations 
are not removed outside of change control processes 

ID.RA-1, ID.RA-
2, ID.RA-6, 
PR.IP-12, 
DE.CM-8, 
RS.MI-3 

CA-7, RA-5, SI-
2, SI-5, SR-8 

SM 3.3: Use configuration management practices to maintain 
critical software platforms and all software deployed to those 
platforms. Practices include: 
 identify the proper hardened security configuration for each 

critical software platform and all software deployed to that 
platform (hardened security configurations enforce the princi-
ples of least privilege, separation of duties, and least func-
tionality) 

 implement the configurations for the platforms and software  
 control and monitor the platforms and software to ensure the 

configuration is not changed outside of change control pro-
cesses  

ID.RA-1, ID.RA-
2, ID.RA-6, 
PR.AC-4, PR.IP-
1, PR.IP-3, 
PR.PT-3, 
DE.CM-8, 
RS.MI-3 

AC-5, AC-6, CA-
7, CM-2, CM-3, 
CM-6, CM-7, 
RA-5, SI-5 

Objective 4: Quickly detect, respond to, and recover from threats and incidents involving critical 
software and critical software platforms. 

SM 4.1: Configure logging to record the necessary information 
about security events involving critical software platforms and all 
software running on those platforms. 

PR.PT-1 AU-2, AU-3, 
AU-4, AU-5, 
AU-8, AU-9, 
AU-11, AU-12 
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Security Measure (SM) 
Cybersecurity 
Framework 
Subcategories 

SP 800-53 Rev. 
5 Controls 

SM 4.2: Continuously monitor the security of critical software 
platforms and all software running on those platforms. 

DE.CM-7 CA-7, SI-4 

SM 4.3: Employ endpoint security protection on critical software 
platforms to protect the platforms and all software running on 
them. Capabilities include: 
 protecting the software, data, and platform by identifying, re-

viewing, and minimizing the attack surface and exposure to 
known threats 

 permitting only verified software to execute (e.g., file integ-
rity verification, signed executables, allowlisting)  

 proactively detecting threats and stopping them when possi-
ble 

 responding to and recovering from incidents 
 providing the necessary information for security operations, 

threat hunting, incident response, and other security needs 

PR.DS-5, PR.DS-
6, DE.AE-2, 
DE.CM-4, 
DE.CM-7, 
DE.DP-4 

SI-3, SI-4, SI-7 

SM 4.4: Employ network security protection to monitor the 
network traffic to and from critical software platforms to protect 
the platforms and their software using networks. Capabilities 
include: 
 proactively detecting threats at all layers of the stack, includ-

ing the application layer, and stopping them when possible 
 providing the necessary information for security operations, 

threat hunting, incident response, and other security needs 

PR.DS-5, 
DE.AE-1, 
DE.AE-3, 
DE.CM-1, 
DE.CM-4, 
DE.CM-7, 
DE.DP-4 

AU-13, AU-14, 
SC-7, SI-3 

SM 4.5: Train all security operations personnel and incident 
response team members, based on their roles and 
responsibilities, on how to handle incidents involving critical 
software or critical software platforms. 

PR.AT-5, PR.IP-
9, PR.IP-10 

AT-3, CP-3, IR-2 

Objective 5: Strengthen the understanding and performance of humans’ actions that foster the 
security of critical software and critical software platforms. 

SM 5.1: Train all users of critical software, based on their roles 
and responsibilities, on how to securely use the software and the 
critical software platforms. 

PR.AT-1 AT-2, AT-3 

SM 5.2: Train all administrators of critical software and critical 
software platforms, based on their roles and responsibilities, on 
how to securely administer the software and/or platforms. 

PR.AT-2 AT-3, CP-3 
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Security Measure (SM) 
Cybersecurity 
Framework 
Subcategories 

SP 800-53 Rev. 
5 Controls 

SM 5.3: Conduct frequent awareness activities to reinforce the 
training for all users and administrators of critical software and 
platforms, and to measure the training’s effectiveness for 
continuous improvement purposes. 

PR.AT-1, PR.AT-
2 

AT-3 

A.2 Component Support of Security Measures  736 

This section provides summary tables for how each technology provider’s components in the example 737 
solution could support the security measures defined above. The technical mechanisms, configuration 738 
settings, or other ways in which the components could provide this support were not necessarily utilized 739 
in the example solution build. The information is provided here to offer examples of how these security 740 
measures might be implemented, not to serve as recommendations for how to implement them. 741 

Each table in this section has the same four columns: 742 

 SM #: This lists a security measure ID from the previous section and hyperlinks to the definition 743 
of that ID. 744 

 Question: This contains a question NIST asked the technology providers to answer for their 745 
components regarding the associated security measure. 746 

 Technical Mechanism or Configuration: This is a summary of the answer from the component’s 747 
technology provider. The content submitted by each technology provider has been edited for 748 
brevity. 749 

 Refs.: This provides hyperlinks to any applicable references specified by the technology 750 
provider. This column is blank if no reference was needed or available, or if there is a single 751 
reference for all entries in a table, in which case the reference is defined immediately before the 752 
table.  753 

In each table, rows with no answer or an answer of “no” or “not applicable” have been omitted for 754 
brevity. 755 

A.2.1 Cisco FTD Support of Security Measures 756 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for the 
use of a two-factor authentication 
method for access? 

Certificates from a Personal Identity 
Verification (PIV) card or Common Access 
Card (CAC) can be used along with soft 
certificates to authenticate admin users. 

Ref1 
  

https://www.cisco.com/c/en/us/td/docs/security/firepower/621/configuration/guide/fpmc-config-guide-v621/firepower_system_user_management.html#ID-2263-000000e3
https://www.cisco.com/c/en/us/td/docs/security/firepower/621/configuration/guide/fpmc-config-guide-v621/firepower_system_user_management.html#ID-2263-000000e3
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.2 

Does the software platform identify and 
authenticate users and machine accounts 
that try to access the platform? 

Services using the PxGrid solution to 
gather data from the system or publish 
require the use of certificates to secure 
the communications channel. 

Ref1 

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Cisco FMC admin console supports 
role-based access control. There are 
predefined roles, and custom roles with 
permissions can be created. 

Ref1 

SM 
1.4 

Does the system allow for the use of 
discretionary access control lists (DACLs), 
network segmentation, or isolation for 
access to the platform? 

Administrators can limit access by IP 
address and port. 

Ref1 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Cisco FMC admin console and 
command-line interface (CLI) both 
support role-based access control. 

Ref1 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

Cisco FMC enables backup and restore of 
configuration and monitoring. FMC also 
provides backup and restore of the 
devices it manages. 

Ref1 

SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

Cisco distributes several types of 
upgrades and updates for Firepower 
deployments. These include OS versions, 
patches, vulnerability databases, intrusion 
rules, and geolocation databases. These 
are all deployed centrally from FMC. 

Ref1 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or 
Security Information and Event 
Management (SIEM)? 

FMC allows for sending all logs to a third-
party SIEM using syslog or eStreamer. 

Ref1 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

The system can generate logs of the 
connection events its managed devices 
detect. Connection events include 
Security Intelligence events (connections 
blocked by the reputation-based Security 
Intelligence feature.) 

Ref1 

https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine-24/214481-configure-ise-2-4-and-fmc-6-2-3-pxgrid-i.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/Firepower_System_User_Management.html#ID-2263-00000738
https://www.cisco.com/c/en/us/td/docs/security/firepower/623/configuration/guide/fpmc-config-guide-v623/system_configuration.html#concept_C539C10D4F134323933DCD745F1CD645
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/Firepower_System_User_Management.html#ID-2263-000015e9
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/Backup_and_Restore.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/System_Software_Updates.html?bookSearch=true#concept_5835D84A07A84D38B6ED455BE5BAC1DD
https://www.cisco.com/c/en/us/td/docs/security/firepower/620/configuration/guide/fpmc-config-guide-v62/connection_logging.html#ID-2174-00000004
https://www.cisco.com/c/en/us/td/docs/security/firepower/620/configuration/guide/fpmc-config-guide-v62/connection_and_security_intelligence_events.html
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

Cisco provides training resources through 
direct offering, partner, knowledge 
partners, and on-demand through Cisco 
Live. 

 

SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

Cisco provides training resources through 
direct offering, partner, knowledge 
partners, and on-demand through Cisco 
Live. 

 

SM 
5.3 

Are trainings updated and metrics 
collected to improve trainings? 

Cisco regularly collects metrics from 
completed user training to make 
improvements and updates. 

 

 757 

A.2.2 Cisco ISE Support of Security Measures 758 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for the 
use of a two-factor authentication 
method for access? 

Certificates from a PIV or CAC can be used 
along with soft certificates to 
authenticate admin users. 

Ref1 
 

SM 
1.2 

Does the software platform identify and 
authenticate users and machine accounts 
that try to access the platform? 

Services using the ISE PxGrid solution to 
gather data from the system or publish 
require the use of certificates to secure 
the communications channel. 

Ref1 

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Cisco ISE admin console and CLI both 
support role-based access control. 

Ref1 

SM 
1.4 

Does the system allow for the use of 
DACLs, network segmentation, or 
isolation for access to the platform? 

Both the admin user interface (UI) and CLI 
can be configured to limit IP access to the 
system. 

Ref1 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Cisco ISE admin console and CLI both 
support role-based access control. 

Ref1 

SM 
2.4 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data in transit? 

Cisco ISE can be configured for Federal 
Information Processing Standards (FIPS) 
compliance. In this mode, only the 
protocols listed here are allowed to be 
used for authentication: EAP-TLS, PEAP, 
EAP-FAST, EAP-TTLS 

Ref1 

https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/215308-configure-certificate-or-smartcard-based.html
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/215308-configure-certificate-or-smartcard-based.html
https://community.cisco.com/kxiwq67737/attachments/kxiwq67737/4561-docs-security/5070/1/How-To_89_CA-signed_pxGridISEnode_CAsigned_pxGridclient.pdf
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/200891-Understanding-Admin-Access-and-RBAC-Poli.html
https://www.cisco.com/c/en/us/td/docs/security/ise/3-0/admin_guide/b_ISE_admin_3_0/b_ISE_admin_30_overview.html
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/200891-Understanding-Admin-Access-and-RBAC-Poli.html
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/200535-FIPS-Mode-on-ISE.html
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SM 
2.5 

Does the system support performing 
regular backups and restorations? 

Cisco ISE backs up to a repository both the 
configuration and event data. The system 
provides high-availability (HA) capabilities 
with redundant service pairs. 

Ref1 

SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

Cisco ISE provides a centralized patching 
mechanism through the admin node to 
apply patches to all systems that are a 
member of the deployment. Patches are 
rollups, so administrators do not have to 
install multiple patches. Patches include 
vulnerability fixes and bug fixes. 

Ref1 

SM 
3.3 

Does the platform allow for configuration 
management practices such as removal 
or disabling of services to maintain 
security? 

Cisco ISE allows administrators to turn on 
and off features and functions. Cisco ISE 
does not allow access to the underlying 
OS, so services are only enabled and 
disabled based on the packages needed to 
support the enabled services. 

Ref1 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

Log events for the following categories 
are sent by all nodes in the deployment to 
the logging targets: Administrative and 
Operational Audit, System Diagnostics, 
and System Statistics. 

Ref1 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

The web interface can specify remote 
syslog server targets to which system log 
messages are sent. Log messages are sent 
to the remote syslog server targets in 
accordance with the syslog protocol 
standard (RFC 3164). 

Ref1 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

Cisco provides training resources through 
direct offering, partner, knowledge 
partners, and on-demand through Cisco 
Live. 

 

SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

Cisco provides training resources through 
direct offering, partner, knowledge 
partners, and on-demand through Cisco 
Live. 

 

https://www.cisco.com/c/en/us/td/docs/security/ise/2-7/admin_guide/b_ise_27_admin_guide/b_ISE_admin_27_maintain_monitor.html#ID111
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/215406-patch-installation-on-ise-and-faq-durin.html
https://www.cisco.com/c/en/us/td/docs/security/ise/2-7/admin_guide/b_ise_27_admin_guide/b_ISE_admin_27_deployment.html#reference_9414B4B3040B4071947D3FA6B865924F
https://www.cisco.com/c/en/us/td/docs/security/ise/3-0/admin_guide/b_ISE_admin_3_0/b_ISE_admin_30_maintain_monitor.html#ID58
https://www.cisco.com/c/en/us/td/docs/security/ise/3-0/admin_guide/b_ISE_admin_3_0/b_ISE_admin_30_maintain_monitor.html#ID58
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SM 
5.3 

Are trainings updated and metrics 
collected to improve trainings? 

Cisco regularly collects metrics from 
completed user training to make 
improvements and updates. 

 

 759 

A.2.3 Eclypsium Administration and Analytics Service Support of Security 760 
Measures 761 

All entries in this table have the same two references: the Eclypsium-supplied Solution Guide and 762 
Deployment Guide. The Solution Guide is built into the product, and Eclypsium provides the Deployment 763 
Guide at purchase, so it was not possible to provide hyperlinks for this table. 764 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for the 
use of a two-factor authentication 
method for access? 

Eclypsium integrates with multiple 
authentication mechanisms, many of 
which support multi-factor authentication 
(MFA). 

  

SM 
1.2 

Does the software platform identify and 
authenticate users and machine accounts 
that try to access the platform? 

Unique application programming 
interface (API) tokens are managed by 
Eclypsium administrators. 

 
  

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Eclypsium platform contains 
Admin/User access roles. Only 
administrators can change systemwide 
analysis policies. 

 
 

SM 
1.4 

Does the system allow for the use of 
DACLs, network segmentation, or 
isolation for access to the platform? 

The Linux OS hosting Eclypsium can be 
configured to allow for the creation of 
network-based access restrictions. 

 
  

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Eclypsium platform contains 
Admin/User access roles. Only 
administrators can change systemwide 
analysis policies. 

 

SM 
2.3 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data at rest? 

The data-at-rest encryption 
implementation is done as part of the 
backend platform onto which Eclypsium is 
deployed. In the cloud, the provider's key 
management system may be used. In an 
on-premises deployment, the OS or 
hardware-based encryption on the 
physical servers may be used. 

 

https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
2.4 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data in transit? 

All communications occur over Transport 
Layer Security (TLS). FIPS mode can be 
enabled and utilized where desired. 

 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

Backups of the Eclypsium backend are 
performed as part of the platform onto 
which it is deployed. Standard 
mechanisms for Linux server 
backup/restore will operate normally. 

 

SM 
3.1 

Does the product list all software 
dependencies and currently installed 
applications/services? 

This information is in the Solution Guide. 
When scanning firmware on target 
systems, similar information may be 
inferred from binary analysis. 

 

SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

The cloud version is managed by 
Eclypsium to provide updates. The on-
premises version is the responsibility of 
the customer. The OS can be configured 
to perform updates. On target systems, 
Eclypsium will indicate whether firmware 
is up to date. 

 

SM 
3.3 

Does the platform allow for configuration 
management practices such as removal 
or disabling of services to maintain 
security? 

Eclypsium directly manages the 
configuration of cloud deployments. In an 
on-premises environment, configuration 
management becomes the responsibility 
of the customer. Normal configuration 
management for Linux servers will apply 
to the Eclypsium backend. 

 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

In most instances, syslog is integrated 
with SIEM tools. Eclypsium alerts for 
target systems are forwarded over syslog 
to such tools when configured. 

 

SM 
4.2 

Does the platform monitor the security 
and vulnerabilities associated with all 
software and dependencies used? 

There is an audit trail of users who have 
logged in and the actions they performed.  
Updates are also sent out to help 
remediate software running on the 
platform. 

 
 

https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
4.3 

Is anti-malware or antivirus able to be 
installed on the system running your 
platform? 

Eclypsium scanners and the Eclypsium 
backend are compatible with running 
other endpoint security software on the 
same device. 

 
 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

In cloud deployments, Eclypsium manages 
network security protections. In an on-
premises deployment, this would be 
inherited from the environment into 
which Eclypsium is deployed. 

 

SM 
4.5 

Are there training courses or procedures 
in the event of an incident involving the 
tool or platform? 

Eclypsium security operations personnel 
receive security and incident response 
training. Customer training is available 
from Eclypsium to cover firmware security 
and incident response scenarios. 

 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

Eclypsium has the latest training catalog. 
 

 
 

SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

Eclypsium has the latest training catalog. 
 

 
  

SM 
5.3 

Are trainings updated and metrics 
collected to improve trainings? 

Eclypsium has the latest training catalog.  

 765 

A.2.4 Forescout Platform Support of Security Measures 766 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for the 
use of a two-factor authentication 
method for access? 

The Forescout platform's integration with 
PIV and Homeland Security Presidential 
Directive 12 (HSPD-12) cards allows for 
this capability. 

Ref1 

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Forescout platform supports a range 
of accounts with different access levels as 
required to support least privilege. 

Ref1 

https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.forescout.com/bundle/admin-guide-8-2-2/page/admin-guide-8-2-2.Managing-Users.html%20%20%20https:/docs.forescout.com/bundle/admin-guide-8-2-2/page/admin-guide-8-2-2.Using-Smart-Card-Authentication.html
https://www.forescout.com/resources/modern-nac-whitepaper/


DRAFT 

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems 33 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.4 

Does the system allow for the use of 
DACLs, network segmentation, or 
isolation for access to the platform? 

Forescout supports the use of DACLs, 
virtual local area network (VLAN) 
assignment, and any other network-based 
control offered by the network devices in 
use for device isolation as needed. 

Ref1 

SM 
2.1 

Does the software list and maintain an 
inventory of all software criticalities and 
integrations? 

This is enabled via Forescout's native 
policy. 

Ref1 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

The Forescout platform supports a range 
of accounts with different access levels as 
required to support least privilege.  

Ref1 

SM 
2.3 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data at rest? 

Forescout natively encrypts the data at 
rest on the hard drives but can also verify 
and establish the encryption level of 
managed endpoints. 

Ref1 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

Forescout supports backup/restore of 
data and configurations of all appliances. 

Ref1 

SM 
3.1 

Does the product list all software 
dependencies and currently installed 
applications/services? 

Forescout can identify applications and 
services that are installed and/or running 
on Windows, Linux, and macOS. Remote 
inspection capabilities are enabled either 
by integration with AD (LDAP) or via an 
agent (Secure Connector). This in turn can 
be enhanced by creating Forescout 
security policies to identify all software 
with enhanced privileges and known 
CVEs. 

 

SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

Forescout integrates with a variety of 
patch and OS management tools. 
Forescout has native remediations via 
scripting on endpoints via policy.  

Ref1 

SM 
3.3 

Does the platform allow for configuration 
management practices such as removal 
or disabling of services to maintain 
security? 

Forescout can perform control actions 
against any managed endpoint. Services 
as a property are an attribute detected 
running/installed on the endpoint. These 
attributes (services) can in turn can be 
stopped/started or removed as required 
via policy. 

Ref1 

https://www.forescout.com/products/eyesegment/
https://docs.forescout.com/bundle/admin-guide-8-2-2/page/admin-guide-8-2-2.Policy-Management.html
https://www.forescout.com/resources/modern-nac-whitepaper/
https://docs.forescout.com/bundle/install-guide-8-2-2/page/install-guide-8-2-2.Installation-Overview.html
https://docs.forescout.com/bundle/install-guide-8-2-2/page/install-guide-8-2-2.Restore-Enterprise-Manager-System-Settings.html
https://www.forescout.com/products/eyeextend/
https://www.forescout.com/resources/forescout-eyecontrol-datasheet/
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

The Forescout platform will send rich 
device context information to a SIEM 
system for logging and event analysis. 

Ref1 
Ref2 

SM 
4.2 

Does the platform monitor the security 
and vulnerabilities associated with all 
software and dependencies used? 

Forescout supports a default Windows 
Vulnerability CVE/Patch plugin (published 
by Microsoft) to actively scan all Windows 
clients/servers in real time via policy. The 
Forescout platform also provides Security 
Policy Templates (SPT) covering zero-day 
information and assesses software and 
hardware for these issues. SPT includes 
vulnerability and response templates with 
relevant data for vulnerabilities as 
documented by Forescout security labs. 

Ref1 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

All successful and failed connections to 
the Forescout platform are logged in 
system event logs. Administrators can 
view these logs. An option is also available 
to forward event messages to third-party 
logging systems via syslog. 

Ref1 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

Forescout offers training and 
certifications for administrators. 

Ref1 

SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

Forescout offers training and 
certifications for engineers. 

Ref1 
  

 767 

A.2.5 IBM Code Risk Analyzer Support of Security Measures 768 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for the 
use of a two-factor authentication 
method for access? 

It leverages the IBM Cloud authentication 
mechanism, which provides multi-factor 
authentication for all users and 
administrators. 

 
  

SM 
1.2 

Does the software platform identify and 
authenticate users and machine accounts 
that try to access the platform? 

All users and machines are identified 
using the Identity and Access 
Management feature of IBM Cloud. 

 
  

https://docs.forescout.com/bundle/splunk-3.0-h/page/splunk-3.0-h.Create-a-Send-Endpoint-and-Policy-Details-to-Spl.html
https://www.forescout.com/resources/splunk-extended-module-datasheet/
https://docs.forescout.com/bundle/spt-content-h/page/spt-content-h.Policy-Templates-in-the-Security-Policy-Template.html
https://www.forescout.com/products/eyesegment/
https://www.forescout.com/wp-content/uploads/2017/05/FS-DS-FSCA_Training-and-Certification.pdf
https://www.forescout.com/resources/fsce-training-datasheet
https://www.forescout.com/resources/fsce-training-datasheet
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

Accounts can be created and assigned to 
appropriate roles that have different 
access levels. This functionality is 
provided by the Identify and Access 
Management feature of IBM Cloud. 

 
 

SM 
1.4 

Does the system allow for the use of 
DACLs, network segmentation, or 
isolation for access to the platform? 

Network segmentation and isolation is 
done by using Kubernetes clusters and 
Istio as the service mesh. Strict policies 
exist for egress and ingress. 

 
  

SM 
2.1 

Does the software list and maintain an 
inventory of all software criticalities and 
integrations? 

The software keeps a bill of materials for 
each component. This bill of materials 
contains a full list of third-party 
dependencies. Integration is allowed with 
only IBM-authorized software. 

 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

This feature is achieved by using the 
Identity and Access Management (IAM) 
feature of IBM Cloud. IAM has 
comprehensive features for granular 
access for users, administrators, and 
machines. 

 

SM 
2.3 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data at rest? 

All data at rest, whether in databases or 
file systems, is encrypted using NIST-
certified cryptographic standards. 

 

SM 
2.4 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data in transit? 

All data in transit is encrypted using NIST-
certified cryptographic standards. This 
includes data that is flowing between 
microservices inside a cluster. 

 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

The system data is backed up regularly for 
offsite storage. Disaster recovery 
procedures are reviewed and tested 
regularly by IBM engineers. 

 

SM 
3.1 

Does the product list all software 
dependencies and currently installed 
applications/services? 

A bill of materials is created for each 
microservice. Integrations with databases 
and other systems are tracked. Change 
management is rigorously followed. 

 

https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
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SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

The OS, middleware, and application 
components are regularly patched using 
automated pipelines. These components 
are scanned for any vulnerabilities and 
patches are deployed within strict 
timeframes. 

 

SM 
3.3 

Does the platform allow for configuration 
management practices such as removal 
or disabling of services to maintain 
security? 

The system is configured and deployed 
using various standard techniques such as 
Kubernetes Helm charts and YAML files.  
The service can be disabled in all regions 
within minutes by disabling DNS entries, 
reverse proxies, etc. 

 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

Syslog data is streamed to centralized 
logging mechanisms. The security events 
data is also made available to clients using 
the Activity Tracker mechanism. 

 

SM 
4.2 

Does the platform monitor the security 
and vulnerabilities associated with all 
software and dependencies used? 

Continuous monitoring for security is 
accomplished by using firewalls and 
service mesh. 

 
 

SM 
4.3 

Is anti-malware or antivirus able to be 
installed on the system running your 
platform? 

All systems running the system have anti-
malware software running on them. 
Comprehensive reports are generated to 
ensure compliance. 

 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

All successful and unsuccessful 
connections are logged in the Activity 
Tracker and in the Identity and Access 
Management system of IBM Cloud. 

 

SM 
4.5 

Are there training courses or procedures 
in the event of an incident involving the 
tool or platform? 

Process documentation, runbooks, 
training, and technology are in place to 
respond to incidents in a timely manner. 
High-severity incidents are tracked at 
executive levels. Root-cause analysis is 
performed and actionable tasks are 
documented. Best practices are shared 
across all teams in IBM Cloud. 

 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

Self-service tutorials are available to users 
based on their roles. Comprehensive 
documentation is available as well. 

 

https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
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SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

IBM Garage teams host courses for all 
aspects of the IBM Cloud platform. 

 

SM 
5.3 

Are trainings updated and metrics 
collected to improve trainings? 

Regular trainings are conducted for all 
developers and administrators that are 
responsible for operating the IBM Cloud. 
The training materials are revised as new 
best practices become available. 

 

 769 

A.2.6 IBM MaaS360 with Watson Support of Security Measures 770 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.2 

Does the software platform identify and 
authenticate users and machine 
accounts that try to access the 
platform? 

Connections to IBM MaaS360 are 
authenticated with API keys or credentials.  

Ref1 
  

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

In the MaaS360 admin console, roles can 
be assigned to each administrator based 
on their individual needs. 

Ref1  
 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

In the MaaS360 admin console, custom 
roles can be defined with granular access 
rights. 

Ref1 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different 
courses for different roles? 

IBM MaaS360 offers training courses that 
are catered to the role an individual will 
hold utilizing the product. 

Ref1 
  

SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

IBM MaaS360 offers training courses for 
administrative users. 

Ref1 
Ref2 
 

SM 
5.3 

Are trainings updated and metrics 
collected to improve trainings? 

Release Notes are regularly updated with 
new and updated feature information, and  
the “MaaS360 Latest” panel provides 
videos and tutorials on new and updated 
capabilities. Each training course has a star 
rating system for effectiveness and 
improvement purposes. 

Ref1 

 771 

https://www.ibm.com/docs/en/maas360?topic=services-auto-provisioning-web
https://www.ibm.com/docs/en/maas360?topic=services-auto-provisioning-web
https://www.ibm.com/docs/en/maas360?topic=administrators-access-roles-rights-portal
https://www.ibm.com/docs/en/maas360?topic=administrators-access-roles-rights-portal
https://www.ibm.com/docs/en/maas360?topic=portal-creating-admin-role-administrators
https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
https://www.securitylearningacademy.com/course/view.php?id=3526
https://www.securitylearningacademy.com/course/view.php?id=3526
https://www.securitylearningacademy.com/course/view.php?id=3526
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A.2.7 Lookout MES Support of Security Measures 772 

SM # Description Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for 
the use of a two-factor authentication 
method for access? 

Organizations can integrate their existing 
Security Assertion Markup Language 
(SAML) 2.0 MFA solutions for authorization 
purposes into the Lookout MES Console. 

 

SM 
1.2 

Does the software platform identify and 
authenticate users and machine 
accounts that try to access the 
platform? 

Lookout identifies and authenticates each 
user or machine account that attempts to 
access the platform. Audit logs also collect 
actions taken by each account. 

 

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

Lookout allows for the creation of several 
administrative types with decreasing levels 
of access. 

 
 

SM 
2.1 

Does the software list and maintain an 
inventory of all software criticalities and 
integrations? 

The Lookout MES Console provides a full 
application inventory list of all devices 
within the customer’s user fleet. 

 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

Lookout allows for the creation of several 
administrative types with decreasing levels 
of access. 

 

SM 
2.3 

Does the system use or contain an 
option to enable the use of NIST-
certified cryptographic standards for 
protecting data at rest? 

Data at rest is encrypted using Advanced 
Encryption Standard (AES) 256-bit 
encryption. 

 

SM 
2.4 

Does the system use or contain an 
option to enable the use of NIST-
certified cryptographic standards for 
protecting data in transit? 

Data in transit is encrypted using TLS 
version 1.2. 

 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

Daily backups and snapshots of the 
production environment are taken and 
stored via Amazon’s S3 service within 
multiple zones and US regions. Regular 
integrity checks occur through restorations 
occurring multiple times annually. These 
restores populate new production 
instances which are then verified and 
monitored. 
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SM 
3.1 

Does the product list all software 
dependencies and currently installed 
applications/services? 

The Lookout MES Console provides a full 
application inventory list of all devices 
within the customer's user fleet. 

 

SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

Patches to the Lookout MES Console are 
controlled and maintained by Lookout 
backoffice support. 

 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

Lookout uses a representational state 
transfer (REST) API to capture and send all 
console-related logs (e.g., device changes, 
threat information, system audit events) to 
SIEMs and syslog readers. 

 

SM 
4.2 

Does the platform monitor the security 
and vulnerabilities associated with all 
software and dependencies used? 

Lookout is Federal Risk and Authorization 
Management Program (FedRAMP) 
Moderate and therefore follows strict 
patch management controls for patching 
our own software. 

 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

Lookout captures connection events to the 
tool and activities conducted within the 
tool via our auditing capabilities. 

 

SM 
4.5 

Are there training courses or procedures 
in the event of an incident involving the 
tool or platform? 

Internally, Lookout has established 
procedures for how to respond to a 
security incident (leak, compromise, etc.). 
These procedures follow strict FedRAMP 
Moderate policies. 

 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different 
courses for different roles? 

Lookout provides first-touch training and 
guidance for using the Lookout MES and 
for integration guidance with a customer's 
MDM. Additionally, frequently asked 
questions (FAQs), integration guides, and 
console user guides are available to all 
administrators via the Lookout Support 
Knowledge portal. 
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SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

Lookout provides first-touch training and 
guidance for using the Lookout MES and 
for integration guidance with a customer's 
MDM. Additionally, FAQs, integration 
guides, and console user guides are 
available to all administrators via the 
Lookout Support Knowledge portal. 

 

 773 

A.2.8 Microsoft Endpoint Configuration Manager (ECM) Support of Security 774 
Measures 775 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for the 
use of a two-factor authentication 
method for access? 

Access to ECM Site Collections can be 
restricted via strong authentication. This 
can include MFA and passwordless 
options like Windows Hello for Business. 

Ref1 
  

SM 
1.2 

Does the software platform identify and 
authenticate users and machine accounts 
that try to access the platform? 

ECM natively audits logins and activities 
and can be reported on by utilizing ECM 
Reports. 

Ref1 
  

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

ECM supports achieving least privilege 
through security roles, scopes, and 
collections. 

Ref1  
 

SM 
1.4 

Does the system allow for the use of 
DACLs, network segmentation, or 
isolation for access to the platform? 

Microsoft provides guidance around the 
ports and protocols required by ECM. 
Customers can use this to implement 
firewalls between services and clients.   

Ref1 
  

SM 
2.1 

Does the software list and maintain an 
inventory of all software criticalities and 
integrations? 

Configuration Manager uses an in-console 
service method called Updates and 
Servicing. It makes it easy to find and 
install recommended updates for your 
Configuration Manager infrastructure. 

Ref1 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

ECM supports achieving least privilege 
through security roles, scopes, and 
collections. 

Ref1 

https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/understand/fundamentals-of-role-based-administration
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/updates
https://docs.microsoft.com/en-us/mem/configmgr/core/understand/fundamentals-of-role-based-administration
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SM 
2.3 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data at rest? 

ECM supports encryption at rest natively 
and through the use of BitLocker.  

Ref1 

SM 
2.4 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data in transit? 

ECM supports encryption for data in 
transport. 

Ref1 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

Backup and restore operations are core 
resiliency capabilities in ECM. 

Ref1 

SM 
3.1 

Does the product list all software 
dependencies and currently installed 
applications/services? 

ECM lists the software dependencies that 
are required for the platform to operate 
on the server in addition to client end 
nodes. 

Ref1 

SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

Configuration Manager uses an in-console 
service method called Updates and 
Servicing. It makes it easy to find and 
install recommended updates for your 
Configuration Manager infrastructure. 

Ref1 

SM 
3.3 

Does the platform allow for configuration 
management practices such as removal 
or disabling of services to maintain 
security? 

Configuration Manager supports installing 
specific roles, for example management 
points, distribution points, and software 
update points, which contain the services 
required to run that service only. 

Ref1 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

Logs are stored in the ECM database, log 
files, and Windows Event Logs. 
Implementation guidance is specific to the 
capabilities of the SIEM. 

 

SM 
4.2 

Does the platform monitor the security 
and vulnerabilities associated with all 
software and dependencies used? 

Configuration Manager includes software 
update monitoring, which can be used to 
identify vulnerable software on its 
infrastructure. 

Ref1 
 

SM 
4.3 

Is anti-malware or antivirus able to be 
installed on the system running your 
platform? 

Anti-malware and anti-virus solutions can 
be installed on the host operating system. 
Microsoft recommends allowlisting the 
files and processes related to ECM. 

Ref1 
 

https://docs.microsoft.com/en-us/windows/security/information-protection/bitlocker/bitlocker-how-to-deploy-on-windows-server
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/cryptographic-controls-technical-reference
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/backup-and-recovery
https://docs.microsoft.com/en-us/mem/configmgr/core/clients/deploy/prerequisites-for-deploying-clients-to-windows-computers
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/updates
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/deploy/start-using
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
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SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

Client and management point logging can 
be configured at various levels to meet 
customer requirements. 

Ref1 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

Microsoft offers training courses that are 
catered to the role an individual will have 
utilizing the product. 

Ref1 
 

SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

Microsoft provides e-learning and 
certification preparation guides for ECM 
on the Microsoft Learn portal. Hands-on 
or train-the-trainer models are provided 
through an implementation partner. 

Ref1 
  

SM 
5.3 

Are trainings updated and metrics 
collected to improve trainings? 

Courses and certifications are periodically 
updated based on product enhancements 
and feedback from customers. 

 

 776 

A.2.9 Tenable.sc Support of Security Measures 777 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.1 

Does the software platform allow for the 
use of a two-factor authentication 
method for access? 

MFA is achieved through certificate-based 
authentication and SAML authentication. 

Ref1 
Ref2 

SM 
1.2 

Does the software platform identify and 
authenticate users and machine accounts 
that try to access the platform? 

This is default behavior. Connections are 
authenticated with API keys or 
credentials, then handled via session 
cookie. 

Ref1 
Ref2 

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

This is default behavior provided by role-
based access control. 

Ref1  
 

SM 
1.4 

Does the system allow for the use of 
DACLs, network segmentation, or 
isolation for access to the platform? 

Tenable.sc can bind https interface to a 
single IP/network interface card (NIC) and 
utilize sideband networks for 
management/administration. 

Ref1 
Ref2 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

This is default behavior provided by role-
based access control. 

Ref1 

https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/about-log-files
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.tenable.com/tenablesc/Content/SSLClientCertAuth.htm
https://docs.tenable.com/tenablesc/Content/SAMLAuthentication.htm
https://docs.tenable.com/tenablesc/Content/UserAccess.htm
https://docs.tenable.com/tenablesc/Content/Login.htm
https://docs.tenable.com/tenablesc/Content/UserRoles.htm
https://docs.tenable.com/tenablesc/Content/SystemRequirements.htm#Secure
https://docs.tenable.com/tenablesc/Content/ConfigurationSettings.htm
https://docs.tenable.com/tenablesc/lg/Content/AccessControl.htm
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SM 
2.3 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data at rest? 

Tenable.sc provides encryption for critical 
resources (target credentials). For 
vulnerability data and application 
configuration information, an external 
data-at-rest solution is required. 

Ref1 

SM 
2.4 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data in transit? 

This is default behavior. Ref1 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

Tenable supports administrator backup of 
the opt/sc directory. Backups can be 
scripted to run on the host OS. 

Ref1 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

The Tenable.sc application can use the 
host OS’s syslog implementation to 
leverage an external syslog or SIEM. 

Ref1 

SM 
4.2 

Does the platform monitor the security 
and vulnerabilities associated with all 
software and dependencies used? 

Tenable.sc can scan an environment 
passively (with the use of Nessus Network 
Monitor/NNM) and actively to achieve 
continuous monitoring. 

Ref1 
Ref2 

SM 
4.3 

Is anti-malware or antivirus able to be 
installed on the system running your 
platform? 

Anti-malware and anti-virus solutions can 
be installed. Tenable recommends 
allowlisting the files and processes related 
to Nessus and Tenable.sc. 

Ref1 
Ref2 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

NNM not only does passive analysis for 
vulnerabilities, but it can also provide 
logging of connection events as 
Informational events. 

Ref1 

SM 
4.5 

Are there training courses or procedures 
in the event of an incident involving the 
tool or platform? 

Tenable has many training options 
available to customers of our products, 
including instructional videos, free 
trainings, and paid trainings for deeper 
dives and larger groups. 

Ref1 
Ref2 
Ref3 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

Tenable offers training courses that are 
catered to the role an individual will have 
utilizing the product. 

Ref1 
Ref2 
Ref3 

https://docs.tenable.com/tenablesc/Content/EncryptionStrength.htm
https://docs.tenable.com/tenablesc/Content/EncryptionStrength.htm
https://docs.tenable.com/tenablesc/Content/Backup.htm
https://docs.tenable.com/tenablesc/Content/ConfigurationSettings.htm
https://docs.tenable.com/tenablesc/Content/ActiveScanObjects.htm
https://docs.tenable.com/nnm/Content/GetStarted.htm
https://docs.tenable.com/nessus/Content/Whitelist.htm
https://docs.tenable.com/nessusagent/Content/Whitelist.htm
https://docs.tenable.com/nnm/Content/ConnectionsSection.htm
https://www.tenable.com/education
https://www.youtube.com/channel/UCX_67IPEhqyYF9ppVRAcAwQ
https://university.tenable.com/
https://www.tenable.com/education
https://www.youtube.com/channel/UCX_67IPEhqyYF9ppVRAcAwQ
https://university.tenable.com/
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SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

Tenable offers training courses for 
administrative users. 

Ref1 
Ref2 
Ref3 

SM 
5.3 

Are trainings updated and metrics 
collected to improve trainings? 

Tenable continually collects feedback and 
introduces changes based on product 
updates and user feedback. 

 

 

A.2.10 VMware vRealize Automation SaltStack Config Support of Security 778 
Measures 779 

SM # Question Technical Mechanism or Configuration Refs. 

SM 
1.2 

Does the software platform identify and 
authenticate users and machine accounts 
that try to access the platform? 

This can be set up in the SaltStack Config 
component or done through integration 
with LDAP, AD, SAML, or OpenID Connect 
(OIDC) providers. 

Ref1 
  

SM 
1.3 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

This can be set up in SaltStack Config or 
done through integration with LDAP, AD, 
SAML, or OIDC providers. 

Ref1 
  

SM 
1.4 

Does the system allow for the use of 
DACLs, network segmentation, or 
isolation for access to the platform? 

The Linux OS hosting SaltStack Config can 
be configured to perform network 
isolation. 

 
  

SM 
2.1 

Does the software list and maintain an 
inventory of all software criticalities and 
integrations? 

VMWare tracks each product used by 
SaltStack Config and any updates and 
vulnerabilities in those products. 

 

SM 
2.2 

Does the system allow for creating 
accounts with different access levels to 
enforce least management? 

This can be set up in SaltStack Config or 
done through integration with LDAP, AD, 
SAML, or OIDC providers. 

Ref1 
  

SM 
2.3 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data at rest? 

SaltStack Config has a FIPS-compliant 
mode that can be configured at 
installation time to support encryption of 
data at rest. 

Ref1 

SM 
2.4 

Does the system use or contain an option 
to enable the use of NIST-certified 
cryptographic standards for protecting 
data in transit? 

SaltStack Config supports encryption for 
data in transit by default. Key generation 
uses standard algorithms found in the 
OpenSSL library. These algorithms rely on 
OS-generated random seed data. 

 

https://www.tenable.com/education
https://www.youtube.com/channel/UCX_67IPEhqyYF9ppVRAcAwQ
https://university.tenable.com/
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/install-configure-saltstack-config/GUID-D3B8A6AF-6F1A-409D-872C-8F96EDADBD73.html?hWord=N4IghgNiBcIGIEkAKBnABAWQPYBMCmIAvkA
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
2.5 

Does the system support performing 
regular backups and restorations? 

SaltStack Config allows administrators to 
perform manual backups. 

Ref1 

SM 
3.1 

Does the product list all software 
dependencies and currently installed 
applications/services? 

SaltStack provides a list of all dependent 
software and libraries used within the 
product. 

 

SM 
3.2 

Does the platform allow for the 
deployment of patches and OS updates? 

The Linux system hosting SaltStack can be 
updated by administrators. The SaltStack 
SecOps component can be utilized to 
perform updates on SaltStack nodes and 
client end nodes. 

Ref1 

SM 
3.3 

Does the platform allow for configuration 
management practices such as removal 
or disabling of services to maintain 
security? 

SaltStack Config allows for configuration 
management through the implementation 
of Salt states, the beacon and reactor 
system, and/or orchestration. 

Ref1 

SM 
4.1 

Does the security tool support logging 
and sending that data to rsyslog or a 
SIEM? 

Salt returners can be used/configured to 
send logs to third-party tools like rsyslog, 
splunk, etc. 

Ref1 

SM 
4.2 

Does the platform monitor the security 
and vulnerabilities associated with all 
software and dependencies used? 

VMWare tracks each product used by 
SaltStack Config and tracks any updates 
and vulnerabilities that are announced by 
the product owners. 

 
 

SM 
4.3 

Is anti-malware or antivirus able to be 
installed on the system running your 
platform? 

Anti-malware and anti-virus solutions can 
be installed on the host Linux OS. 

 
 

SM 
4.4 

Does the platform allow for logging 
connection events to the tool? 

You can set the logging level to debug or 
turn on the audit trail, and that will 
provide connection events. 

Ref1 

SM 
4.5 

Are there training courses or procedures 
in the event of an incident involving the 
tool or platform? 

There is official training for customers of 
the platform. Also, support contracts can 
be purchased to help troubleshoot and fix 
incidents with the product. 

Ref1 

SM 
5.1 

Are there training courses in how to use 
the products? Are there different courses 
for different roles? 

VMware provides training on the 
underlying platform (SaltStack Config and 
vRealize Automation) as well as the 
security operations product. 

Ref1 

https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/install-configure-saltstack-config/GUID-984CCC14-4511-494F-86B6-F257579B57A4.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-02DF1763-BC06-4454-BCE3-D9C3336DA6B0.html?hWord=N4IghgNiBcIM4FMDGB7ADnEBfIA
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-96A02EE1-CD8D-4641-8048-A1E25DBAC4D5.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/install-configure-saltstack-config/GUID-D3B8A6AF-6F1A-409D-872C-8F96EDADBD73.html?hWord=N4IghgNiBcIGIEkAKBnABAWQPYBMCmIAvkA
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/install-configure-saltstack-config/GUID-D3B8A6AF-6F1A-409D-872C-8F96EDADBD73.html?hWord=N4IghgNiBcIGIEkAKBnABAWQPYBMCmIAvkA
https://mylearn.vmware.com/mgrReg/courses.cfm?ui=www_edu&a=one&id_subject=96449
https://mylearn.vmware.com/mgrReg/courses.cfm?ui=www_edu&a=one&id_subject=96449
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SM # Question Technical Mechanism or Configuration Refs. 

SM 
5.2 

Are there training courses for teaching 
administrators how to utilize the 
platform? 

VMware provides training on the 
underlying platform (SaltStack Config and 
vRealize Automation) as well as the 
security operations product. 

Ref1  
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Appendix B List of Acronyms 780 

 

AD Active Directory 

AES Advanced Encryption Standard 

ANC Adaptive Network Control 

API Application Programming Interface 

BIOS Basic Input/Output System 

CAC Common Access Card 

CIO Chief Information Officer 

CISO Chief Information Security Officer 

CLI Command-Line Interface 

CRADA Cooperative Research and Development Agreement 

CVE Common Vulnerabilities and Exposures 

CVSS Common Vulnerability Scoring System 

DACL Discretionary Access Control List 

DHCP Dynamic Host Configuration Protocol 

DNS Domain Name System 

ECM (Microsoft) Endpoint Configuration Manager 

EMM  Enterprise Mobility Management  

EO Executive Order 

FAQ Frequently Asked Questions 

FedRAMP Federal Risk and Authorization Management Program 

FIPS Federal Information Processing Standards 

FMC (Cisco) Firepower Management Center 

FTD (Cisco) Firepower Threat Defense 

HA High Availability 
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HSPD-12 Homeland Security Presidential Directive 12 

IAM Identity and Access Management 

ICS  Industrial Control System  

IoT  Internet of Things  

IP Internet Protocol 

ISE (Cisco) Identity Services Engine 

IT  Information Technology  

LDAP Lightweight Directory Access Protocol 

MDM Mobile Device Manager 

MES (Lookout) Mobile Endpoint Security 

MFA Multi-Factor Authentication 

NCCoE  National Cybersecurity Center of Excellence  

NIC Network Interface Card 

NIST  National Institute of Standards and Technology  

NNM (Tenable) Nessus Network Monitor 

OIDC OpenID Connect 

OS  Operating System  

OT  Operational Technology  

PC  Personal Computer  

PIV Personal Identity Verification 

REST Representational State Transfer 

RMF Risk Management Framework 

SaaS  Software as a Service  

SAML Security Assertion Markup Language 

SAN  Storage Area Network  

SCCM (Microsoft) System Center Configuration Manager 
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SGT Security Group Tag 

SIEM Security Information and Event Management 

SM Security Measure 

SMS (Microsoft) Systems Management Server 

SP  Special Publication  

SPT (Forescout) Security Policy Templates 

SSH Secure Shell 

TLS Transport Layer Security 

UEM Unified Endpoint Management 

UI User Interface 

VLAN Virtual Local Area Network 

VM  Virtual Machine  

WaaS  Windows as a Service  

WSUS  (Microsoft) Windows Server Update Services  
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tended to imply that the entities, equipment, products, or materials are necessarily the best available 6 
for the purpose. 7 

While NIST and the NCCoE address goals of improving management of cybersecurity and privacy risk 8 
through outreach and application of standards and best practices, it is the stakeholder’s responsibility to 9 
fully perform a risk assessment to include the current threat, vulnerabilities, likelihood of a compromise, 10 
and the impact should the threat be realized before adopting cybersecurity measures such as this 11 
recommendation. 12 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 27 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 28 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 29 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 30 
public-private partnership enables the creation of practical cybersecurity solutions for specific 31 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 32 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 33 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 34 
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity 35 
solutions using commercially available technology. The NCCoE documents these example solutions in 36 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 37 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 38 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 39 
Maryland. 40 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 41 
https://www.nist.gov. 42 

NIST CYBERSECURITY PRACTICE GUIDES 43 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 44 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 45 
adoption of standards-based approaches to cybersecurity. They show members of the information 46 
security community how to implement example solutions that help them align with relevant standards 47 
and best practices, and provide users with the materials lists, configuration files, and other information 48 
they need to implement a similar approach. 49 

The documents in this series describe example implementations of cybersecurity practices that 50 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 51 
or mandatory practices, nor do they carry statutory authority.  52 

ABSTRACT 53 

Despite widespread recognition that patching is effective and attackers regularly exploit unpatched 54 
software, many organizations do not adequately patch. There are myriad reasons why, not the least of 55 
which are that it’s resource-intensive and that the act of patching can reduce system and service 56 
availability. Also, many organizations struggle to prioritize patches, test patches before deployment, and 57 
adhere to policies for how quickly patches are applied in different situations. To address these 58 
challenges, the NCCoE is collaborating with cybersecurity technology providers to develop an example 59 
solution that addresses these challenges. This NIST Cybersecurity Practice Guide explains how tools can 60 
be used to implement the patching and inventory capabilities organizations need to handle both routine 61 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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and emergency patching situations, as well as implement workarounds, isolation methods, or other 62 
alternatives to patching. It also explains recommended security practices for patch management 63 
systems themselves. 64 

KEYWORDS 65 

cyber hygiene; enterprise patch management; firmware; patch; patch management; software; update; 66 
upgrade; vulnerability management 67 
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DOCUMENT CONVENTIONS  74 

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the 75 
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that 76 
among several possibilities, one is recommended as particularly suitable without mentioning or 77 
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in 78 
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms 79 
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CALL FOR PATENT CLAIMS 82 

This public review includes a call for information on essential patent claims (claims whose use would be 83 
required for compliance with the guidance or requirements in this Information Technology Laboratory 84 
(ITL) draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication 85 
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or by reference to another publication. This call also includes disclosure, where known, of the existence 86 
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant 87 
unexpired U.S. or foreign patents. 88 

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in writ-89 
ten or electronic form, either: 90 

a) assurance in the form of a general disclaimer to the effect that such party does not hold and does not 91 
currently intend holding any essential patent claim(s); or 92 

b) assurance that a license to such essential patent claim(s) will be made available to applicants desiring 93 
to utilize the license for the purpose of complying with the guidance or requirements in this ITL draft 94 
publication either: 95 

1. under reasonable terms and conditions that are demonstrably free of any unfair discrimination; 96 
or  97 

2. without compensation and under reasonable terms and conditions that are demonstrably free 98 
of any unfair discrimination.  99 

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its 100 
behalf) will include in any documents transferring ownership of patents subject to the assurance, provi-101 
sions sufficient to ensure that the commitments in the assurance are binding on the transferee, and that 102 
the transferee will similarly include appropriate provisions in the event of future transfers with the goal 103 
of binding each successor-in-interest.  104 

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of 105 
whether such provisions are included in the relevant transfer documents.  106 

Such statements should be addressed to: cyberhygiene@nist.gov  107 
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1 Introduction 264 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 265 
Technology (NIST) built an example solution in a laboratory environment to demonstrate how 266 
organizations can use technologies to improve enterprise patch management for their general 267 
information technology (IT) assets. 268 

This volume of the practice guide shows IT professionals and security engineers how we have 269 
implemented the example solution. It covers all of the products employed in this reference design, 270 
summarizes their integration into the laboratory environment, and documents security decisions and 271 
associated configurations. We do not re-create the product manufacturers’ documentation, which is 272 
presumed to be widely available. Rather, these volumes show how we incorporated the products 273 
together in our environment. 274 

This draft covers both phases of the example solution. Phase 1 involved two types of IT assets: desktop 275 
and laptop computers, and on-premises servers. Phase 2 added mobile devices and containers. 276 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 277 
for these products that are out of scope for this example implementation. 278 

1.1 How to Use this Guide 279 

This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and provides 280 
users with the information they need to replicate the proposed approach for improving enterprise 281 
patching practices for general IT systems. This design is modular and can be deployed in whole or in 282 
part. 283 

This guide contains three volumes: 284 

 NIST Special Publication (SP) 1800-31A: Executive Summary – why we wrote this guide, the 285 
challenge we address, why it could be important to your organization, and our approach to 286 
solving the challenge 287 

 NIST SP 1800-31B: Security Risks and Capabilities – why we built the example implementation, 288 
including the risk analysis performed and the security capabilities provided by the 289 
implementation 290 

 NIST SP 1800-31C: How-To Guides – what we built, with instructions for building the example 291 
implementation, including all the details that would allow you to replicate all or parts of this 292 
project (you are here) 293 

Depending on your role in your organization, you might use this guide in different ways: 294 

Business decision makers, including chief security and technology officers, will be interested in the 295 
Executive Summary, NIST SP 1800-31A, which describes the following topics: 296 
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 challenges that enterprises face in mitigating risk from software vulnerabilities 297 

 example solution built at the NCCoE 298 

 benefits of adopting the example solution 299 

Business decision makers can also use NIST SP 800-40 Revision 4 (Draft), Guide to Enterprise Patch 300 
Management Planning: Preventive Maintenance for Technology. It complements the implementation 301 
focus of this guide by recommending creation of an enterprise strategy to simplify and operationalize 302 
patching while also reducing risk. 303 

Technology or security program managers who are concerned with how to identify, understand, assess, 304 
and mitigate risk will be interested in NIST SP 1800-31B, which describes what we did and why. The 305 
following sections will be of particular interest: 306 

 Section 3.5.1, Threats, Vulnerabilities, and Risks, describes the risk analysis we performed. 307 

 Section 3.5.2, Security Control Map, maps the security characteristics of this example solution 308 
to cybersecurity standards and best practices. 309 

You might share the Executive Summary, NIST SP 1800-31A, with your leadership team members to help 310 
them understand the importance of adopting standards-based, automated patch management. Also, 311 
NIST SP 800-40 Revision 4 (Draft), Guide to Enterprise Patch Management Planning: Preventive 312 
Maintenance for Technology may also be helpful to you and your leadership team. 313 

IT professionals who may be interested in implementing an approach similar to ours will find the entire 314 
practice guide useful. In particular, the How-To portion of the guide, NIST SP 1800-31C could be used to 315 
replicate all or parts of the build created in our lab. Furthermore, the How-To portion of the guide 316 
provides specific product installation, configuration, and integration instructions for implementing the 317 
example solution. We have omitted the general installation and configuration steps outlined in 318 
manufacturers’ product documentation since they are typically made available by manufacturers. 319 
Instead, we focused on describing how we incorporated the products together in our environment to 320 
create the example solution. 321 

This guide assumes that the reader of this document is a seasoned IT professional with experience in 322 
implementing security solutions within an enterprise setting. While we have used a suite of commercial 323 
and open-source products to address this challenge, this guide does not endorse these particular 324 
products. Your organization can adopt this solution or one that adheres to these guidelines in whole, or 325 
you can use this guide as a starting point for tailoring and implementing parts of an automated 326 
enterprise patch management system. Your organization’s security experts should identify the products 327 
that will best integrate with your existing tools and IT system infrastructure. We hope that you will seek 328 
products that are congruent with applicable standards and recommended practices. The Technologies 329 
section of NIST SP 1800-31B lists the products we used and maps them to the cybersecurity controls 330 
provided by this example solution. 331 

https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
https://csrc.nist.gov/publications/detail/sp/800-40/rev-4/draft
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A NIST Cybersecurity Practice Guide does not describe “the” solution, but an example solution. This is a 332 
draft guide. We seek feedback on the contents of this guide and welcome your input. Comments, 333 
suggestions, and success stories will improve subsequent versions of this guide. Please contribute your 334 
thoughts to cyberhygiene@nist.gov. 335 

1.2 Build Overview 336 

This NIST Cybersecurity Practice Guide addresses the use of commercially available technologies to 337 
develop an example implementation for deploying an automated patch management system. This 338 
project focuses on enterprise patch management for small to large enterprises. The example solution 339 
demonstrates how to manage assets to reduce outages, improve security, and continuously monitor and 340 
assess asset vulnerabilities. 341 

1.2.1 Use Case Scenarios 342 

The NCCoE team worked with the project collaborators to create a lab environment that includes the 343 
architectural components and functionality that will be described later in this section. These use case 344 
scenarios were demonstrated in the lab environment as applicable for desktop and laptop computers, 345 
on-premises servers, mobile devices, and containers: 346 

 Asset identification and assessment: discovering physical and virtual assets on your corporate 347 
network, and performing automated assessments to prioritize their remediation. For this 348 
scenario, it is important to determine some information about each asset, such as hostname, 349 
Internet Protocol (IP) address, Media Access Control (MAC) address, firmware version, 350 
operating system (OS) version, and installed software packages. This information can be used 351 
to identify the asset and synchronize with other systems such as asset and configuration 352 
management tools. Once the asset has been identified, it is important to determine if the 353 
software and firmware versions have known vulnerabilities and how critical those 354 
vulnerabilities are. The collected information is categorized and integrated with other asset and 355 
configuration management tools. 356 

 Routine patching: modifying assets to configure and install firmware, OSs, and applications for 357 
the purpose of addressing bug fixes, providing security updates, and upgrading to later, 358 
supported releases of software. Routine patching is done on regularly scheduled intervals 359 
defined by the organization. 360 

 Emergency patching: performing emergency patching of assets, such as for an extreme severity 361 
vulnerability or a vulnerability being actively exploited in the wild. Systems in this scenario 362 
should be able to deploy patches to assets outside of regularly scheduled intervals. 363 

 Emergency workaround: implementing emergency workarounds for identified assets, such as 364 
temporarily disabling vulnerable functionality. This scenario demonstrates an emergency 365 
procedure in which an organization needs to temporarily mitigate a vulnerability prior to a 366 

mailto:cyberhygiene@nist.gov
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vendor releasing a patch. Systems included in this scenario need to be able to uninstall, 367 
reconfigure, and disable services on assets. 368 

 Isolation of unpatched assets: performing network isolation of assets, like unsupported legacy 369 
assets, end-of-life assets, and assets with high operational uptime requirements, to mitigate 370 
risk for assets that cannot be easily patched or cannot be patched at all. 371 

 Patch management system security: implementing recommended security practices for patch 372 
management systems, which have administrative privileged access over many other systems. 373 
See Section 3 of NIST SP 1800-31B for more information on addressing this scenario. 374 

1.2.2 Logical Architecture 375 

This project required a variety of technology capabilities. The following were included in the lab build:  376 

 IT endpoints: This represents traditional endpoints, which included Apple laptops, Linux 377 
workstations/servers, and Windows workstations/servers, as well as newer types of endpoints, 378 
such as containers and Android and iOS mobile devices. These endpoints were all integrated 379 
either physically or virtually within the network environment. 380 

 Device discovery: This includes systems that actively or passively scan the network 381 
environment and report about newly discovered assets and their observed characteristics. 382 

 Network access management: This includes systems that govern access for endpoints, which 383 
are components that typically enforce access restrictions based on telemetry received from 384 
device discovery and vulnerability management systems within the environment. For example, 385 
enterprise assets that are not up to the required patch levels could be restricted from having 386 
access to resources distributed across the network environment. 387 

 Vulnerability management: This includes systems that continually scan endpoints to identify 388 
known vulnerabilities and associated risks so that they may be proactively mitigated through 389 
appropriate patching and configuration settings. 390 

 Software and configuration management: This includes systems that automate and maintain 391 
configuration changes and consistency across endpoints within the environment, as well as 392 
update currently installed software and firmware versions. Configuration changes may include 393 
updating network information, installing/uninstalling programs and services, and starting and 394 
stopping services. 395 

 Update sources: This includes systems that house and maintain the most recent and trusted 396 
software updates/upgrade files for distribution within the environment. These update sources 397 
were leveraged by the software distribution systems to maintain an updated repository of 398 
available patches. 399 

 Reporting: This includes systems that collect information from device discovery, network 400 
access management, and vulnerability management systems. This collected information can 401 
then be presented via dashboards or reports. 402 
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Figure 1-1 depicts the components that are used in the logical architecture, and the flow of a new or 403 
returning device joining the network. 404 
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Figure 1-1 Logical Architecture Components and Flow 405 
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The following steps take place as a new or returning device joins the network. Each number corresponds 406 
to a flow in Figure 1-1.  407 

Device discovery: 1) The device discovery tool scans the device and collects information such as IP 408 
address, MAC address, installed software/firmware, and OS, then 2) sends the information to a 409 
vulnerability management system. 410 

Vulnerability scanning: 3) The vulnerability management system scans the endpoint for vulnerability 411 
information, including missing patches and outdated software, and 4) receives the scan results. 5) The 412 
vulnerability management system sends the collected vulnerability data to the reporting service for 413 
presentation to administrators. 414 

Quarantine decision and enforcement: 6) The vulnerability management system shares the device 415 
patch level with the network access management system to be used for network access control. 7) The 416 
network access management system applies one of the following two enforcement actions: 7a) If the 417 
network device does not exceed the organizational patch threshold, the device is given network access 418 
and does not need to go through the remainder of the diagram. 7b) If the network device exceeds the 419 
organizational patch threshold, the network access management system performs quarantine actions on 420 
the endpoint and restricts network access. 8) The network access management system shares the 421 
missing patch information with the software and configuration management system. 422 

Patching: 9) The software and configuration management system checks its trusted update source for 423 
patch updates, then 10) receives any new patches and updates its patch repository database. 11) 424 
Missing patches are deployed from the software and configuration management system to the 425 
connected endpoint. 12) The software and configuration management system receives the update that 426 
the patches have been installed successfully. 13) The updates that were applied are sent to a reporting 427 
server for administrator review. 14) The software and configuration management system communicates 428 
that updates were successfully applied to the endpoint. 429 

Vulnerability scanning: 15) The network access management system initiates a rescan of the endpoint 430 
by communicating with the vulnerability management system. 16) The vulnerability management 431 
system rescans the endpoint and 17) collects updated vulnerability data. 18) The vulnerability 432 
management system sends updated endpoint vulnerability data to the reporting server and 19) shares 433 
device patch level information with the network access management server. 434 

Network access granted: 20) The network access management server grants the endpoint network 435 
access. 436 

1.3 Build Architecture Summary 437 

Figure 1-2 depicts the high-level physical architecture of the NCCoE laboratory environment. The 438 
segmented laboratory network backbone models the separation that typically exists between 439 
subnetworks belonging to different parts of an enterprise, such as a backup site, shared services, a data 440 



DRAFT  

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 8 

center hosting widely used applications and services, and a workstation subnet consisting of user 441 
endpoints. While the majority of the nodes in the workstation subnet were virtual, the gray box notes 442 
physical machines.  443 

The subnets were extended from the virtual lab to the physical lab by a Cisco switch. The switch had the 444 
workstation virtual local area network (VLAN) extended to it from VMWare via a trunk port. The lab 445 
subnetworks were connected by a Cisco Firepower Threat Defense (FTD) firewall.  446 
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Figure 1-2 Laboratory Configuration of Example Solution Architecture 447 
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The NCCoE lab provided the following supporting infrastructure for the example implementation: 448 

 VMWare ESX version 7.0, a shared NCCoE resource provided by the NCCoE IT Operations team 449 
to host the patching infrastructure’s virtual machine (VM) workloads and network 450 
infrastructure 451 

 a dedicated VLAN provided for external collaborator remote access to the VMWare lab 452 
environment from NCCoE IT operations 453 

 a Windows 2016 server that provided Active Directory (AD) services, authenticated users and 454 
machines to the lab.nccoe.org domain, and provided Domain Name System (DNS) services 455 

 a Windows 2019 server that provided Dynamic Host Configuration Protocol (DHCP) services to 456 
the endpoint network  457 

 a Windows 2019 server that served as a remote backup site for the endpoint configuration 458 
management system  459 

 a CentOS 7 machine that served as a remote backup site for the Tenable vulnerability 460 
management system  461 

 iDrac interfaces that allowed for remote configuration of Dell R620 server blades  462 

 virtualized endpoints running the following OSs: CentOS, Fedora, macOS, Redhat, Solaris, 463 
Ubuntu, Windows Enterprise, and Windows Server  464 

 a physical Windows 10 laptop and a physical Apple laptop running macOS to represent 465 
employee endpoints 466 

 a Microsoft SQL server hosting the database for Microsoft Endpoint Configuration Manager  467 

 several Dell R620 machines that had Windows Server 2016, VMWare ESXi, and two machines 468 
running CentOS 7 installed to represent physical end nodes. Of the two CentOS 7 machines, 469 
one was chosen to have OpenShift installed to represent a container management platform. 470 
The Docker repository was also run on this same OpenShift machine.  471 

1.4 Implemented Products and Services 472 

The following collaborator-supplied components were integrated with the supporting infrastructure to 473 
yield the example implementation:  474 

 Cisco Firepower Management Center (FMC) version 6.5.0.4 provided centralized management 475 
of the Cisco Firepower Threat Defense firewall. It supplied a web interface for firewall 476 
administrators. 477 

 Cisco Firepower Threat Defense (FTD) version 6.4.0 was the central firewall that connected the 478 
lab’s internal subnets and the external internet. Through communication with Cisco Identity 479 
Services Engine (ISE), the firewall provided network segmentation capabilities. 480 
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 Cisco Identity Services Engine (ISE) version 2.7.0.36 was utilized to perform asset inventory 481 
and discovery. Using attributes that were collected by Cisco ISE, such as current user or patch 482 
level, the firewall enforced custom network access control policies. 483 

 Eclypsium Administration and Analytics Service version 2.2.2 was configured to assess 484 
firmware levels present on a device and report if a vulnerable version of firmware was running 485 
on a device. It could then download firmware updates to affected devices. 486 

 Forescout Platform version 8.2.2 provided asset inventory and discovery. Additionally, 487 
Forescout collected attributes associated with endpoints and, through policy, provided 488 
enforcement actions such as network access control via an integration with pxGrid, or service 489 
removal via custom scripts. 490 

 IBM Code Risk Analyzer (cloud-based service) provided vulnerability scanning and reporting for 491 
source code as part of the DevOps pipeline. Through an integration with GitHub, it scanned 492 
deployed code for vulnerabilities and produced a report of remediation actions. IBM, as part of 493 
the lab effort, provided source code hosted in GitHub to be ingested by the Code Risk Analyzer. 494 

 IBM MaaS360 with Watson (cloud-based service) provided asset inventory, vulnerability 495 
management, and software distribution to laptops and mobile devices. The user authentication 496 
module, part of the Cloud Extender module, was used to integrate IBM MaaS360 with AD. This 497 
allowed users to authenticate to MaaS360 with their domain-joined accounts. 498 

 Lookout Mobile Endpoint Security (cloud-based service) provided vulnerability scanning, 499 
assessment, reporting, and policy enforcement for mobile devices. An integration with IBM 500 
MaaS360 allowed custom attributes from Lookout to be used in MaaS360 policies. 501 

 Microsoft Endpoint Configuration Manager version 2002 provided device configuration and 502 
software distribution capabilities. Endpoint Configuration Manager allowed for software 503 
updates and software changes to be pushed to endpoints. Discovery capabilities were enabled 504 
to determine what endpoints existed on the network and domain. 505 

 Nessus version 8.14.0 provided on-premises vulnerability scanning of the architecture. Nessus 506 
logged into devices over the network, using supplied credentials, and enumerated 507 
vulnerabilities and missing patch information. This information was then presented to the 508 
administrator via the managing Tenable.sc tool. 509 

 Tenable.io (cloud-based service) provided vulnerability scanning and reporting for 510 
containerized applications. Tenable.io was configured to upload a repository from an OpenShift 511 
node and perform assessments. 512 

 Tenable.sc version 5.18.0 provided management of the lab Nessus scanner. Tenable.sc was 513 
configured to utilize the Nessus scanner to provide on-premises vulnerability scanning, asset 514 
inventorying/discovery, and reporting using dashboards. Scan data from Tenable.sc was 515 
ingested by other systems and was exported in the form of reports. 516 

 VMware vRealize Automation SaltStack Config version 8.3.0 provided device configuration 517 
and software distribution capabilities. SaltStack Config allowed for configuration changes to be 518 
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made to devices by updating or removing software as well as updating settings such as network 519 
information.  520 

Table 1-1 lists the collaborator-supplied product versions and system configurations that were utilized in 521 
the implementation, including the number of central processing units (CPUs) and the amount of random 522 
access memory (RAM) and hard disk drive (HDD) space in gigabytes (GB). All products were either 523 
deployed virtually via an Open Virtualization Appliance (OVA) or installed on VMs. In addition to these 524 
products, five cloud-based software as a service (SaaS) offerings were also used for the build: IBM Code 525 
Risk Analyzer, IBM MaaS360 with Watson, Lookout Mobile Endpoint Security, Tenable.io, and a SaaS 526 
version of Eclypsium. 527 

Table 1-1 Product Versions and System Configurations Used 528 

Product Version   OS CPUs RAM HDD  Deployed Via 

Cisco FMC 6.5.0.4 N/A 4 32 GB 250 GB OVA 

Cisco FTD 6.4.0 N/A 4 8 GB 49 GB OVA 

Cisco ISE 2.7.0.36 N/A 2 8 GB 200 GB OVA 

Eclypsium 
Administration and 
Analytics Service (on-
premises) 

2.2.2 CentOS 7 2 8 GB 200 GB Installed application 

Forescout Appliance 8.2.2 N/A 6 14 GB 200 GB OVA 

Forescout Enterprise 
Manager 

8.2.2 N/A 4 12 GB 200 GB OVA 

Microsoft Endpoint 
Configuration 
Manager 

2002 Windows 
Server 2019 

4 8 GB 240 GB Installed application 

Nessus 8.14.0 CentOS 7 2 8 GB 200 GB Installed application 

Tenable.sc 5.18.0 CentOS 7 2 8 GB 80 GB Installed application 

VMware vRealize 
Automation SaltStack 
Config 

8.3.0 CentOS 7 2 12 GB 80 GB Installed application 

 

Sections 2 through 9 of this volume contain more information on each of these products and services, 529 
grouped by vendor. Note that the vendor sections are in order by the approximate sequence followed in 530 
this build for installing and configuring the products and services. 531 
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1.5 Supporting Infrastructure and Shared Services  532 

In the lab environment, common services were deployed to support the example solution. These 533 
services included AD Domain Services, Windows DNS, Windows DHCP, and a physical Cisco switch. 534 

1.5.1 AD Domain Services 535 

The AD Domain Services deployment provided the directory services that many of the products relied on 536 
for their installations. A directory stores information about objects such as users and computers. This 537 
information is made accessible on the network and can be used for many purposes; in this reference 538 
implementation it was mainly used for authentication and access control. The AD Domain Services 539 
instance in our reference implementation was deployed on a single VM running Windows Server 2016. 540 
This server was accessible to all subnets on the lab. More information about AD Domain Services and 541 
the capabilities it provides can be found here. 542 

1.5.2 Windows DNS 543 

The Windows DNS deployment provided DNS capabilities to the reference implementation. DNS is an 544 
open protocol that is primarily used to translate domain names to IP addresses. The Windows DNS 545 
instance in our reference implementation was deployed on the same Windows Server 2016 VM running 546 
AD Domain Services. This server was accessible to all subnets of the lab, giving all computers access to 547 
DNS. More information on how to deploy Windows DNS can be found here.  548 

1.5.3 Windows DHCP 549 

The Windows DHCP deployment provided DHCP capabilities to the endpoints located in the Workstation 550 
network segment. DHCP is a network management protocol that is primarily used to provide network 551 
parameters, such as an IP address and default gateway, to endpoints. The Windows DHCP instance in 552 
our reference implementation was deployed on a Windows 2019 server VM. This server was accessible 553 
to the endpoint subnet of the patching architecture, giving all computers connected to the endpoint 554 
subnet access to DHCP. More information on how to deploy Windows DHCP can be found here.  555 

1.5.4 Cisco Switch  556 

The architecture utilized a Cisco Catalyst 9300 switch to extend the VMWare VLANs to the physical 557 
devices within the lab environment, including laptops and server blades. A trunk port configured on the 558 
switch allowed for the VLANs configured in VMWare to be recognized by the switch. The remaining 559 
switch ports were configured to access one VLAN at a time, depending on the connected device. More 560 
information on the Cisco Catalyst 9300 switch can be found here. 561 

https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/ad-ds-deployment
https://docs.microsoft.com/en-us/iis/web-hosting/installing-infrastructure-components/dns-server
https://docs.microsoft.com/en-us/iis/web-hosting/installing-infrastructure-components/dhcp-server
https://www.cisco.com/c/en/us/products/switches/catalyst-9300-series-switches/index.html
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1.6 Typographic Conventions 562 

The following table presents typographic conventions used in this volume. 563 

Typeface/Symbol Meaning Example 

Italics file names and path names; references 
to documents that are not hyperlinks; 
new terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, command 
buttons, and fields 

Choose File > Edit. 

Monospace command-line input, onscreen 
computer output, sample code 
examples, and status codes 

mkdir 

Monospace Bold command-line user input contrasted 
with computer output 

service sshd start 

blue text link to other parts of the document, a 
web URL, or an email address 

All publications from NIST’s NCCoE are 
available at 
https://www.nccoe.nist.gov. 

2 Tenable 564 

In the first phase of our build we used Tenable products to provide on-premises vulnerability scanning, 565 
asset inventorying/discovery, and reporting using dashboards. Tenable was leveraged to meet the 566 
device discovery, software/firmware discovery, and software/firmware assessment scenarios. Two 567 
Tenable products, Nessus Scanner and Tenable.sc, were used in the lab environment as part of this 568 
project. Also, Tenable.io, a SaaS-based cloud offering from Tenable, provided vulnerability scanning of 569 
container images to the lab environment during the second phase of the build. This section shows how 570 
each product was installed, configured, and used in the lab. 571 

2.1 Nessus Installation and Configuration 572 

Nessus is a vulnerability scanning engine that is used to scan endpoints, such as Linux, Windows, and 573 
macOS, VMWare ESXi, and network switches for vulnerability data. We utilized Nessus to scan endpoints 574 
for vulnerability information and feed this information to Tenable.sc for reporting. Nessus can be 575 
deployed as a standalone server or managed by Tenable.sc. In our lab build, Nessus was managed by 576 
Tenable.sc. Since Nessus needed to be linked to Tenable.sc during Tenable.sc’s setup, Nessus was 577 
installed and set up first. 578 

Nessus was installed on a CentOS 7 VM, with hardware details included in Section 1.4. More information 579 
on Nessus requirements can be found here. Installing Nessus 8.14.0 consisted of the following steps 580 
(with more detailed information available from the hyperlinked resources): 581 

https://www.nccoe.nist.gov/
https://docs.tenable.com/generalrequirements/Content/NessusScanners.htm
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1. Download the Nessus executable from the Tenable download page. Note that you will need a 582 
Tenable account to download installation software. 583 

2. Install Nessus by running the rpm installation command, then start the Nessus service. 584 

3. Configure Nessus to be managed by Tenable.sc after installing Tenable.sc. 585 

2.2 Tenable.sc 586 

Tenable.sc is a vulnerability management product that collects information from Nessus and reports 587 
that information to administrators using dashboards and reports. Our build utilized Tenable.sc to 588 
manage a Nessus scanner and report on collected vulnerability data for scanned endpoints. This section 589 
assumes that the Nessus scanner from Section 2.1 was installed before installing Tenable.sc. 590 

2.2.1 Tenable.sc Installation and Configuration 591 

Tenable.sc was installed on a CentOS 7 VM, with hardware details included in Section 1.4. The Tenable 592 
site has more information on Tenable.sc requirements. Installing and configuring Tenable.sc 5.18.0 593 
consisted of the following steps: 594 

1. Download Tenable.sc from the Tenable site (note: a Tenable account is needed). 595 

2. Install Tenable.sc using the appropriate rpm command and start the Tenable.sc service. 596 

3. License Tenable.sc. 597 

4. Configure Tenable.sc: 598 

a. Add a Nessus scanner. Tenable.sc relies on vulnerability data collected from Nessus 599 
scanners to provide information on endpoint vulnerability levels. 600 

b. Add a repository. A repository holds vulnerability data that is collected from Nessus 601 
scanners for organizational endpoints. Repositories provide data storage that can be 602 
restricted to appropriate users. 603 

c. Add an organization. Organizations provide logical groupings for Tenable resources. 604 
Administrators can restrict access to organizations to ensure that only authorized 605 
personnel can view data. 606 

d. Add a user with Security Manager permissions. The Security Manager role needs to be 607 
added before a scan can be run. By default, when installing Tenable.sc a local system 608 
administrator account is created, and that account is responsible solely for setting up 609 
organizations and repositories. A Security Manager account has the correct permissions 610 
to view scan data and initiate scans. More information on other Tenable.sc security 611 
roles can be found here. 612 

https://www.tenable.com/downloads/nessus
https://docs.tenable.com/nessus/Content/InstallNessusLinux.htm
https://docs.tenable.com/nessus/Content/ManagedbyTenablesc.htm
https://docs.tenable.com/generalrequirements/Content/SC.htm
https://www.tenable.com/downloads/tenable-sc
https://docs.tenable.com/tenablesc/Content/Install.htm
https://docs.tenable.com/tenablesc/Content/AddLicense.htm
https://docs.tenable.com/tenablesc/Content/AddNessusScanner.htm
https://docs.tenable.com/tenablesc/Content/AddRepository.htm
https://docs.tenable.com/tenablesc/Content/Repositories.htm
https://docs.tenable.com/tenablesc/Content/AddOrganization.htm
https://docs.tenable.com/tenablesc/5_7/Content/Organizations.htm
https://docs.tenable.com/tenablesc/Content/AddUserTNS.htm
https://docs.tenable.com/tenablesc/Content/UserRoles.htm
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e. Add endpoint credentials. Tenable.sc requires credentials to be loaded in order to 613 
obtain the correct access levels for vulnerability scan data to be collected. Missing 614 
results may be observed by scanning an endpoint without credentials. More information 615 
on credentials can be found here. 616 

2.2.2 Tenable.sc Scan Setup and Launch 617 

After installing Nessus and Tenable.sc, the next step was to set up a scan policy. Scan policies allow you 618 
to deploy template-based or custom scan options for assessing endpoints, including Windows, VMWare 619 
ESXi, macOS, and Linux-based OSs, as well as networking equipment. Scan policies contain plugin 620 
settings and other advanced options that are used during active scans. For our build, Tenable 621 
recommended the Basic Network scan template with credentials to assess vulnerabilities, because it 622 
performs a full system scan that is suitable for a variety of hosts regardless of OS. Our build performed a 623 
credentialed scan to help Tenable enumerate missing patch information; other options were non-624 
credentialed scans and agent-based scanning. More information on other types of Tenable.sc scan 625 
templates and when they may be used can be found here. 626 

We used the options below when creating our scan policy. See 627 
https://docs.tenable.com/tenablesc/Content/AddScanPolicy.htm for more information on adding scan 628 
policies. 629 

 Template: Basic Network scan 630 

 Name: Lab Basic Scan 631 

 Advanced: Default 632 

 Discovery: Port scan (common ports) 633 

 Assessment: Default 634 

 The Report and Authentication tabs stayed at their default values, as credentials will be added 635 
in the active scan section. 636 

https://docs.tenable.com/tenablesc/Content/AddCredentials.htm
https://docs.tenable.com/nessus/Content/NessusCredentialedChecks.htm
https://docs.tenable.com/nessusagent/Content/TraditionalScanCredentialed.htm
https://docs.tenable.com/nessusagent/Content/TraditionalScansUncredentialed.htm
https://docs.tenable.com/nessusagent/Content/TraditionalScansUncredentialed.htm
https://docs.tenable.com/nessusagent/Content/AgentScans.htm
https://docs.tenable.com/nessus/Content/ScanAndPolicyTemplates.htm
https://docs.tenable.com/tenablesc/Content/AddScanPolicy.htm
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 637 

The next step after creating a scan policy was to add that policy to an active scan. Active scans utilize the 638 
scan policy as well as user-supplied options to launch scans against endpoints. More information on 639 
creating an active scan is available here. We used the following options when creating our active scan: 640 

 Name: Credentialed Scan 641 

 Policy: Lab Basic Scan 642 

 Schedule 643 

• Frequency: Weekly 644 

https://docs.tenable.com/tenablesc/Content/AddActiveScan.htm
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• Time: 03:00 645 

• Timezone: America/New_York 646 

• Repeat Every: Saturday 647 

 Import Repository: Patching Lab Endpoints 648 

 Target Type: IP/DNS Name 649 

 IPs / DNS Names: 10.151.40.0/24 650 

 Credentials: Add all credentials created in step 651 

After creating the active scan, click Submit. The example above would be scheduled to run automatically 652 
on Saturdays at 3 a.m.  653 

Information on manually launching scans (ad-hoc) is available here. 654 

2.2.3 Scan Results 655 

By default, when viewing scan results, the user is taken to the vulnerability summary page. This page 656 
contains information on observed vulnerabilities, and the results are sorted by observed Common 657 
Vulnerability Scoring System (CVSS) severity and the number of observed affected machines. Figure 2-1 658 
shows vulnerability summary information from our build. The vulnerabilities can be viewed by package 659 
name and OS. The scan results can also be sorted by different types, such as IP address. This can be 660 
useful in allowing administrators to quickly see which vulnerabilities were discovered per asset. 661 

Figure 2-1 Vulnerability Summary Information 662 

 

Sorting by IP Summary and then clicking the IP address of a machine allows for additional filters to be 663 
applied to scan results. Another filter that could be utilized for software discovery is clicking on List 664 

https://docs.tenable.com/tenablesc/Content/StartPauseScan.htm
https://docs.tenable.com/tenablesc/Content/ViewScanResults.htm
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Software while searching for a specific IP address. This filter shows all of the software that is currently 665 
running and discovered on a machine, as the example in Figure 2-2 illustrates. 666 

Figure 2-2 Applying Filters to Scan Results 667 

 

2.2.4 Tenable.sc Dashboards 668 

Tenable.sc provides graphical representations of information that is obtained via vulnerability scans. 669 
Dashboards can be customized with different widgets to allow organizations to quickly observe 670 
vulnerability information. We utilized Tenable.sc’s reporting dashboards to help prioritize which assets 671 
to remediate first and meet the firmware and software assessment scenarios. Directions for adding a 672 
dashboard are available here. We used two dashboards: the Vulnerability Prioritization Rating (VPR) 673 
Summary dashboard and the Worst of the Worst - Fix These First! dashboard.  674 

The VPR Summary dashboard was utilized to help administrators prioritize which systems in the lab 675 
should be remediated first. VPR combines threat intelligence, machine learning, research insights, and 676 
vulnerability metrics to dynamically measure risk. A higher number on the VPR dashboard indicated 677 
which systems should be immediately addressed. Figure 2-3 shows the VPR dashboard from the build. 678 

https://docs.tenable.com/tenablesc/Content/AddTemplateDashboard.htm
https://www.tenable.com/sc-dashboards/vulnerability-priority-rating-vpr-summary
https://www.tenable.com/sc-dashboards/vulnerability-priority-rating-vpr-summary
https://www.tenable.com/sc-dashboards/worst-of-the-worst-fix-these-first
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Figure 2-3 Tenable VPR Summary Dashboard 679 

 

  680 
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The Worst of the Worst – Fix These First! dashboard was used to help system administrators prioritize remediation efforts. The dashboard allows system administrators to gain insight into the top 10 vulnerabilities affecting systems and the 681 
top 10 remediation actions that should be taken. The dashboard also shows a list of the most vulnerable assets. Figure 2-4 shows an example of the Worst of the Worst dashboard, with the top 10 most vulnerable assets and exploitable 682 
vulnerabilities. 683 

Figure 2-4 Tenable Worst of the Worst – Fix These First! Dashboard Example 684 
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2.2.5 Tenable.sc Reporting 685 

Tenable.sc also provides the ability to export vulnerability data to reports. The difference between 686 
dashboards and reports is that reports are meant to be exported and used outside of the Tenable.sc 687 
web console. With reports, data can be exported as a comma-separated values (CSV) file for ingestion by 688 
other systems, or as PDF files to be reviewed by management for compliance or vulnerability 689 
management purposes. Our build utilized reports to demonstrate how software and firmware 690 
assessment data could be shared with security managers to help to prioritize remediation efforts and 691 
actions.  692 

Tenable reports can be scheduled to run after a scan or be scheduled to run during certain times of the 693 
week. To launch a report on demand (manually start), follow the instructions here. Once the report is 694 
ready and the results are clicked on, the report will automatically download in the browser. Figure 2-5 695 
shows a portion of the Critical and Exploitable Vulnerabilities report from our build that detailed the top 696 
20 critically affected systems. 697 

Figure 2-5 Exploitable Vulnerability Summary 698 

 
More information about reports, other report templates, and custom report creation can be found here. 699 

https://docs.tenable.com/tenablesc/Content/Reports/LaunchReportOnDemand.htm
https://docs.tenable.com/tenablesc/Content/Reports.htm
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2.2.6 Tenable.sc Integrations 700 

Tenable.sc provides for integrations with third-party software via its representational state transfer 701 
(REST) application programming interface (API). The vulnerability data that is collected by Tenable can 702 
be shared with other systems such as configuration management or access control systems to 703 
automatically apply remediation actions. More information on the Tenable API can be found here. The 704 
following two example integrations with Tenable.sc were implemented in the lab: 705 

 Cisco ISE: This integration allowed Cisco ISE to leverage vulnerability data collected by 706 
Tenable.sc. Cisco ISE would initiate a scan when new devices joined the network. The CVSS 707 
scores observed by Tenable were then sent to Cisco ISE, and devices that were over the score 708 
threshold were automatically quarantined from internal access. See Section 5.2.5 for additional 709 
information on the Cisco ISE integration. 710 

 Forescout Platform: This integration allowed Forescout to leverage vulnerability data collected 711 
by Tenable.sc in order to quarantine endpoints. Forescout policy was created that specified 712 
that devices with CVSS scores over a certain threshold would be quarantined from the network. 713 
Forescout leveraged an integration with Cisco ISE via pxGrid to perform network enforcement 714 
actions. Section 7.2.8 contains additional explanation of the integration. 715 

2.2.7 Tenable.sc Ongoing Maintenance 716 

All Tenable components should be kept up to date. You must have an active Tenable account to 717 
download updated software. Software for all Tenable components, including Nessus and Tenable.sc, can 718 
be downloaded from https://www.tenable.com/downloads. Follow the directions on these pages to 719 
upgrade Tenable.sc and upgrade Nessus. 720 

Note that while Nessus plugins are updated automatically without user intervention, there is an option 721 
to manually update them. Keeping plugins up-to-date allows Tenable to identify all of the latest 722 
vulnerabilities. 723 

2.3 Tenable.io 724 

Tenable.io is a cloud-based platform that organizations can use to perform vulnerability scanning and 725 
reporting for their on-premises and cloud-based endpoints. In our build we used Tenable.io to provide 726 
container security for a CentOS 7 VM running Red Hat’s OpenShift container orchestration software. 727 

The platform system requirements for endpoints to run the Container Security (CS) Scanner software 728 
can be found here. 729 

https://docs.tenable.com/tenablesc/api/index.htm
https://www.tenable.com/downloads
https://docs.tenable.com/tenablesc/Content/Upgrade.htm
https://docs.tenable.com/nessus/Content/Upgrade.htm
https://docs.tenable.com/nessus/Content/InstallPluginsManually.htm
https://docs.tenable.com/tenableio/Content/ContainerSecurity/CSScannerSystemRequirements.htm
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2.3.1 Tenable.io Configuration 730 

Tenable.io is operated using an online portal. It provides a Get Started page that walks administrators 731 
through initial setup steps, such as configuring scans and linking a Nessus scanner. These steps were not 732 
needed to perform the capabilities implemented in the lab demonstration. 733 

Administrators will need to speak with their Tenable representative to ensure access to the CS 734 
dashboard before continuing. Without access to this dashboard, they will not be able to add a connector 735 
to upload registry images or review the results from completed scans. 736 

2.3.2 Performing Container Scans 737 

Container registry users need to perform the following high-level steps in order to begin running 738 
container scans. For more information on getting started running the CS Scanner, please consult the 739 
following page. 740 

1. Download and install the CS Scanner Docker image from the Tenable.io Portal. During 741 
download, you will be presented with a username and password. Please make note of them, as 742 
they will be needed during the installation. 743 

2. Generate API keys. API keys will be needed in order for the CS Scanner tool to securely interact 744 
with and upload data to Tenable.io. 745 

3. Set environmental variables. The following environmental variables were created and exported: 746 

a. TENABLE_ACCESS_KEY – This was created in step 2. It is used to allow the container 747 
security tool to connect with Tenable.io. 748 

b. TENABLE_SECRET_KEY – This was generated during the API key creation process. It is 749 
used to allow the tool to connect with Tenable.io. 750 

c. IMPORT_REPO_NAME – This is the name of the repository that you would like to export. 751 
Note that this name is what will appear in the container security dashboard of 752 
Tenable.io. 753 

d. REGISTRY_URI – This is the URI of the registry that you would like to import. 754 

e. REGISTRY_USERNAME – This is a machine account on the system that contains the 755 
correct privileges to read from the registry. 756 

f. REGISTRY_PASSWORD – This is the password for the account that will read from the 757 
registry. 758 

https://docs.tenable.com/tenableio/Content/ContainerSecurity/CSScanner.htm
https://docs.tenable.com/tenableio/Content/ContainerSecurity/DownloadCSScanner.htm
https://docs.tenable.com/tenableio/Content/Settings/GenerateAPIKey.htm
https://docs.tenable.com/tenableio/Content/ContainerSecurity/ConfigureRunCSScanner.htm#Environm
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g. IMPORT_INTERVAL_MINUTES – This is how often you want the Tenable.io scanner to 759 
import and scan images. The lab implementation configured the scan to run every 1440 760 
minutes. The scan by default will run in a manual, ad-hoc manner. 761 

4. Configure and run the Tenable.io CS Scanner. This involves running a docker command with the 762 
environmental variables that were previously set, then importing the registry. The registry is 763 
automatically imported after a one-line command is run, without further interaction from the 764 
user. 765 

2.3.3 Container Scan Results 766 

After performing the scan from Section 2.3.2, the container image data will populate inside of 767 

Tenable.io. To view scan results, a user logs in to Tenable.io and navigates to Menu  > Container 768 
Security > Images tab. This tab presents the user with the repository and image name, the associated 769 
number of vulnerabilities or malware, risk score, and date of upload, as Figure 2-6 depicts. 770 

Figure 2-6 Example of Container Image Data 771 

 

The scan results can be further drilled into by clicking on the repository that you would like additional 772 
information on. Under this new view, administrators can see the actual vulnerabilities and CVE scores 773 
associated with containers as well as malware, package inventory, and identified containers. Figure 2-7 774 
shows a view of the vulnerabilities associated with the lab instance’s uploaded registry. 775 

https://docs.tenable.com/tenableio/Content/ContainerSecurity/CSScanner_RegistryImport.htm
https://docs.tenable.com/tenableio/Content/ContainerSecurity/ViewScanResults.htm
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Figure 2-7 Example of Container Vulnerability Information 776 

 

2.3.4 Tenable.io Maintenance 777 

Tenable.io is a SaaS offering with updates automatically provided and installed by Tenable, who 778 
maintains the platform. 779 

3 Eclypsium 780 

Eclypsium provides monitoring and alerting for software and hardware components for an enterprise, 781 
along with advanced capabilities such as firmware integrity checking and updating. This section provides 782 
information on Eclypsium installation and usage. In this build, we utilized Eclypsium to provide agent-783 
based identification of hardware and firmware for our laptop, desktop, and server endpoints while also 784 
monitoring the firmware for vulnerable or end-of-life versions. We utilized both the on-premises and 785 
cloud-hosted versions of Eclypsium. Both solutions offered the same experience, with the cloud product 786 
receiving updates faster and automatically. 787 

3.1 Eclypsium Installation and Configuration  788 

Two machines were required for the on-premises installation: one for the main console and database, 789 
and the other for data processing. The console machine should be accessible by a fully qualified domain 790 
name (FQDN) DNS entry. The steps below are a basic overview of the installation. You will receive an 791 
installation guide from your Eclypsium representative with more detailed instructions. 792 

1. Provision two machines that meet or exceed the hardware requirements in the installation 793 
guide. 794 

2. Download the Eclypsium installation script and your license to the same folder. 795 
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3. Perform the installation. 796 

4. Install Transport Layer Security (TLS) certificates by copying the private key, public TLS 797 
certificate, and the full certificate chain to the /opt/eclypisum/certs directory. The TLS certificate 798 
was generated and signed by our internal Lab certificate authority (CA). 799 

The SaaS version of Eclypsium comes fully provisioned and installed. 800 

3.2 Eclypsium Scanning 801 

Eclypsium scanning is agent-based, so the binary must be downloaded and installed on the target 802 
machine and registered to the Eclypsium before scanning can begin. To download the Eclypsium agent 803 
go to Deployment > Download to find the binary for your chosen computing platform. Eclypsium 804 
supports installer binaries for Windows, Windows Server, macOS, and Debian or RPM Package Manager 805 
(RPM) based linux systems. You must also use an access token (a random character string) for the 806 
registration. This token is used both to ensure that only desired endpoints are registered, and optionally 807 
to register devices in groups depending on the token used. Device tokens can be managed by navigating 808 
to Administration > Tokens. 809 

After downloading the binary onto an endpoint and generating a host registration token, the following 810 
commands were run, as an example on a CentOS 7 machine, to install the application and register the 811 
host with the console: 812 

yum install eclypsium*.rpm 813 

EclypsiumApp -s2 <DOMAIN> <REGISTRATION_TOKEN> 814 

To launch an ad-hoc or manual scan, navigate to Devices > Device List and click the Scan button.  815 

To schedule a recurring scan, perform the following steps: 816 

1. Navigate to Settings > Scan. 817 

2. Click Schedule under the Scan Schedule field. 818 

3. Fill out the Custom Scan Schedule box with the information shown below. 819 
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 820 

4. Click Save. 821 

The above options create a scan that will run weekly on Saturdays at 8 p.m. ET. The scan schedule can 822 
be changed so that scans run more than once per week by selecting additional days, or be repeated at a 823 
different weekly interval by changing the Repeat Every field.  824 

3.3 Eclypsium Reporting 825 

Eclypsium’s main dashboard (Figure 3-1) provided firmware assessment capabilities to the build. The 826 
main dashboard provided a quick view into monitored devices, devices at risk, and the integrity of 827 
installed firmware. The Devices pane displayed information on the devices that were actively being 828 
monitored by the Eclypsium agent and presented that information grouped by device type (Clients, 829 
Servers, Network). The Risk pane displayed information regarding systems that were affected by 830 
vulnerable firmware versions with high CVSS scores. The Risk pane also showed all vulnerable devices 831 
and devices that were running outdated firmware. The Integrity pane showed devices with integrity 832 
failures and baseline deviations. Eclypsium keeps a running database of good firmware hashes to 833 
compare to an installed firmware hash to check for malicious or potentially compromised firmware 834 
versions. 835 
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Figure 3-1 Eclypsium Main Dashboard 836 

 

Figure 3-2 provides an example of details found on a scanned device. The device registration steps were 837 
performed, and a scan was conducted automatically. Although there were vulnerabilities found in the 838 
chipset firmware, Eclypsium determined that no updates were available. Additionally, Eclypsium 839 
provided vulnerability and integrity information for device components such as the CPU, Basic 840 
Input/Output System (BIOS), and Peripheral Component Interconnect (PCI) devices; this was outside the 841 
scope of this project. 842 
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Figure 3-2 Eclypsium Dashboard Device Details 843 

 

3.4 Updating Firmware 844 

There is an update script from Eclypsium for automatically finding firmware updates for endpoints. The 845 
script downloads the new firmware, and then the administrator performs the update manually with the 846 
downloaded file. After obtaining the script (currently a python file) from Eclypsium, follow these steps: 847 

1. Ensure the endpoint you want to update the firmware on has the required python dependencies 848 
installed so it will be able to execute the script. 849 

2. Put the script on the machine and run it. It will automatically find and download the latest 850 
firmware update file. 851 

3. Run the downloaded file to update the firmware. 852 
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Figure 3-3 and Figure 3-4 show the characteristics of a System Management BIOS (SMBIOS) before and 853 
after running the Eclypsium firmware update script. Note that the SMBIOS Version has changed from 854 
1.11.4 to 1.22.3 after running the update script and manually installing the downloaded firmware 855 
binary. 856 

Figure 3-3 SMBIOS Before Eclypsium Firmware Update Script 857 

 

Figure 3-4 SMBIOS After Eclypsium Firmware Update Script 858 

 

3.5 Updating Eclypsium 859 

The Eclypsium on-premises upgrade process required downloading a script and running it in the same 860 
folder Eclypsium was installed in. Our experience with updating Eclypsium was a successful one-step 861 
process. After running the script and restarting the Eclypsium service, the dashboard was updated. 862 
Eclypsium provides materials to customers on how to update their on-premises installations.  863 

The cloud-hosted version of Eclypsium updates automatically, with no user interaction required. The on-864 
premises version of Eclypsium is not updated automatically because it is tied closely to environment 865 
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policies. Eclypsium users will receive a notification on the main console screen when updates are 866 
available. Managed endpoints can be configured to automatically update the installed endpoint driver 867 
or update manually if needed. 868 

4 VMware 869 

In our build we used VMware vRealize Automation SaltStack Config 8.3.0 to provide configuration 870 
management, vulnerability management, and patch deployment. SaltStack Config was used to manage 871 
Windows workstations and servers, a macOS laptop, and Linux/Unix based VMs and servers. A full list of 872 
OSes that SaltStack Config can manage can be found here.  873 

VMware vRealize Automation SaltStack Config is deployed with a “Salt master” server that manages 874 
endpoints via an installed agent referred to as the “Salt minion.” In the build, the following SaltStack 875 
Config server components were deployed on a single VM running CentOS 7: 876 

 Salt master: The Salt master service provided the main connection between SaltStack Config 877 
and the targeted endpoints running the minion agent. The Salt master plugin also 878 
communicated with the backend PostgreSQL database to access stored jobs and job 879 
configuration files. 880 

 Returner as a Service (RaaS): RaaS provided the communication between the SaltStack Config 881 
web user interface and connected Salt master nodes. 882 

 PostgreSQL database: RaaS used a PostgreSQL database to store minion data, the output from 883 
job returns, event data, files, local user accounts, and settings for the user interface. 884 

 Redis database: RaaS used a Redis database for temporary storage for items such as cached 885 
data. It also used this database to hold queued work for deployment. 886 

4.1 VMware vRealize Automation SaltStack Config Installation and 887 

Configuration 888 

VMware vRealize Automation SaltStack Config and its components listed above were installed via the 889 
SaltStack installer script on a CentOS 7 VM, with hardware details included in Section 1.4. SaltStack 890 
Config has the following software dependencies: 891 

 OpenSSL 892 

 Extra Packages for Enterprise Linux (EPEL) 893 

 Python cryptography 894 

 Python OpenSSL library 895 

More information on SaltStack Config requirements can be found here.896 

https://docs.saltproject.io/en/latest/topics/installation/index.html#platform-specific-installation-instructions
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.6/install-configure-saltstack-config/GUID-0975509F-0117-4553-934D-F942473A2C94.html
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The SaltStack Config installation process consists of the following steps: 897 

1. Obtain the SaltStack Config installer zip file from your SaltStack representative. 898 

2. Unzip the zip file on the desired installation node. 899 

3. Run the setup_single_node.sh script. 900 

4. Allow port 443 access for reaching the SaltStack Admin Web graphical user interface (GUI). 901 

5. Allow port 4505 and 4506 access for communication between the Salt master and minion 902 
agents. 903 

6. Install the license key. 904 

More information on installing SaltStack Config can be found here. 905 

4.2 Salt Minion Agent 906 

The Salt minion agent is how SaltStack Config communicates with endpoints to perform configuration. 907 
The minion agent needs to be installed on any endpoints that will be managed by SaltStack Config. The 908 
minion agent is available for various OSs and can be found here along with OS-specific installation 909 
instructions. 910 

The minion agent can be installed and configured with the following steps: 911 

1. Download and install the minion agent. 912 

2. Edit the minion agent with the IP address of the Salt master server. Note that by default, the 913 
minion will use the DNS name of ‘salt’ when trying to connect to the Salt master server. On 914 
Linux-based systems the configuration file located under /etc/salt/minion can be edited to use 915 
custom IP addresses or hostnames instead. On Windows-based systems, this information can be 916 
edited using the minion configuration wizard. 917 

3. Start the minion agent. 918 

4. Accept the minion key. 919 

The Salt minion agent uses a public/private key pairing for communicating with the SaltStack Config 920 
server. The key generation process takes place automatically on the client system, and the minion public 921 
key is automatically sent to the Salt master server. The public key of the minion agent will need to be 922 
accepted on the Salt master server so that secure communication can take place. Steps for accepting a 923 
new minion key can be found here. Note that jobs will not be able to be issued to endpoints unless the 924 
minion key is accepted in the SaltStack Config console. 925 

https://help.saltstack.com/hc/en-us/articles/360040436552-Updating-License-Key-for-SaltStack-Enterprise
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.6/install-configure-saltstack-config/GUID-DBE6D84B-0D4B-4747-8291-B0D80851CE62.html
https://repo.saltproject.io/
https://repo.saltproject.io/
https://docs.saltproject.io/en/latest/ref/configuration/index.html#minion-configuration
https://docs.saltproject.io/en/latest/ref/configuration/index.html#running-salt
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-30D58032-C6A3-4817-96FC-C640ACC8C7A1.html#accepting-a-new-minion-key-1
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4.3 SaltStack Config Jobs 926 

SaltStack Config uses jobs to run remote execution tasks on endpoints. The build utilized these jobs to 927 
provide configuration management capabilities. Jobs were created, scheduled, and executed via the 928 
SaltStack Config web console. 929 

For brevity, and because jobs are highly customizable, this guide includes one example of creating and 930 
running a job. The example job demonstrates removing 7zip version 19 from a Windows endpoint in an 931 
emergency workaround scenario, where an administrator chooses to remove a vulnerable product that 932 
cannot be patched. The following are the steps used in the build to set up and execute this job: 933 

1. Click on Config > File Server. 934 

2. Click on base from the saltenv dropdown menu. Base corresponds to one of the default file 935 
directories that are created to hold configuration files. 936 

3. Type windows/7zip.sls for the path name. 937 

4. In the field name below, add the information in the screenshot, then click SAVE. 938 

 939 
5. Next, click Config > Jobs, then click Create Job. Edit the fields listed in Table 4-1 so they have the 940 

specified values. 941 

Table 4-1 Specified Values for Creating "Uninstall 7zip" Job Using SaltStack Config 942 

Field Value Explanation 

Name Uninstall 7zip This is the name of the job. 

Command Salt The salt command allows for all salt functions to be loaded and 
available for choosing. 

https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/services/use-manage-saltstack-config/GUID-96A02EE1-CD8D-4641-8048-A1E25DBAC4D5.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/services/use-manage-saltstack-config/GUID-96A02EE1-CD8D-4641-8048-A1E25DBAC4D5.html
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Field Value Explanation 

Targets Windows This field allows for different groups of machines to have 
configurations applied to them. The default way that SaltStack 
groups machines is by OS; however, other target groups can be 
created based on device attributes. 

Function state.apply The state.apply function allows for custom state files or .sls 
configuration files to be applied to an endpoint. 

Environments Base Base corresponds to one of the default file directories that are 
created to hold configuration files. 

States windows.7zip The states field corresponds to the file with the configurations that 
are to be pushed down to the endpoint. In this example, this 
corresponds to the uninstallation of 7zip configuration file. 

   
6. Click on Minions, then select the Windows Target Group. 943 

7. Click Run Job. Under the Job dropdown menu, select Uninstall 7zip. 944 

8. Select Run Now. 945 

4.4 SaltStack SecOps 946 

SaltStack SecOps, an add-on component for vRealize Automation SaltStack Config, was utilized to 947 
provide vulnerability and patch management capabilities. SaltStack SecOps can be configured to run 948 
scheduled assessments of endpoint vulnerabilities with the following steps: 949 

1. Click on Protect > Policies under the SaltStack Config Web GUI. 950 

2. Click Create Policy. 951 

3. Type in Endpoint Scan. 952 

4. Under Targets, select All Minions. This performs a scan of all connected network endpoints 953 
regardless of OS. A scan targeting a specific OS or other defined target group could be 954 
performed instead by selecting a different value.  955 

5. Under Type, choose Repeat Date & Time, and fill out the other options as shown. 956 
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 957 

6. Make sure that Run assessment on save is checked. 958 

7. Click Save. The above scan will automatically run and be scheduled to run weekly on Saturdays 959 
at 9 p.m. without further user interaction. 960 

After running the scan, the Vulnerability Summary and Top Advisories dashboard begins to populate, as 961 
captured in Figure 4-1. The image shows that the SaltStack SecOps engine has started collecting 962 
vulnerability information and categorizing it by severity level. The Top Advisories dashboard shows 963 
vulnerabilities detected in the scan that have the highest CVSS score. In the scan, the top advisories all 964 
have scores of 9.8.  965 
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Figure 4-1 SaltStack SecOps Vulnerability Summary and Top Advisories Dashboard 966 
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SaltStack SecOps can also be used to remediate endpoints. To do so, follow these steps: 967 

1. Click the “Endpoint Scan” policy that was created previously. 968 

2. From the resulting list, either single remediations can be selected, or you can choose to select all 969 
remediations. 970 

3. When the desired patches are selected, click Remediate. 971 

4.5 vRealize Automation SaltStack Config Maintenance 972 

All SaltStack Config components should be kept up to date. You are required to have an active VMWare 973 
account to download updated software. Software for all SaltStack Config components can be 974 
downloaded from here. To upgrade SaltStack Config, follow the directions in Section 10 (Upgrade from a 975 
previous version) of Installing and Configuring SaltStack Config. 976 

SaltStack vulnerability data is kept up to date automatically without user interaction. To perform a 977 
manual check for updates, perform the following steps: 978 

1. Log in to the SaltStack web console. 979 

2. Navigate to Administration > SecOps. 980 

3. Click CHECK FOR UPDATES under the Vulnerability Content section. 981 

https://my.vmware.com/en/web/vmware/downloads/details?downloadGroup=VRA-SSC-640&productId=1059&rPId=55611
https://docs.vmware.com/en/vRealize-Automation/8.4/install-configure-saltstack-config-guide.pdf
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 982 

5 Cisco 983 

In this implementation, we used the Cisco Firepower Threat Defense (FTD) firewall to provide network 984 
access management capabilities and Cisco Identity Services Engine (ISE) to provide device discovery 985 
capabilities. The Cisco Firepower Management Center (FMC) product was utilized to manage Cisco FTD. 986 
All Cisco products in the build were virtual appliances that were deployed in VMWare ESX via Open 987 
Virtualization Formats (OVFs) downloaded from the Cisco website. 988 

5.1 Cisco Firepower Threat Defense and Firepower Management Center 989 

Cisco FTD is a next-generation virtual firewall that was used to provide networking to the patching 990 
architecture. The build utilized Cisco FTD 6.4.0 to enforce network access control using firewall rules. 991 
Cisco FTD was deployed and managed in the lab via a separate Cisco FMC VM. This section walks 992 
through installing and configuring Cisco FTD and Cisco FMC. 993 
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5.1.1 Cisco Firepower Management Center Installation 994 

Cisco FMC was utilized to manage an instance of Cisco FTD. With this in mind, it is suggested to set up 995 
FMC first. Installing and setting up the FMC virtual appliance involved the following steps:  996 

1. Download the FMC VM tar file from the Cisco Downloads page. Note that you will need a Cisco 997 
account to download it. 998 

2. Deploy the OVF in VMWare. 999 

3. Perform initial configuration of the FMC. This included tasks like accepting the End User License 1000 
Agreement (EULA), setting a password, and configuring network settings.  1001 

5.1.2 Cisco Firepower Threat Defense Installation 1002 

For our build, installing the Cisco FTD VM consisted of the following steps: 1003 

1. Download the OVF from the Cisco Downloads page. 1004 

2. Deploy the Cisco FTD VM using the VMware vSphere web client.  1005 

3. Complete the Cisco FTD VM setup using the command line interface (CLI). This included 1006 
performing initial configuration, such as setting up network information, user credentials, 1007 
management mode, and firewall mode. In our build, we chose no for “Enable Local Manager” to 1008 
ensure that the FTD was managed by the FMC from Section 5.1.1. The FTD was set to routed 1009 
firewall mode, which allowed for IP-based separation between subnets.  1010 

4. Register the Firepower Threat Defense to the Firepower Management Center. This included 1011 
configuring network information for the management port, which was the IP address that the 1012 
management center VM communicated with. 1013 

5.1.3 Licensing Cisco FTD with Cisco FMC 1014 

When first logging into the Cisco FMC, a license needs to be applied to the Cisco FTD instance. 1015 
Instructions can be found here. The smart licensing feature allows for individual features to be licensed 1016 
to meet organizational needs. The license types listed in Table 5-1 were applied to our build, and they 1017 
granted the specified capabilities. 1018 

Table 5-1 License Types and Granted Capabilities for Cisco FTD 1019 

License Type Granted Capabilities 

Base User and application control, switching, routing, network address 
translation (NAT) 

Threat Intrusion detection and prevention 

https://software.cisco.com/download/home
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/fmcv/fpmc-virtual/fpmc-virtual-vmware.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/fmcv/fpmc-virtual/fpmc-virtual-initial-setup.html
https://software.cisco.com/download/home
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/vmware/ftdv/ftdv-vmware-qsg.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/vmware/ftdv/ftdv-vmware-gsg/ftdv-vmware-deploy.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/vmware/ftdv/ftdv-vmware-gsg/ftdv-vmware-deploy.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/623/configuration/guide/fpmc-config-guide-v623/licensing_the_firepower_system.html
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Malware Threat intelligence for detecting malware 

URL Filtering Category and reputation-based uniform resource locator (URL) filtering 

AnyConnect VPN Only Remote access virtual private network (VPN) configuration 

5.1.4 Cisco FTD Initial Network Configuration 1020 

After licensing the Cisco FTD instance, the next step is to configure networking information for the 1021 
firewall interfaces. Security zones need to be created; they allow firewall interfaces to be grouped 1022 
together in order to apply configuration and policy. To create security zones, perform the following 1023 
steps: 1024 

1. Choose Objects > Object Management. 1025 

2. Choose Interface from the list of object types. 1026 

3. Click Add > Security Zone. 1027 

4. Enter a name. 1028 

5. Select Routed from Interface Type. 1029 

6. Click Save. 1030 

The security zones described in Table 5-2 were created in support of our build: 1031 

Table 5-2 Security Zones Created for Cisco FTD 1032 

Security Zone Zone Description 

Outside Zone Contained the wide area network (WAN) interface that sat between the firewall 
and the internet gateway 

Endpoints Contained the interface that communicated with all lab endpoints which repre-
sented end user devices and servers 

Shared Services Contained shared common services such as DHCP and DNS 

Patching Products Contained all deployed patching products and services 
 

The next step is to edit each firewall interface with the correct IP address for your organization and the 1033 
appropriate security zone: 1034 

1. Select Devices > Device Management and click Edit ( ) for your FTD device. The Interfaces 1035 
page is selected by default. 1036 

2. Click Edit ( ) for the interface you want to edit. 1037 



DRAFT  

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 42 

3. Enable the interface by checking the Enabled check box. 1038 

4. Under the Security Zone dropdown, select the correct security zone. 1039 

5. Under the IPv4 tab, enter the appropriate IP address information. 1040 

6. Click Ok. 1041 

7. Click Save. 1042 

The last step is to enable NAT. Since private IP addresses cannot traverse the public internet, a NAT rule 1043 
needs to be created to allow the public IP address for the firewall to be used for external network traffic 1044 
from internal network endpoints using private IP addresses. To create a NAT policy, perform the 1045 
following steps: 1046 

1. Select Devices > NAT. 1047 

2. Click New Policy > Threat Defense NAT to create a new policy. Give the policy a name, option-1048 
ally assign devices to it, and click Save. 1049 

3. Click Edit ( ) to edit the Threat Defense NAT policy. 1050 

4. Click Add Rule, then select Auto NAT Rule. 1051 

5. Under Interface Objects, leave any under Source Interface Objects, and place Outside_Zone 1052 
under Destination Interface Objects. 1053 

 1054 

6. Under the Translation tab, select IPv4-Private-10.0.0.0-8 under Original Source, and under 1055 
Translated Source select Destination Interface IP. 1056 
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 1057 

7. Click Ok, then click Save. 1058 

8. Click Deploy > Select Device > Deploy to deploy the NAT policy. 1059 

5.2 Cisco Identity Services Engine 1060 

Cisco ISE is a network administration product that allows for enforcement of administrator-created 1061 
security and access control policies. Cisco ISE captures attributes about devices, such as IP address, MAC 1062 
address, and OS in order to enforce custom policies. Cisco ISE can be deployed as a standalone system 1063 
or as a primary and secondary node for high-availability deployments. Our build utilized a single ISE VM 1064 
node set in standalone deployment. 1065 

5.2.1 Cisco ISE Installation 1066 

The installation process for deploying a virtualized version of Cisco ISE requires you to download the 1067 
OVA from https://software.cisco.com/download/home and deploy it using VMWare. Note that you will 1068 
need a Cisco account to be able to download software from Cisco. Follow the steps here for deploying 1069 
the Cisco ISE OVA template.  1070 

After deploying the ISE OVA, launch the VM console from VMWare. At the Cisco ISE CLI, type setup to 1071 
start the ISE setup wizard. Use it to configure hostname and IP address information and to create admin 1072 
credentials for the Web Admin portal. 1073 

Lastly, Cisco ISE needs to be licensed. Follow the guidance here to find more information on licensing 1074 
your ISE deployment. 1075 

https://software.cisco.com/download/home
https://www.cisco.com/c/en/us/td/docs/security/ise/2-0/installation_guide/b_ise_InstallationGuide20/Installing_ISE_on_a_VMware_Virtual_Machine.html
https://www.cisco.com/c/en/us/td/docs/security/ise/2-4/admin_guide/b_ISE_admin_guide_24/m_ise_man_license.html


DRAFT  

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 44 

5.2.2 Cisco ISE Initial Configuration 1076 

After performing initial setup and licensing, the next step is to ensure that the Cisco ISE deployment 1077 
node has the correct settings and profiling configuration services running. Perform the following steps: 1078 

1. Click Administration > System > Deployment. 1079 

2. Under the General Settings tab, ensure that the options shown below are selected. 1080 

 1081 

3. Under the Profiling Configuration tab, ensure the following options are selected. Note that a 1082 
description of the various profiling services can be found on the Profiling Configuration tab. 1083 
When you are done selecting the options, click Save. 1084 
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 1085 

For our build, Cisco ISE needed to have an integration with AD services to perform authentication of 1086 
endpoint users to the network. Cisco ISE used AD as a trusted store to authenticate users and machines 1087 
to the network. To perform the integration between Cisco ISE and AD, follow the guidance here. 1088 

5.2.3 Configuring AnyConnect VPN Using Cisco FTD and Cisco ISE 1089 

By default Cisco ISE cannot make any policy enforcement actions for devices that are not actively 1090 
authenticated against it. This means that devices that are not using 802.1X authentication or the 1091 
AnyConnect VPN client will not have full device attributes collected nor be subject to ISE policy rulesets. 1092 
Our build utilized AnyConnect VPN integration between the Cisco FTD and Cisco ISE to demonstrate 1093 
authenticating two hosts to Cisco ISE. The example assets chosen to be connected to the VPN were a 1094 
Windows 10 and CentOS 7 VM. Please follow the steps here for setting up the integration. 1095 

5.2.4 Cisco Security Group Tags (SGTs) 1096 

Cisco security group tags (SGTs) are user-designated tags that can be used to group and classify devices. 1097 
Each tag is then used to represent logical group privileges to inform the access policy. SGTs were used by 1098 
the build to restrict access to devices that did not meet the desired organization patch level. This section 1099 
covers setting up the Quarantine SGT and sharing SGTs with Cisco FTD. 1100 

First, add the Quarantine SGT to Cisco ISE with these steps: 1101 

https://www.cisco.com/c/en/us/td/docs/security/ise/2-2/ise_active_directory_integration/b_ISE_AD_integration_2x.html#ID612
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/215236-ise-posture-over-anyconnect-remote-acces.html
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1. Click on Work Centers > Trust Sec > Components > Security Groups. 1102 

2. Click Add. 1103 

3. Under Name, type: Quarantined_Systems. 1104 

4. Under Description, type: Quarantine Security Group. 1105 

5. Ensure the Propagate to ACI option is checked. 1106 

 1107 

After adding the Quarantine SGT, it needs to be shared with the Cisco FTD. SGTs are not shared between 1108 
ISE and FTD by default. ISE will have to be added as an identity source to the firewall. This 1109 
communication between the firewall and ISE takes place using pxGrid. The process for setting up SGT 1110 
sharing from ISE to the firewall involves: 1111 

 making sure that SGTs are published via pxGrid by Cisco ISE, 1112 

 exporting the ISE pxGrid and monitoring (MNT) system certificates for importation to FTD, and 1113 

 adding ISE as an identity source on the firewall.  1114 

The build used this integration to perform network access control on devices that were given the 1115 
Quarantine SGT by ISE. This SGT was given by assessing an endpoint’s current patch level. See this page 1116 
for step-by-step guidance on adding Cisco ISE as an identity source. 1117 

https://www.cisco.com/c/en/us/td/docs/security/firepower/650/configuration/guide/fpmc-config-guide-v65/control_users_with_ise_ise_pic.html
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5.2.5 Cisco ISE Integration with Tenable.sc 1118 

For our build, Cisco ISE contained an integration with Tenable.sc to perform automated scanning of 1119 
endpoints as they were authenticated to ISE. ISE could then take the highest CVSS score that was 1120 
associated with an endpoint and, via policy, enforce network restrictions through sharing SGTs with the 1121 
Cisco firewall. The build used this capability to scan devices as they connected to the network and 1122 
determine whether a quarantine action should take place.  1123 

The steps for integrating ISE with Tenable.sc consist of the following: 1124 

1. Create a machine account for ISE to log in into Tenable.sc to launch a scan. The device is 1125 
referred to as a machine account since it is used by a service and not a person. 1126 

2. Export the Tenable.sc Root and System certificates, and import them to Cisco ISE. This step is so 1127 
there are no errors when Cisco tries to contact Tenable over Hypertext Transfer Protocol Secure 1128 
(HTTPS) for API calls. 1129 

3. Configure third-party threat integrations on Cisco ISE. This will start the process of creating the 1130 
integration with Tenable, including creating a Tenable adapter. 1131 

4. Configure the Tenable adapter. The adapter is how Cisco ISE will communicate with Tenable, so 1132 
it needs to be configured to provide login credentials and connection options. 1133 

5. Configure an authorization profile. This configures Cisco ISE to assess vulnerabilities via the 1134 
newly created Tenable adapter. 1135 

Step-by-step guidance on integrating Cisco ISE with Tenable.sc is available here. Note: Your ISE instance 1136 
will need to be version 2.7 or higher. 1137 

Once the integration between Cisco ISE and Tenable is configured correctly, vulnerability data is 1138 
viewable for connected endpoints. To view vulnerability data for connected devices, go to Context 1139 
Visibility > Endpoints > Vulnerable Endpoints. The collected device information, such as the example in 1140 
Figure 5-1, shows the affected IP address, current user, Tenable plugin ID, and CVSS score. 1141 

https://community.cisco.com/t5/security-documents/cisco-tc-nac-with-ise-and-tenable-security-center/ta-p/3647543
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Figure 5-1 Cisco ISE View of Vulnerability Data for Connected Devices 1142 

 
The highest CVSS score associated with a device was utilized by the patching lab to create policy that would restrict network access to devices with a vulnerability that exceeded a CVSS threshold score of 7. This threshold was designed to 1143 
block devices that have high and critical severity scores. 1144 
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5.2.6 Cisco ISE Integration with Cisco Catalyst 9300 Switch 1145 

For our build, Cisco ISE contained an integration with a physical Cisco Catalyst 9300 switch located in the 1146 
lab network. This allowed Cisco ISE to perform 802.1x port-based authentication for devices that were 1147 
connected via ethernet. The build used this capability to authenticate devices to the network and then 1148 
later scanned authenticated devices to ensure they were at the appropriate patch level. The example 1149 
implementation applied 802.1x authentication to port 40 of a 48-port switch. 1150 

The following is an abbreviated version of the steps we performed in the lab to integrate ISE with the 1151 
Cisco Catalyst 9300 switch. For more detailed guidance, consult the following Cisco guide. 1152 

1. Access the admin console of the Cisco switch via a physical connection or remote protocol. 1153 

2. Go to global configuration mode by typing config t and then enter the following: 1154 

aaa new-model 1155 

! 1156 

aaa group server radius ise 1157 

 server name ISE 1158 

! 1159 

aaa authentication dot1x default group ise 1160 

aaa authorization network default group ise 1161 

aaa accounting update newinfo periodic 1440 1162 

aaa accounting dot1x default start-stop group ise 1163 

! 1164 

aaa server radius dynamic-author 1165 

 client 10.132.6.12 server-key password 1166 

! 1167 

aaa session-id common 1168 

switch 1 provision c9300-48p 1169 

! 1170 

radius-server attribute 6 on-for-login-auth 1171 

radius-server attribute 6 support-multiple 1172 

radius-server attribute 8 include-in-access-req 1173 

radius-server attribute 25 access-request include 1174 

https://www.cisco.com/c/en/us/td/docs/security/ise/3-0/admin_guide/b_ISE_admin_3_0/b_ISE_admin_30_integration.html#reference_AFBF2DEB9EB8408EB66C37CC836ECB69
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radius-server attribute 31 mac format ietf upper-case 1175 

radius-server attribute 31 send nas-port-detail 1176 

! 1177 

radius server ISE 1178 

 address ipv4 10.132.6.12 auth-port 1645 acct-port 1646 1179 

 key password 1180 

3. Configure interface 40 by typing interface Gi10/40 at the switch terminal and then entering 1181 
the following information: 1182 

switchport mode access 1183 

 authentication event fail action next-method 1184 

 authentication event server dead action authorize vlan 1345 1185 

 authentication event server dead action authorize voice 1186 

 authentication event server alive action reinitialize 1187 

 authentication host-mode multi-auth 1188 

 authentication open 1189 

 authentication order dot1x mab 1190 

 authentication priority dot1x mab 1191 

 authentication port-control auto 1192 

 authentication periodic 1193 

 authentication timer reauthenticate server 1194 

 authentication violation restrict 1195 

 mab 1196 

 dot1x pae authenticator 1197 

 dot1x timeout tx-period 10 1198 

 spanning-tree portfast 1199 

4. Add the Cisco Switch to ISE by navigating to Administration > Network Resources > Network 1200 
Devices and clicking the Add button. 1201 

5. In the Network Devices field, fill out the information shown below to ensure that Cisco ISE 1202 
knows the IP address of the switch, network device group information, and has a name and 1203 
description for the new device. 1204 
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 1205 

6. Ensure the RADIUS Authentication Settings box is checked, then fill out the information shown 1206 
below. Please note that the Share Secret field corresponds with the radius server key field from 1207 
the last line of the configuration in step 2. 1208 
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 1209 

7. Next, select the checkbox by SNMP Settings, and fill out the information depicted below. 1210 

 1211 
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8. Click the Save button. 1212 

5.2.7 Cisco ISE Policy Sets 1213 

Cisco ISE policy sets are policy-based rules that are written to group devices together. Group devices can 1214 
then have access control policies applied. Our build utilized policy sets to create rules that would apply 1215 
network access control policies to devices that did not meet the appropriate patch level. Guidance for 1216 
setting up policy sets can be found here. 1217 

5.2.7.1 VPN Policy Set 1218 

The following policy set was created for the build to enforce network restrictions on VPN devices that 1219 
did not meet the desired patching threshold. As a reminder, VPN devices were chosen because network 1220 
enforcement can only be performed on actively authenticated devices. The following steps walk through 1221 
setting up the patching example policy set: 1222 

1. In the Cisco ISE Web Console, click Policy > Policy Sets. 1223 

2. Click the Add icon. 1224 

3. Under the Policy Set Name field, type: VPN. 1225 

4. Click the plus button under the conditions field. 1226 

5. In the Editor field, select Click to add an attribute field. 1227 

6. Click the Network Device Button . 1228 

7. Click the Device Type attribute. 1229 

8. Under the Choose from list or type dropdown, select All Device Types#VPNDevice. 1230 

9. Click the Use button. 1231 

10. Click the arrow under View on the newly created VPN Policy. 1232 

11. Under the Authorization Policy – Global Exceptions tab, add the rule depicted below. It 1233 
indicates that if an endpoint has a vulnerability with a CVSS score greater than 7, the device 1234 
receives the Quarantined_Systems security group tag. This rule was placed into the Global 1235 
Exceptions tab because it allows these rules to be checked first. This is important, as it allows 1236 
rules in this category to override any rules that may grant network access to a device. 1237 

  1238 

https://www.cisco.com/c/en/us/td/docs/security/ise/2-7/admin_guide/b_ise_27_admin_guide/b_ISE_admin_27_segmentation.html?referring_site=RE&pos=1&page=https://www.cisco.com/c/en/us/td/docs/security/ise/2-4/admin_guide/b_ISE_admin_guide_24/m_configure_and_manage_policies.html#ID37
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5.2.7.2 Wired 802.1x Policy Set 1239 

The following policy set was created for the build to enforce network restrictions on wired 802.1x 1240 
connected devices that did not meet the desired patching threshold. The following steps walk through 1241 
setting up the patching example policy set: 1242 

1. In the Cisco ISE Web Console, click Policy > Policy Sets. 1243 

2. Click the Add icon. 1244 

3. Under the Policy Set Name field, type: Wired. 1245 

4. Click the plus button under the conditions field. 1246 

5. In the Editor field. select Click to add an attribute field. 1247 

6. Click and drag over the Wired_802.1X and Wired_MAB conditions from the library field. 1248 

7. Click the Use button. 1249 

8. Click the arrow under View on the newly created Wired policy. 1250 

9. Under the Authentication Policy tab, add the policy depicted below. It allows Cisco ISE to 1251 
authenticate 802.1x users against an identity store. The identity store we used was our AD 1252 
users. 1253 

 1254 

10. Under the Authorization Policy tab, three new rules need to be created, as the screenshot 1255 
below depicts. The Posture-NonCompliant rule says that devices that are assessed and deemed 1256 
not compliant should be assigned the Quarantined_Systems security group tag. The Posture rule 1257 
says that devices that are marked compliant should be permitted access to the network and 1258 
assigned an employee group tag. The Posture-Unknown rule states that devices that have an 1259 
unknown posture, meaning the device has yet to be assessed by Cisco ISE, should be redirected 1260 
to install the posture assessment module. 1261 
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 1262 

5.2.8 Client Provisioning Policy 1263 

The Cisco AnyConnect module is used by ISE to perform posture assessments of 802.1X and VPN 1264 
connected devices. To ensure that users can be provisioned with the latest version of the AnyConnect 1265 
module, the Client Provisioning Policy needs to be set up for Windows and macOS devices. Our build 1266 
downloaded the Cisco AnyConnect Module to the machine administrating ISE, from the following Cisco 1267 
download page, and uploaded the resource during the creation of the Client Provisioning Policy. 1268 

Under the Client Provisioning Policy field, the Windows and MAC OS fields were edited as shown in 1269 
Figure 5-2 to provide access for endpoints to download the AnyConnect Module. For more detailed 1270 
information regarding setting up Client Provisioning Resources, please consult the following page. 1271 

Figure 5-2 Examples of Client Provisioning Policies 1272 

 

5.2.9 Posture Assessment 1273 

The lab instance utilized Cisco ISE’s ability to perform posture assessments to determine the patch level 1274 
of connected devices. This collected information was used to meet the use case for isolating 1275 
unpatchable assets. We configured ISE to perform a posture assessment of a physical Windows laptop. 1276 
The posture assessment agent was configured to check if Windows Update reported any missing critical 1277 
patches before letting a device join the network. The steps below provide an overview of the work 1278 
performed in the lab instance to configure Posture Assessment; more information can be found at the 1279 
following page. 1280 

https://software.cisco.com/download/home/286281283/type/282364313/release/4.10.03104?i=!pp
https://www.cisco.com/c/en/us/td/docs/security/ise/2-1/admin_guide/b_ise_admin_guide_21/b_ise_admin_guide_20_chapter_010101.html
https://www.cisco.com/c/en/us/td/docs/security/ise/2-2/admin_guide/b_ise_admin_guide_22/b_ise_admin_guide_22_chapter_010111.html
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1. In the Cisco ISE Web console, click Policy > Posture. 1281 

2. Under the last rule in the list, click the drop-down arrow by the Edit button and click Insert New 1282 
Policy. 1283 

3. In the policy field, fill out the information as shown below and click Save. The policy states that 1284 
users from any policy group running any version of Windows using the AnyConnect Compliance 1285 
Module will be subjected to a WinPatching rule that will check for Windows updates. 1286 

 1287 

4. Click on Policy > Policy Elements > Posture > Patch Management Condition to add a new patch 1288 
management condition. This step configures AnyConnect to check for missing patches for 1289 
Important and Critical updates on endpoints against Windows Update Agent. Configure the 1290 
Patch Management Condition with the information shown below. 1291 

 1292 

5. Next, in the ISE interface click Policy > Policy Elements > Results > Posture > Remediation 1293 
Action. This step configures ISE to perform remediation actions on devices that are deemed 1294 
non-compliant. Under the last rule in the list, click the drop-down arrow by the Edit button and 1295 
then click Insert New Requirement. Add the following: 1296 

 1297 

6. Click Save to save the new requirement. 1298 
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5.2.10  Cisco FTD Firewall Rules 1299 

The Cisco FTD firewall rules were used to enforce network restrictions on the quarantined systems using 1300 
the Quarantined_Systems security group tag in our build. The following steps create a basic 1301 
enforcement rule: 1302 

1. On the Cisco FMC web console, click Policies > Access Control. 1303 

2. Click New Policy. 1304 

3. Fill out the New Policy Form with the information below. The default action for the policy is 1305 
network discovery. Network discovery allows for traffic to be monitored by the firewall only 1306 
without blocking traffic. This monitored traffic is then collected and can be utilized by network 1307 
admins to create organizational firewall rules. Once firewall rules are in place for your 1308 
organization, this item can be changed to block all traffic. 1309 

 1310 

4. Click Save. 1311 

5. Click the edit button  on the newly created rule. 1312 

6. Click the Add Rule button. 1313 

7. Under the Zones category, add the information in the screenshot below. The rule states that 1314 
traffic that is coming from anywhere will be allowed to the VendorProducts zone, which 1315 
contains the vendor-supplied patching products that were utilized in this build. This rule ensures 1316 
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that quarantined systems can still receive patches and updates from the appropriate patching 1317 
system. 1318 

 1319 

8. Under the SGT/ISE Attributes tab, fill out the fields with the information in the screenshot. This 1320 
applies the network access control from step 7 only to traffic that originates from a machine 1321 
with the Quarantined_Systems security group tag. 1322 

 1323 

9. Click Save. 1324 

10. Click the Add Rule button to add an additional rule. 1325 
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11. Edit the Zones tab with the information in the screenshot. This rule causes any traffic that has 1326 
the Quarantined_Systems security group tag to be blocked from traversing the network. 1327 

 1328 

12. Under the SGT/ISE Attributes tab, add the Quarantined_Systems security group tag to Selected 1329 
Source Metadata, like in step 8. 1330 

5.3 Cisco Maintenance 1331 

All Cisco products should be kept up to date. You are required to have an active Cisco account to 1332 
download updated software. Software for all Cisco products can be downloaded from here. Follow the 1333 
guidance on the following pages to upgrade the Cisco product of your choice: 1334 

 Upgrade Cisco Firepower Management Center 1335 

 Upgrade Cisco Firepower Threat Defense 1336 

 Upgrade Cisco Identity Services Engine 1337 

6 Microsoft  1338 

In this implementation, we used Microsoft Endpoint Configuration Manager to perform configuration 1339 
management, including software and firmware patching. Microsoft Endpoint Configuration Manager 1340 
also provided discovery capabilities for endpoints and the capability to respond to emergency scenarios, 1341 
such as providing a workaround or an emergency patch. 1342 

https://software.cisco.com/download/home
https://www.cisco.com/c/en/us/td/docs/security/firepower/upgrade/fpmc-upgrade-guide/upgrade_firepower_management_centers.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/upgrade/fpmc-upgrade-guide/upgrade_firepower_threat_defense.html#id_59714
https://www.cisco.com/c/en/us/td/docs/security/ise/2-7/upgrade_guide/Upgrade_Journey/PDF/b_ise_upgrade_guide_2_7_pdf/m_upgradeoverview.html
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6.1 Microsoft Installation and Configuration 1343 

Our implementation utilized a standalone deployment of Microsoft Endpoint Configuration Manager 1344 
with a separate instance of the database server running Microsoft SQL 2019. The Microsoft Endpoint 1345 
Configuration Manager was configured to manage multiple Windows-based hosts within the lab 1346 
environment. The standalone server hosting the Microsoft Endpoint Configuration Manager and the SQL 1347 
Server were running Windows Server 2019. Each of these servers was joined to the lab Domain 1348 
Controller, allowing Microsoft Endpoint Configuration Manager to utilize the services the Domain 1349 
Controller provided. Information on how to determine the correct deployment for your environment 1350 
can be found here. 1351 

Our implementation of Endpoint Configuration Manager consisted of multiple components, including: 1352 

 Windows Server Update Services (WSUS), an update service primarily used for downloading, 1353 
distributing, and managing updates for Microsoft Windows-based systems. Information on how 1354 
to deploy the WSUS role on Windows Server 2019 can be found here. 1355 

 Microsoft SQL Server, which served as a database for the Endpoint Configuration Manager 1356 
sites. The sites are where most of the data for the Endpoint Configuration Manager product is 1357 
stored. Information on how to deploy Microsoft SQL Server 2019 can be found here. 1358 

 Microsoft Endpoint Configuration Manager site server, which hosted the core functionality of 1359 
Endpoint Configuration Manager. Microsoft Endpoint Configuration Manager sites are used to 1360 
manage endpoints. Information on how to deploy the Endpoint Configuration Manager sites 1361 
can be found here. 1362 

 Microsoft Endpoint Configuration Manager console, which was needed to perform 1363 
administration tasks and was the interface for interacting with the Endpoint Configuration 1364 
Manager sites. Information on how to deploy the Endpoint Configuration Manager console can 1365 
be found here. 1366 

6.2 Device Discovery 1367 

In our implementation, we utilized Heartbeat Discovery, Active Directory System, and Active Directory 1368 
Group Discovery. Heartbeat Discovery functioned by having the Microsoft Endpoint Configuration 1369 
Manager agent on the endpoint periodically communicate with the Microsoft Endpoint Configuration 1370 
Manager server. Active Directory System and Active Directory Group Discovery took advantage of the 1371 
Enterprise Patching domain and retrieved domain information from the directory server on computers 1372 
joined to the domain and groups. 1373 

More information on how to set up device discovery capabilities can be found here. 1374 

https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/configs/supported-configurations
https://docs.microsoft.com/en-us/windows-server/administration/windows-server-update-services/deploy/1-install-the-wsus-server-role
https://docs.microsoft.com/en-us/sql/sql-server/?view=sql-server-ver15
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/deploy/install/prepare-to-install-sites
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/deploy/install/install-consoles
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/deploy/configure/configure-discovery-methods
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6.3 Patching Endpoints with Microsoft Endpoint Configuration Manager 1375 

For our implementation, Microsoft Endpoint Configuration Manager was configured to support software 1376 
updates to Windows devices. More information on how to do this can be found here. 1377 

Our deployment relied on third-party updates to deploy non-Microsoft-based software updates. The 1378 
implementation subscribed to update catalogues that supported software updates for firmware. More 1379 
information on how to configure third-party updates can be found here.  1380 

Although there are multiple methods for distributing patches, our deployment utilized the manual 1381 
method for deploying software updates. This method applied to both third-party updates and updates 1382 
from Microsoft. This was achieved by first downloading the software updates we wanted to deploy from 1383 
the “All Software Updates” view, as Figure 6-1 shows. From this view you can download the software 1384 
updates you want to deploy. 1385 

 1386 

https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/deploy-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/third-party-software-updates


DRAFT  

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 62 

Figure 6-1 All Software Updates View for Microsoft Endpoint Configuration Manager 1387 
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From this view you can download the software updates you want to deploy. The next step we 1388 
performed was creating a new deployment package. Figure 6-2 provides an example of this. 1389 

Figure 6-2 Creating a New Deployment Package with Microsoft Endpoint Configuration Manager 1390 

 

After creating a deployment package, the updates can be distributed to endpoints by adding the 1391 
deployment package to a software update group. More information on how to use this method can be 1392 
found here. 1393 

https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/manually-deploy-software-updates
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For instances where updates need to be deployed more quickly, deployments can be specified with 1394 
immediate delivery by changing the deployment type to Required. See Figure 6-3 showing the settings 1395 
for an example deployment. 1396 

Figure 6-3 Deployment Settings 1397 

 

This forces the update to be installed based on the schedule specified in the deployment. For immediate 1398 
updates, select As soon as possible when configuring the schedule for deployment. Figure 6-4 shows the 1399 
schedule details for an example deployment. 1400 
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Figure 6-4 Deployment Schedule 1401 

 

Our deployment also relied on Endpoint Configuration Manager’s ability to deploy a PowerShell script to 1402 
endpoints for emergency workaround scenarios. We utilized a script that uninstalled Java on the 1403 
endpoint on which the script is run. More information on how to deploy PowerShell scripts can be found 1404 
here.  1405 

The script we uploaded into Microsoft Endpoint Configuration Manager for the build was:  1406 

gwmi Win32_Product -filter "name like 'Java%'" | % { $_.Uninstall() } 1407 

https://docs.microsoft.com/en-us/mem/configmgr/apps/deploy-use/create-deploy-scripts
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Our deployment relied on Microsoft Endpoint Configuration Manager’s ability to deploy scripts directly 1408 
to endpoints. This was achieved by selecting an endpoint from the Devices view and selecting the Run 1409 
Script option, as Figure 6-5 illustrates. 1410 

Figure 6-5 Devices View with Run Script Option Selected 1411 

 

6.4 Microsoft Reporting 1412 

We utilized the reporting capabilities of Microsoft Endpoint Configuration Manager to determine which 1413 
Windows patches and third-party updates were available for endpoints. Information on configuring 1414 
those reporting capabilities can be found here. 1415 

The build utilized the available Software Updates reports from Microsoft Endpoint Configuration 1416 
Manager to determine specific software updates that were available for endpoints. An example of a 1417 
report used for this to determine what critical third-party updates are available can be seen in Figure 1418 
6-6. 1419 

https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/configuring-reporting
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Figure 6-6 Report Showing Critical 3rd Party Updates Available for HP Business Clients 1420 

 

6.5 Microsoft Maintenance 1421 

Microsoft Endpoint Configuration Manager utilizes in-console updates and servicing. This feature 1422 
automatically applies Microsoft-recommended updates that are relevant to your specific infrastructure 1423 
and configuration. 1424 

7 Forescout 1425 

In this implementation, we used the Forescout platform to perform endpoint discovery. The Forescout 1426 
platform can perform endpoint discovery by detecting endpoints and determining software information 1427 
about those endpoints based on a set of attributes. The Forescout platform also provided the capability 1428 
to isolate or restrict unpatchable assets and to respond to emergency scenarios, such as providing a 1429 
workaround or deploying an emergency patch. This section explains how the Forescout platform was 1430 
utilized in this build. 1431 

7.1 Installation and Configuration of Enterprise Manager and Appliance 1432 

Our implementation of the Forescout platform utilized both the Forescout Enterprise Manager and 1433 
Forescout Appliance. Instructions for deploying these can be found here. 1434 

In our setup, the Enterprise Manager allowed for the management of multiple Forescout Appliances. 1435 
Although our build only contained one appliance, we chose to utilize the Enterprise Manager to 1436 

https://docs.forescout.com/bundle/install-guide-8-1-x/page/install-guide-8-1-x.Installation-Overview.html


DRAFT  

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 68 

demonstrate an enterprise environment and to enable adding more appliances to our build if needed. 1437 
The Forescout Appliance was deployed to have a dedicated virtual device for monitoring network traffic. 1438 
Depending on the size of your network and your specific requirements, more than one physical or virtual 1439 
appliance may be recommended. 1440 

7.1.1 Installation via OVF 1441 

Instructions for deploying OVF templates that can be utilized as either an Enterprise Manager or 1442 
Forescout Appliance can be found here. The OVF installation method was used by the team for both the 1443 
Enterprise Manager and Appliance deployment; there are other installation methods available that may 1444 
be better suited for your environment.  1445 

7.1.2 Installation of Forescout Console and Initial Setup 1446 

The console application is required to complete the installation of the Forescout platform and to 1447 
administer the system. The console was installed on a dedicated VM running the Windows 10 OS. This 1448 
VM has network access to the Forescout Enterprise Manager and Appliance. The instructions for initial 1449 
installation and setup of the Forescout console can be found here.  1450 

7.2 Forescout Capabilities Enabled 1451 

After installation and initial setup, it is recommended to enable additional capabilities for the Forescout 1452 
platform to utilize. The capabilities enabled will depend on what services are available in your 1453 
environment for Forescout to integrate with. The following subsections cover the basic options the team 1454 
enabled and utilized in our build.  1455 

7.2.1 Network 1456 

The Forescout platform was configured to capture network traffic from the Forescout Appliance. Traffic 1457 
was collected from all of the internal subnets from the lab environment. This allowed the Forescout 1458 
Appliance to identify hosts on our network by collecting network traffic from the virtual switch using a 1459 
mirror port. This allowed traffic to be collected from endpoints without requiring an agent or 1460 
communicating directly between the Forescout platform and the endpoints. 1461 

7.2.2 User Directory 1462 

The User Directory plugin was configured so that the Forescout platform integrated with the lab’s AD 1463 
Domain Controller. This plugin provided Lightweight Directory Access Protocol (LDAP) services to 1464 
Forescout, allowing directory-based users to log in into Forescout as well as providing user directory 1465 
information such as the current active domain users logged into each endpoint. More information about 1466 
this plugin can be found in the Authentication Module: User Directory Plugin Server and Guest 1467 
Management Configuration Guide.  1468 

https://docs.forescout.com/bundle/install-guide-8-1-x/page/install-guide-8-1-x.Forescout-Virtual-Device-Deployment-in-VMware.html
https://docs.forescout.com/bundle/install-guide-8-1-x/page/install-guide-8-1-x.Install-and-Log-in-to-the-Forescout-Console.html
https://docs.forescout.com/bundle/ud-guest-6-4-x-h/page/ud-guest-6-4-x-h.Configure-the-User-Directory-Plugin.html
https://docs.forescout.com/bundle/ud-guest-6-4-x-h/page/ud-guest-6-4-x-h.Configure-the-User-Directory-Plugin.html
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7.2.3 DNS Query Extension 1469 

This configuration setting allowed Forescout to query the DNS server to determine the hostnames of 1470 
devices identified by Forescout. 1471 

7.2.4 Tenable VM 1472 

The Tenable VM plugin provided the Forescout platform with vulnerability and scan status information 1473 
which can be used to create custom policies. This plugin also enabled Forescout to utilize vulnerability 1474 
management information that Tenable.sc collected from endpoints, and allowed the Forescout platform 1475 
to determine if scans had been performed on endpoints within the lab. More information about the 1476 
Critical Vulnerability Quarantine policy which utilizes the data from this policy can be found in Section 1477 
7.3.3. Information on how this plugin can be installed and configured for your environment can be found 1478 
in the eyeExtend for Tenable Vulnerability Management Configuration guide.  1479 

7.2.5 Microsoft SMS/SCCM 1480 

The Microsoft Systems Management Server (SMS)/System Center Configuration Manager (SCCM) 1481 
module was configured to allow the Forescout platform to integrate with Microsoft Endpoint 1482 
Configuration Manager. This module allowed for a custom policy to be created that used data from 1483 
Microsoft Endpoint Configuration Manager. More information about the SCCM Agent Non Compliant 1484 
Check policy which utilizes the data from this module can be found in Section 7.3.6. In our build, this 1485 
module was primarily used to determine which hosts were running the Endpoint Configuration Manager 1486 
agent and therefore communicating with Microsoft Endpoint Configuration Manager. Information on 1487 
how this module can be installed and configured for your environment can be found in the Endpoint 1488 
Module: Microsoft SMS/SCCM Plugin Configuration guide.  1489 

7.2.6 Linux 1490 

The Linux plugin was configured to collect information from and manage Linux-based endpoints via two 1491 
methods: secure shell (SSH) access to the endpoints, and agent-based integration with the Linux 1492 
endpoint. Both of these methods for collecting data from endpoints were implemented in the lab 1493 
environment. Information on how this plugin can be installed and configured for your environment can 1494 
be found in the Endpoint Module: Linux SCCM Plugin Configuration guide. 1495 

7.2.7 HPS Inspection Engine 1496 

The HPS Inspection Engine was configured to collect information from Windows endpoints via two 1497 
methods. The first method utilized a directory-based integration with the lab’s AD Domain Services 1498 
instance, which collected domain-based information on the Windows endpoint. The second method 1499 
utilized an agent-based integration called SecureConnector that allowed Forescout to collect and 1500 
manage Windows endpoints. The agent-based integration was deployed to endpoints by a Windows 1501 

https://docs.forescout.com/bundle/tenable-vm-3-0-4-h/page/tenable-vm-3-0-4-h.Configure-eyeExtend-for-Tenable-VM-Module.html
https://docs.forescout.com/bundle/SMS-SCCM-2-3-h/resource/SMS-SCCM-2-3-h.pdf
https://docs.forescout.com/bundle/SMS-SCCM-2-3-h/resource/SMS-SCCM-2-3-h.pdf
https://docs.forescout.com/bundle/linux-1-2-h/resource/linux-1-2-h.pdf
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Installer (MSI) installer that was manually downloaded from the Enterprise Manager and installed on the 1502 
endpoint.  1503 

Multiple deployment methods can be utilized for installing the SecureConnector. Two methods that 1504 
were not utilized in this build are automatically deploying software utilizing a configuration 1505 
management tool, and using a corporate image with the SecureConnector preinstalled when configuring 1506 
new endpoints for your environment. 1507 

Information on how the HPS Inspection Engine can be installed and configured for your environment can 1508 
be found in the Endpoint Module: HPS Inspection Engine Configuration guide. 1509 

7.2.8 pxGrid 1510 

The pxGrid plugin was configured to integrate with Cisco ISE. This plugin gave the Forescout Platform 1511 
the ability to utilize Cisco ISE to apply adaptive network control (ANC) policies to endpoints. ANC policies 1512 
can be used to control network access for endpoints. The ANC policies were enabled on Cisco ISE and 1513 
could be controlled by third-party systems such as the Forescout platform using pxGrid.  1514 

In this implementation, an ANC policy configured within Cisco ISE was used to apply a quarantine policy 1515 
against the host. For example, in the Critical Vulnerability Quarantine Policy in Section 7.3.3, Forescout 1516 
communicates to Cisco ISE to quarantine the host when critical vulnerabilities are found on the endpoint 1517 
via the Tenable VM plugin. After the Cisco ISE ANC policy is applied to a host, the device is assigned a 1518 
Quarantine security group tag by Cisco ISE. The pxGrid integration between ISE and the Cisco FTD 1519 
firewall allows for security group tags to be shared. This SGT is then applied by ISE, and network traffic 1520 
at layer 3 is controlled via firewall rules that were created in Section 5.2.7. Information on how this 1521 
plugin can be installed and configured for your environment can be found in the pxGrid Plugin 1522 
Configuration guide. 1523 

7.2.9 Switch 1524 

The Switch plugin was configured to integrate the Forescout platform with the physical Cisco switch 1525 
located in the lab. The plugin used information from the switch to collect information about endpoints 1526 
that were physically connected to the switch. Information on how this plugin can be installed and 1527 
configured for your environment can be found in the Network Module: Switch Plugin Configuration 1528 
guide. 1529 

7.2.10  VMWare vSphere/ESXi 1530 

Forescout can integrate with VMWare vCenter or ESXi host via a plugin. Our build utilized this plugin to 1531 
collect information on what virtual hosts and appliances were running in support of the host discovery 1532 
scenario. We configured Forescout to collect information from a VMWare ESXi host installed on a Dell 1533 

https://docs.forescout.com/bundle/hps-ie-11-1-2-h/page/hps-ie-11-1-2-h.Configure-the-HPS-Inspection-Engine.html
https://docs.forescout.com/bundle/pxgrid-1-2-h/page/pxgrid-1-2-h.Configure-the-Forescout-Platform-for-the-pxGrid.html
https://docs.forescout.com/bundle/pxgrid-1-2-h/page/pxgrid-1-2-h.Configure-the-Forescout-Platform-for-the-pxGrid.html
https://docs.forescout.com/bundle/switch-8-13-x-h/page/switch-8-13-x-h.Configuring-Switches-in-the-Switch-Plugin.html
https://docs.forescout.com/bundle/switch-8-13-x-h/page/switch-8-13-x-h.Configuring-Switches-in-the-Switch-Plugin.html
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R620 server in the lab environment. Information on how this plugin can be installed and configured can 1534 
be found on the following page. 1535 

The following is an overview of the steps for configuring the plugin: 1536 

1. Open the Forescout Console and go to Options > Tools. 1537 

2. Select VMWare vSphere from the left pane. 1538 

3. Select Add. 1539 

4. Fill out the resulting form with the requested parameters. 1540 

7.3 Policies 1541 

The project received policies from Forescout that are normally made available to a customer when they 1542 
purchase professional services from Forescout. These policies helped the team to discover, classify, and 1543 
assess endpoints on the lab network. More information on how to receive the professional services 1544 
policies can be found here. 1545 

To satisfy the scenarios outlined in the project description, the team also created the following custom 1546 
policies. More information on how to create custom policies can be found here.  1547 

7.3.1 Adobe Flash Player Removal Policy 1548 

The Adobe Flash Player Removal policy checks if Flash is running on a Windows Endpoint. If it is, this 1549 
policy will terminate the process running Flash and uninstall Flash by running the command 1550 
“uninstall_flash_player.exe -uninstall” on the endpoint. 1551 

<RULES> 1552 

<RULE APP_VERSION="8.2.2-1553 
731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" CLASSIFICATION="REG_STATUS" DES1554 
CRIPTION=" " ENABLED="true" ID="-2605681954930199910" NAME="Adobe Flash Player 1555 
Removal" NOT_COND_UPDATE="true" UPGRADE_PERFORMED="true"> 1556 

<GROUP_IN_FILTER> 1557 

<GROUP ID="1391284960034120761" NAME="Windows"/> 1558 

</GROUP_IN_FILTER> 1559 

<INACTIVITY_TTL TTL="0" USE_DEFAULT="true"/> 1560 

<ADMISSION_RESOLVE_DELAY TTL="0" USE_DEFAULT="true"/> 1561 

<MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1562 

<ADMISSION ALL="true"/> 1563 

</MATCH_TIMING> 1564 

https://docs.forescout.com/bundle/vmware-vsphere-2-5-h/page/vmware-vsphere-2-5-h.Configure-the-VMware-vSphere-Plugin.html
https://www.forescout.com/company/resources/professional-services-overview/
https://docs.forescout.com/bundle/dev-class-eng-1-3-x-h/page/dev-class-eng-1-3-x-h.Custom-Policies.html
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<EXPRESSION EXPR_TYPE="AND"> 1565 

<!-- Rule expression. Rule name is: Adobe Flash Player Removal --> 1566 

<EXPRESSION EXPR_TYPE="SIMPLE"> 1567 

<CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="process_no_ext" LABEL="Windows 1568 
Processes Running" LEFT_PARENTHESIS="0" LOGIC="AND" PLUGIN_NAME="HPS Inspection 1569 
Engine" PLUGIN_UNIQUE_NAME="va" PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="1570 
111020046" RET_VALUE_ON_UKNOWN="UNMATCH" RIGHT_PARENTHESIS="0"> 1571 

<FILTER CASE_SENSITIVE="false" FILTER_ID="-1572 
8737023325596837863" TYPE="contains"> 1573 

<VALUE VALUE2="Flash"/> 1574 

</FILTER> 1575 

</CONDITION> 1576 

</EXPRESSION> 1577 

<EXPRESSION EXPR_TYPE="SIMPLE"> 1578 

<CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="nbthost" LABEL="NetBIOS 1579 
Hostname" LEFT_PARENTHESIS="0" LOGIC="AND" PLUGIN_NAME="NBT 1580 
Scanner" PLUGIN_UNIQUE_NAME="nbtscan_plugin" PLUGIN_VESRION="3.2.1" PLUGIN_VESR1581 
ION_NUMBER="32010012" RET_VALUE_ON_UKNOWN="IRRESOLVED" RIGHT_PARENTHESIS="0"> 1582 

<FILTER CASE_SENSITIVE="false" FILTER_ID="-575936128989425039" TYPE="contains"> 1583 

<VALUE VALUE2="PEWKWINSVR02"/> 1584 

</FILTER> 1585 

</CONDITION> 1586 

</EXPRESSION> 1587 

</EXPRESSION> 1588 

<EXCEPTION NAME="ip" UNKNOWN_EVAL="UNMATCH"> 1589 

<RANGE FROM="10.131.5.2" TO="10.131.5.2"/> 1590 

<RANGE FROM="10.132.2.11" TO="10.132.2.11"/> 1591 

</EXCEPTION> 1592 

<EXCEPTION NAME="mac" UNKNOWN_EVAL="UNMATCH"/> 1593 

<EXCEPTION NAME="nbthost" UNKNOWN_EVAL="UNMATCH"/> 1594 

<EXCEPTION NAME="user" UNKNOWN_EVAL="UNMATCH"/> 1595 

<EXCEPTION NAME="group" UNKNOWN_EVAL="UNMATCH"/> 1596 

<ORIGIN NAME="CUSTOM"/> 1597 
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<UNMATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1598 

<ADMISSION ALL="true"/> 1599 

</UNMATCH_TIMING> 1600 

<SEGMENT ID="2960766429758300381" NAME="Endpoints"> 1601 

<RANGE FROM="10.132.6.0" TO="10.132.6.255"/> 1602 

<RANGE FROM="10.151.40.0" TO="10.151.40.255"/> 1603 

<RANGE FROM="192.168.1.0" TO="192.168.1.255"/> 1604 

</SEGMENT> 1605 

<RULE_CHAIN> 1606 

<INNER_RULE APP_VERSION="8.2.2-1607 
731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" CLASSIFICATION="REG_STATUS" DES1608 
CRIPTION="" ID="1600971908334654081" NAME="Runing 1609 
Flash" NOT_COND_UPDATE="true" RECHECK_MAIN_RULE_DEF="true"> 1610 

<MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1611 

<ADMISSION ALL="true"/> 1612 

</MATCH_TIMING> 1613 

<EXPRESSION EXPR_TYPE="SIMPLE"> 1614 

<!-- Rule expression. Rule name is: Runing Flash --> 1615 

<CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="process_no_ext" LABEL="Windows 1616 
Processes Running" LEFT_PARENTHESIS="0" LOGIC="AND" PLUGIN_NAME="HPS Inspection 1617 
Engine" PLUGIN_UNIQUE_NAME="va" PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="1618 
111020046" RET_VALUE_ON_UKNOWN="UNMATCH" RIGHT_PARENTHESIS="0"> 1619 

<FILTER CASE_SENSITIVE="false" FILTER_ID="2547115646639713943" TYPE="contains"> 1620 

<VALUE VALUE2="Flash"/> 1621 

</FILTER> 1622 

</CONDITION> 1623 

</EXPRESSION> 1624 

<ACTION DISABLED="false" NAME="add-to-group"> 1625 

<PARAM NAME="temporary" VALUE="true"/> 1626 

<PARAM NAME="group-name" VALUE="id:-6458612277141846421;name:Adobe Flash 1627 
Running"/> 1628 

<PARAM NAME="item_key" VALUE="mac_or_ip"/> 1629 

<PARAM NAME="comment" VALUE=""/> 1630 
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<SCHEDULE> 1631 

<START Class="Immediately"/> 1632 

<OCCURENCE onStart="true"/> 1633 

</SCHEDULE> 1634 

</ACTION> 1635 

</INNER_RULE> 1636 

<INNER_RULE APP_VERSION="8.2.2-1637 
731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" CLASSIFICATION="REG_STATUS" DES1638 
CRIPTION="Upload the uninstaller into the script repository and have it push to 1639 
the endpoint and execute it with the silent uninstall option? 1640 
https://fpdownload.macromedia.com/get/flashplayer/current/support/uninstall_fla1641 
sh_player.exe uninstall_flash_player.exe -uninstall Or to uninstall a specific 1642 
player type (ActiveX, NPAPI, or PPAPI), use the following: 1643 
uninstall_flash_player.exe -uninstall activex uninstall_flash_player.exe -1644 
uninstall plugin uninstall_flash_player.exe -uninstall pepperplugin" ID="-1645 
7555287754841043925" NAME="Uninstall Adobe 1646 
Flash" NOT_COND_UPDATE="true" RECHECK_MAIN_RULE_DEF="true"> 1647 

<MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1648 

<ADMISSION ALL="true"/> 1649 

</MATCH_TIMING> 1650 

<EXPRESSION EXPR_TYPE="SIMPLE"> 1651 

<!-- Rule expression. Rule name is: Uninstall Adobe Flash --> 1652 

<CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="process_no_ext" LABEL="Windows 1653 
Processes Running" LEFT_PARENTHESIS="0" LOGIC="AND" PLUGIN_NAME="HPS Inspection 1654 
Engine" PLUGIN_UNIQUE_NAME="va" PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="1655 
111020046" RET_VALUE_ON_UKNOWN="UNMATCH" RIGHT_PARENTHESIS="0"> 1656 

<FILTER CASE_SENSITIVE="false" FILTER_ID="2974243046085011295" TYPE="contains"> 1657 

<VALUE VALUE2="FLASH"/> 1658 

</FILTER> 1659 

</CONDITION> 1660 

</EXPRESSION> 1661 

<ACTION DISABLED="true" NAME="process_kill"> 1662 

<PARAM NAME="process_name" VALUE="flash"/> 1663 

<SCHEDULE> 1664 

<START Class="Immediately"/> 1665 

<OCCURENCE onStart="true"/> 1666 
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</SCHEDULE> 1667 

</ACTION> 1668 

<ACTION DISABLED="true" NAME="run_script"> 1669 

<PARAM NAME="script_howtorun_ac" VALUE="uninstall_flash_player.exe -1670 
uninstall"/> 1671 

<PARAM NAME="script_interactive" VALUE="false"/> 1672 

<PARAM NAME="define_time_to_run" VALUE="false"/> 1673 

<PARAM NAME="time_to_run" VALUE="1"/> 1674 

<SCHEDULE> 1675 

<START Class="Immediately"/> 1676 

<OCCURENCE onStart="true"/> 1677 

</SCHEDULE> 1678 

</ACTION> 1679 

</INNER_RULE> 1680 

</RULE_CHAIN> 1681 

<REPORT_TABLES/> 1682 

</RULE> 1683 

</RULES> 1684 

7.3.2 Java Removal Policy 1685 

The Java Removal policy checks if Java is running on a Windows Endpoint. If it is, this policy will 1686 
terminate the process running Java and uninstall Java by running a script on the endpoint. 1687 

<?xml version="1.0" encoding="UTF-8" standalone="no"?> 1688 

<RULES> 1689 

    <RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" 1690 
CLASSIFICATION="REG_STATUS" DESCRIPTION="&#10;&#10; &#10; &#10; " 1691 
ENABLED="true" ID="-1659136910494976646" NAME="Java Removal" 1692 
NOT_COND_UPDATE="true" UPGRADE_PERFORMED="true"> 1693 

        <GROUP_IN_FILTER> 1694 

            <GROUP ID="1391284960034120761" NAME="Windows"/> 1695 

        </GROUP_IN_FILTER> 1696 

        <INACTIVITY_TTL TTL="0" USE_DEFAULT="true"/> 1697 

        <ADMISSION_RESOLVE_DELAY TTL="0" USE_DEFAULT="true"/> 1698 
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        <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1699 

            <ADMISSION ALL="true"/> 1700 

        </MATCH_TIMING> 1701 

        <EXPRESSION EXPR_TYPE="AND"> 1702 

            <!--Rule expression. Rule name is: Java Removal--> 1703 

            <EXPRESSION EXPR_TYPE="SIMPLE"> 1704 

                <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="process_no_ext" 1705 
LABEL="Windows Processes Running" LEFT_PARENTHESIS="0" LOGIC="AND" 1706 
PLUGIN_NAME="HPS Inspection Engine" PLUGIN_UNIQUE_NAME="va" 1707 
PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="111020046" 1708 
RET_VALUE_ON_UKNOWN="UNMATCH" RIGHT_PARENTHESIS="0"> 1709 

                    <FILTER CASE_SENSITIVE="false" FILTER_ID="3470905276050252920" 1710 
TYPE="contains"> 1711 

                        <VALUE VALUE2="Java"/> 1712 

                    </FILTER> 1713 

                </CONDITION> 1714 

            </EXPRESSION> 1715 

            <EXPRESSION EXPR_TYPE="SIMPLE"> 1716 

                <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="nbthost" 1717 
LABEL="NetBIOS Hostname" LEFT_PARENTHESIS="0" LOGIC="AND" PLUGIN_NAME="NBT 1718 
Scanner" PLUGIN_UNIQUE_NAME="nbtscan_plugin" PLUGIN_VESRION="3.2.1" 1719 
PLUGIN_VESRION_NUMBER="32010012" RET_VALUE_ON_UKNOWN="IRRESOLVED" 1720 
RIGHT_PARENTHESIS="0"> 1721 

                    <FILTER CASE_SENSITIVE="false" FILTER_ID="-575936128989425039" 1722 
TYPE="contains"> 1723 

                        <VALUE VALUE2="PEWKWINSVR02"/> 1724 

                    </FILTER> 1725 

                </CONDITION> 1726 

            </EXPRESSION> 1727 

        </EXPRESSION> 1728 

        <EXCEPTION NAME="ip" UNKNOWN_EVAL="UNMATCH"> 1729 

            <RANGE FROM="10.131.5.2" TO="10.131.5.2"/> 1730 

            <RANGE FROM="10.132.2.11" TO="10.132.2.11"/> 1731 

        </EXCEPTION> 1732 
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        <EXCEPTION NAME="mac" UNKNOWN_EVAL="UNMATCH"/> 1733 

        <EXCEPTION NAME="nbthost" UNKNOWN_EVAL="UNMATCH"/> 1734 

        <EXCEPTION NAME="user" UNKNOWN_EVAL="UNMATCH"/> 1735 

        <EXCEPTION NAME="group" UNKNOWN_EVAL="UNMATCH"/> 1736 

        <ORIGIN NAME="CUSTOM"/> 1737 

        <UNMATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1738 

            <ADMISSION ALL="true"/> 1739 

        </UNMATCH_TIMING> 1740 

        <SEGMENT ID="2960766429758300381" NAME="Endpoints"> 1741 

            <RANGE FROM="10.132.6.0" TO="10.132.6.255"/> 1742 

            <RANGE FROM="10.151.40.0" TO="10.151.40.255"/> 1743 

            <RANGE FROM="192.168.1.0" TO="192.168.1.255"/> 1744 

        </SEGMENT> 1745 

        <RULE_CHAIN> 1746 

            <INNER_RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" 1747 
CACHE_TTL_SYNCED="true" CLASSIFICATION="REG_STATUS" DESCRIPTION="" ID="-1748 
7312022728321489321" NAME="Uninstall Java" NOT_COND_UPDATE="true" 1749 
RECHECK_MAIN_RULE_DEF="true"> 1750 

                <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1751 

                    <ADMISSION ALL="true"/> 1752 

                </MATCH_TIMING> 1753 

                <EXPRESSION EXPR_TYPE="SIMPLE"> 1754 

                    <!--Rule expression. Rule name is: Uninstall Java--> 1755 

                    <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="process_no_ext" 1756 
LABEL="Windows Processes Running" LEFT_PARENTHESIS="0" LOGIC="AND" 1757 
PLUGIN_NAME="HPS Inspection Engine" PLUGIN_UNIQUE_NAME="va" 1758 
PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="111020046" 1759 
RET_VALUE_ON_UKNOWN="UNMATCH" RIGHT_PARENTHESIS="0"> 1760 

                        <FILTER CASE_SENSITIVE="false" 1761 
FILTER_ID="8761976385823184780" TYPE="contains"> 1762 

                            <VALUE VALUE2="java"/> 1763 

                        </FILTER> 1764 

                    </CONDITION> 1765 

                </EXPRESSION> 1766 
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                <ACTION DISABLED="true" NAME="process_kill"> 1767 

                    <PARAM NAME="process_name" VALUE="java"/> 1768 

                    <SCHEDULE> 1769 

                        <START Class="Immediately"/> 1770 

                        <OCCURENCE onStart="true"/> 1771 

                    </SCHEDULE> 1772 

                </ACTION> 1773 

                <ACTION DISABLED="false" NAME="run_script"> 1774 

                    <PARAM NAME="script_howtorun_ac" VALUE="uninstall_java.ps1"/> 1775 

                    <PARAM NAME="script_interactive" VALUE="false"/> 1776 

                    <PARAM NAME="define_time_to_run" VALUE="false"/> 1777 

                    <PARAM NAME="time_to_run" VALUE="10"/> 1778 

                    <SCHEDULE> 1779 

                        <START Class="Immediately"/> 1780 

                        <OCCURENCE onStart="true"/> 1781 

                    </SCHEDULE> 1782 

                </ACTION> 1783 

            </INNER_RULE> 1784 

            <INNER_RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" 1785 
CACHE_TTL_SYNCED="true" CLASSIFICATION="REG_STATUS" DESCRIPTION="" ID="-1786 
8890693029182562272" NAME="Runing Java" NOT_COND_UPDATE="true" 1787 
RECHECK_MAIN_RULE_DEF="true"> 1788 

                <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1789 

                    <ADMISSION ALL="true"/> 1790 

                </MATCH_TIMING> 1791 

                <EXPRESSION EXPR_TYPE="SIMPLE"> 1792 

                    <!--Rule expression. Rule name is: Runing Java--> 1793 

                    <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="process_no_ext" 1794 
LABEL="Windows Processes Running" LEFT_PARENTHESIS="0" LOGIC="AND" 1795 
PLUGIN_NAME="HPS Inspection Engine" PLUGIN_UNIQUE_NAME="va" 1796 
PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="111020046" 1797 
RET_VALUE_ON_UKNOWN="UNMATCH" RIGHT_PARENTHESIS="0"> 1798 

                        <FILTER CASE_SENSITIVE="false" 1799 
FILTER_ID="3138188613733535094" TYPE="contains"> 1800 
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                            <VALUE VALUE2="Java"/> 1801 

                        </FILTER> 1802 

                    </CONDITION> 1803 

                </EXPRESSION> 1804 

                <ACTION DISABLED="false" NAME="add-to-group"> 1805 

                    <PARAM NAME="temporary" VALUE="true"/> 1806 

                    <PARAM NAME="group-name" VALUE="id:-1807 
3761570262828389651;name:Java Running"/> 1808 

                    <PARAM NAME="item_key" VALUE="mac_or_ip"/> 1809 

                    <PARAM NAME="comment" VALUE=""/> 1810 

                    <SCHEDULE> 1811 

                        <START Class="Immediately"/> 1812 

                        <OCCURENCE onStart="true"/> 1813 

                    </SCHEDULE> 1814 

                </ACTION> 1815 

            </INNER_RULE> 1816 

        </RULE_CHAIN> 1817 

        <REPORT_TABLES/> 1818 

    </RULE> 1819 

</RULES> 1820 

7.3.3 Critical Vulnerability Quarantine Policy 1821 

The Critical Vulnerability Quarantine policy utilizes the Tenable VM plugin to determine if an endpoint 1822 
has any known critical vulnerabilities. If it does, this policy uses Cisco ISE to quarantine the endpoint by 1823 
utilizing the pxGrid plugin. 1824 

<?xml version="1.0" encoding="UTF-8" standalone="no"?> 1825 

<RULES> 1826 

    <RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" 1827 
CLASSIFICATION="REG_STATUS" DESCRIPTION="" ENABLED="true" ID="-1828 
663948591345721440" META_TYPE="COMPLY" NAME="Forescout Critical Vulnerability 1829 
Quarantine" NOT_COND_UPDATE="true" UPGRADE_PERFORMED="true"> 1830 

        <GROUP_IN_FILTER/> 1831 

        <INACTIVITY_TTL TTL="0" USE_DEFAULT="true"/> 1832 
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        <ADMISSION_RESOLVE_DELAY TTL="0" USE_DEFAULT="true"/> 1833 

        <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1834 

            <ADMISSION ALL="true"/> 1835 

        </MATCH_TIMING> 1836 

        <EXPRESSION EXPR_TYPE="SIMPLE"> 1837 

            <!--Rule expression. Rule name is: Forescout Critical Vulnerability 1838 
Quarantine--> 1839 

            <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="nbthost" 1840 
LABEL="NetBIOS Hostname" LEFT_PARENTHESIS="0" LOGIC="AND" PLUGIN_NAME="NBT 1841 
Scanner" PLUGIN_UNIQUE_NAME="nbtscan_plugin" PLUGIN_VESRION="3.2.1" 1842 
PLUGIN_VESRION_NUMBER="32010012" RET_VALUE_ON_UKNOWN="IRRESOLVED" 1843 
RIGHT_PARENTHESIS="0"> 1844 

                <FILTER CASE_SENSITIVE="false" FILTER_ID="-847734611131793936" 1845 
TYPE="contains"> 1846 

                    <VALUE VALUE2="PEWKWINSVR02"/> 1847 

                </FILTER> 1848 

            </CONDITION> 1849 

        </EXPRESSION> 1850 

        <EXCEPTION NAME="ip" UNKNOWN_EVAL="UNMATCH"/> 1851 

        <EXCEPTION NAME="mac" UNKNOWN_EVAL="UNMATCH"/> 1852 

        <EXCEPTION NAME="nbthost" UNKNOWN_EVAL="UNMATCH"/> 1853 

        <EXCEPTION NAME="user" UNKNOWN_EVAL="UNMATCH"/> 1854 

        <EXCEPTION NAME="group" UNKNOWN_EVAL="UNMATCH"/> 1855 

        <ORIGIN NAME="CUSTOM"/> 1856 

        <UNMATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1857 

            <ADMISSION ALL="true"/> 1858 

        </UNMATCH_TIMING> 1859 

        <SEGMENT ID="2960766429758300381" NAME="Endpoints"> 1860 

            <RANGE FROM="10.132.6.0" TO="10.132.6.255"/> 1861 

            <RANGE FROM="10.151.40.0" TO="10.151.40.255"/> 1862 

            <RANGE FROM="192.168.1.0" TO="192.168.1.255"/> 1863 

        </SEGMENT> 1864 

        <RULE_CHAIN> 1865 
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            <INNER_RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" 1866 
CACHE_TTL_SYNCED="true" CLASSIFICATION="REG_STATUS" DESCRIPTION="" ID="-1867 
7308160423478365115" NAME="CriticalVuln  pxGrid Policy" NOT_COND_UPDATE="true" 1868 
RECHECK_MAIN_RULE_DEF="true"> 1869 

                <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1870 

                    <ADMISSION ALL="true"/> 1871 

                </MATCH_TIMING> 1872 

                <META_TYPE STATE="NA"/> 1873 

                <ACTION DISABLED="false" NAME="apply_anc_policy"> 1874 

                    <PARAM NAME="policy_name" VALUE="Forescout"/> 1875 

                    <SCHEDULE> 1876 

                        <START Class="Immediately"/> 1877 

                        <OCCURENCE onStart="true"/> 1878 

                    </SCHEDULE> 1879 

                </ACTION> 1880 

                <ACTION DISABLED="false" NAME="balloon_message"> 1881 

                    <PARAM NAME="msg" VALUE="You have been quarantined. Please 1882 
update your computer or contact the helpdesk for assistence."/> 1883 

                    <PARAM NAME="look" VALUE="info"/> 1884 

                    <SCHEDULE> 1885 

                        <START Class="Immediately"/> 1886 

                        <OCCURENCE onStart="true"/> 1887 

                    </SCHEDULE> 1888 

                </ACTION> 1889 

            </INNER_RULE> 1890 

        </RULE_CHAIN> 1891 

        <REPORT_TABLES/> 1892 

    </RULE> 1893 

</RULES> 1894 

7.3.4 Force Windows Update Policy 1895 

The Force Windows Update policy will force a Windows update on an endpoint with Windows Update 1896 
enabled by utilizing Forescout’s capability to determine if vulnerabilities exist on that endpoint. 1897 
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<?xml version="1.0" encoding="UTF-8" standalone="no"?> 1898 

<RULES> 1899 

    <RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" 1900 
CLASSIFICATION="REG_STATUS" DESCRIPTION="&#10;&#10; &#10; &#10; " 1901 
ENABLED="true" ID="8956849743087666010" NAME="Force Windows Update" 1902 
NOT_COND_UPDATE="true" UPGRADE_PERFORMED="true"> 1903 

        <GROUP_IN_FILTER/> 1904 

        <INACTIVITY_TTL TTL="0" USE_DEFAULT="true"/> 1905 

        <ADMISSION_RESOLVE_DELAY TTL="0" USE_DEFAULT="true"/> 1906 

        <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1907 

            <ADMISSION ALL="true"/> 1908 

        </MATCH_TIMING> 1909 

        <EXPRESSION EXPR_TYPE="SIMPLE"> 1910 

            <!--Rule expression. Rule name is: Force Windows Update--> 1911 

            <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="vulns" 1912 
LABEL="Microsoft Vulnerabilities" LEFT_PARENTHESIS="0" LOGIC="AND" 1913 
PLUGIN_NAME="HPS Inspection Engine" PLUGIN_UNIQUE_NAME="va" 1914 
PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="111020046" 1915 
RET_VALUE_ON_UKNOWN="IRRESOLVED" RIGHT_PARENTHESIS="0"> 1916 

                <FILTER AUTO_UPDATE="true" FILTER_ID="-32838886002658939" 1917 
OPTIONS_DIGEST="b3eaa0cf6df1fc550859e51703f2665a"> 1918 

                    <OPT VALUE="KB890830-141"/> 1919 

                    <OPT VALUE="KB890830-139"/> 1920 

                    <OPT VALUE="KB890830-144"/> 1921 

                    <OPT VALUE="KB890830-138"/> 1922 

                    <OPT VALUE="KB890830-143"/> 1923 

                    <OPT VALUE="KB890830-140"/> 1924 

                    <OPT VALUE="KB890830-148"/> 1925 

                    <OPT VALUE="KB890830-145"/> 1926 

                    <OPT VALUE="KB890830-136"/> 1927 

                    <OPT VALUE="KB890830-151"/> 1928 

                    <OPT VALUE="KB890830-146"/> 1929 

                    <OPT VALUE="KB890830-142"/> 1930 

                    <OPT VALUE="KB890830-147"/> 1931 
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                    <OPT VALUE="KB890830-31"/> 1932 

                    <OPT VALUE="KB890830-137"/> 1933 

                    <OPT VALUE="KB890830-150"/> 1934 

                    <OPT VALUE="KB890830-149"/> 1935 

                </FILTER> 1936 

            </CONDITION> 1937 

        </EXPRESSION> 1938 

        <ACTION DISABLED="false" NAME="remediate_wua"> 1939 

            <PARAM NAME="update_type" VALUE="keep_update_settings"/> 1940 

            <PARAM NAME="wsus_target_group" VALUE=""/> 1941 

            <PARAM NAME="automatic_updates_type" VALUE="keep_update_settings"/> 1942 

            <PARAM NAME="use_default_if_disabled" VALUE="false"/> 1943 

            <SCHEDULE> 1944 

                <START Class="Immediately"/> 1945 

                <OCCURENCE onStart="true"/> 1946 

            </SCHEDULE> 1947 

        </ACTION> 1948 

        <EXCEPTION NAME="ip" UNKNOWN_EVAL="UNMATCH"> 1949 

            <RANGE FROM="10.131.5.2" TO="10.131.5.2"/> 1950 

            <RANGE FROM="10.132.2.11" TO="10.132.2.11"/> 1951 

        </EXCEPTION> 1952 

        <EXCEPTION NAME="mac" UNKNOWN_EVAL="UNMATCH"/> 1953 

        <EXCEPTION NAME="nbthost" UNKNOWN_EVAL="UNMATCH"/> 1954 

        <EXCEPTION NAME="user" UNKNOWN_EVAL="UNMATCH"/> 1955 

        <EXCEPTION NAME="group" UNKNOWN_EVAL="UNMATCH"/> 1956 

        <ORIGIN NAME="CUSTOM"/> 1957 

        <UNMATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1958 

            <ADMISSION ALL="true"/> 1959 

        </UNMATCH_TIMING> 1960 

        <SEGMENT ID="2960766429758300381" NAME="Endpoints"> 1961 
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            <RANGE FROM="10.132.6.0" TO="10.132.6.255"/> 1962 

            <RANGE FROM="10.151.40.0" TO="10.151.40.255"/> 1963 

            <RANGE FROM="192.168.1.0" TO="192.168.1.255"/> 1964 

        </SEGMENT> 1965 

        <RULE_CHAIN/> 1966 

        <REPORT_TABLES/> 1967 

    </RULE> 1968 

</RULES> 1969 

7.3.5 Agent Compliance Check Policy 1970 

The Agent Compliance Check policy will determine if a Windows endpoint has the Microsoft Endpoint 1971 
Configuration Manager agent installed by seeing if the endpoint has checked in with Endpoint 1972 
Configuration Manager.  1973 

<?xml version="1.0" encoding="UTF-8" standalone="no"?> 1974 

<RULES> 1975 

    <RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" 1976 
CLASSIFICATION="REG_STATUS" DESCRIPTION="" ENABLED="true" ID="-1977 
329523829728915879" NAME="SCCM Agent Compliance" NOT_COND_UPDATE="true" 1978 
UPGRADE_PERFORMED="true"> 1979 

        <GROUP_IN_FILTER> 1980 

            <GROUP ID="1391284960034120761" NAME="Windows"/> 1981 

        </GROUP_IN_FILTER> 1982 

        <INACTIVITY_TTL TTL="0" USE_DEFAULT="true"/> 1983 

        <ADMISSION_RESOLVE_DELAY TTL="0" USE_DEFAULT="true"/> 1984 

        <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 1985 

            <ADMISSION ALL="true"/> 1986 

        </MATCH_TIMING> 1987 

        <EXPRESSION EXPR_TYPE="SIMPLE"> 1988 

            <!--Rule expression. Rule name is: SCCM Agent Compliance--> 1989 

            <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="Client_registered" 1990 
LABEL="SMS/SCCM  Client Registration Status" LEFT_PARENTHESIS="0" LOGIC="AND" 1991 
PLUGIN_NAME="Microsoft SMS/SCCM" PLUGIN_UNIQUE_NAME="sms" 1992 
PLUGIN_VESRION="2.4.4" PLUGIN_VESRION_NUMBER="24040014" 1993 
RET_VALUE_ON_UKNOWN="IRRESOLVED" RIGHT_PARENTHESIS="0"> 1994 
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                <FILTER AUTO_UPDATE="false" FILTER_ID="8830579494271797354" 1995 
OPTIONS_DIGEST="93e42278ee53b84f8427494bd2a235c6"> 1996 

                    <OPT VALUE="db_found_true"/> 1997 

                </FILTER> 1998 

            </CONDITION> 1999 

        </EXPRESSION> 2000 

        <ACTION DISABLED="false" NAME="add-to-group"> 2001 

            <PARAM NAME="temporary" VALUE="true"/> 2002 

            <PARAM NAME="group-name" VALUE="id:8255406739413382154;name:SCCM 2003 
Client Registered"/> 2004 

            <PARAM NAME="item_key" VALUE="mac_or_ip"/> 2005 

            <PARAM NAME="comment" VALUE=""/> 2006 

            <SCHEDULE> 2007 

                <START Class="Immediately"/> 2008 

                <OCCURENCE onStart="true"/> 2009 

            </SCHEDULE> 2010 

        </ACTION> 2011 

        <EXCEPTION NAME="ip" UNKNOWN_EVAL="UNMATCH"/> 2012 

        <EXCEPTION NAME="mac" UNKNOWN_EVAL="UNMATCH"/> 2013 

        <EXCEPTION NAME="nbthost" UNKNOWN_EVAL="UNMATCH"/> 2014 

        <EXCEPTION NAME="user" UNKNOWN_EVAL="UNMATCH"/> 2015 

        <EXCEPTION NAME="group" UNKNOWN_EVAL="UNMATCH"/> 2016 

        <ORIGIN NAME="CUSTOM"/> 2017 

        <UNMATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 2018 

            <ADMISSION ALL="true"/> 2019 

        </UNMATCH_TIMING> 2020 

        <SEGMENT ID="2960766429758300381" NAME="Endpoints"> 2021 

            <RANGE FROM="10.132.6.0" TO="10.132.6.255"/> 2022 

            <RANGE FROM="10.151.40.0" TO="10.151.40.255"/> 2023 

            <RANGE FROM="192.168.1.0" TO="192.168.1.255"/> 2024 

        </SEGMENT> 2025 
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        <RULE_CHAIN/> 2026 

        <REPORT_TABLES/> 2027 

    </RULE> 2028 

</RULES>  2029 

7.3.6 SCCM Agent Non Compliant Check Policy 2030 

The SCCM Agent Non Compliant Check policy will determine if a Windows endpoint is non-compliant by 2031 
seeing if the endpoint has or has not checked into Microsoft Endpoint Configuration Manager. 2032 

<?xml version="1.0" encoding="UTF-8" standalone="no"?> 2033 

<RULES> 2034 

    <RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200" CACHE_TTL_SYNCED="true" 2035 
CLASSIFICATION="REG_STATUS" DESCRIPTION="" ENABLED="true" 2036 
ID="6927087801731630440" NAME="SCCM Agent Non Compliant Check" 2037 
NOT_COND_UPDATE="true" UPGRADE_PERFORMED="true"> 2038 

        <GROUP_IN_FILTER/> 2039 

        <INACTIVITY_TTL TTL="0" USE_DEFAULT="true"/> 2040 

        <ADMISSION_RESOLVE_DELAY TTL="0" USE_DEFAULT="true"/> 2041 

        <MATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 2042 

            <ADMISSION ALL="true"/> 2043 

        </MATCH_TIMING> 2044 

        <EXPRESSION EXPR_TYPE="SIMPLE"> 2045 

            <!--Rule expression. Rule name is: SCCM Agent Non Compliant Check--> 2046 

            <CONDITION EMPTY_LIST_VALUE="false" FIELD_NAME="Client_registered" 2047 
LABEL="SMS/SCCM  Client Registration Status" LEFT_PARENTHESIS="0" LOGIC="AND" 2048 
PLUGIN_NAME="Microsoft SMS/SCCM" PLUGIN_UNIQUE_NAME="sms" 2049 
PLUGIN_VESRION="2.4.4" PLUGIN_VESRION_NUMBER="24040014" 2050 
RET_VALUE_ON_UKNOWN="IRRESOLVED" RIGHT_PARENTHESIS="0"> 2051 

                <FILTER AUTO_UPDATE="false" FILTER_ID="-9113011034532548035" 2052 
OPTIONS_DIGEST="93e42278ee53b84f8427494bd2a235c6"> 2053 

                    <OPT VALUE="db_found_false"/> 2054 

                </FILTER> 2055 

            </CONDITION> 2056 

        </EXPRESSION> 2057 

        <ACTION DISABLED="false" NAME="add-to-group"> 2058 
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            <PARAM NAME="temporary" VALUE="true"/> 2059 

            <PARAM NAME="group-name" VALUE="id:6514702438169432101;name:SCCM 2060 
Missing Agent"/> 2061 

            <PARAM NAME="item_key" VALUE="mac_or_ip"/> 2062 

            <PARAM NAME="comment" VALUE=""/> 2063 

            <SCHEDULE> 2064 

                <START Class="Immediately"/> 2065 

                <OCCURENCE onStart="true"/> 2066 

            </SCHEDULE> 2067 

        </ACTION> 2068 

        <EXCEPTION NAME="ip" UNKNOWN_EVAL="UNMATCH"/> 2069 

        <EXCEPTION NAME="mac" UNKNOWN_EVAL="UNMATCH"/> 2070 

        <EXCEPTION NAME="nbthost" UNKNOWN_EVAL="UNMATCH"/> 2071 

        <EXCEPTION NAME="user" UNKNOWN_EVAL="UNMATCH"/> 2072 

        <EXCEPTION NAME="group" UNKNOWN_EVAL="UNMATCH"/> 2073 

        <ORIGIN NAME="CUSTOM"/> 2074 

        <UNMATCH_TIMING RATE="28800" SKIP_INACTIVE="true"> 2075 

            <ADMISSION ALL="true"/> 2076 

        </UNMATCH_TIMING> 2077 

        <SEGMENT ID="2960766429758300381" NAME="Endpoints"> 2078 

            <RANGE FROM="10.132.6.0" TO="10.132.6.255"/> 2079 

            <RANGE FROM="10.151.40.0" TO="10.151.40.255"/> 2080 

            <RANGE FROM="192.168.1.0" TO="192.168.1.255"/> 2081 

        </SEGMENT> 2082 

        <RULE_CHAIN/> 2083 

        <REPORT_TABLES/> 2084 

    </RULE> 2085 

</RULES> 2086 
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7.4 Forescout Maintenance 2087 

Forescout releases suggested updates and plugins in the Forescout Console and through its ActiveCare 2088 
Maintenance and Support policy. 2089 

8 IBM 2090 

We used two cloud-based IBM offerings for this build. One, IBM MaaS360 with Watson, was used for 2091 
endpoint management for desktop and laptop computers in the first phase, and for Android and iOS 2092 
mobile devices in the second phase. The second offering, the IBM Code Risk Analyzer, was used during 2093 
the second phase to scan source code in cloud-based containers for vulnerabilities. This section shows 2094 
how each cloud-based service was configured and used for the build. 2095 

8.1 IBM Code Risk Analyzer 2096 

The IBM Code Risk Analyzer, a feature of IBM Cloud Continuous Delivery for DevSecOps application 2097 
architectures, enables developers to quickly assess and remediate security and legal risks that they are 2098 
potentially introducing into source code and provides them direct actionable feedback. It works with 2099 
code repositories such as Git to analyze your application, perform a set of compliance control checks, 2100 
produce a bill of materials, and report vulnerability findings. Code Risk Analyzer is provided as a set of 2101 
Tekton tasks, which can be easily incorporated into delivery pipelines. Also, it is available as a managed 2102 
service on IBM Cloud, which eliminates the need to host your own infrastructure to run these delivery 2103 
pipelines. This section illustrates how we configured Code Risk Analyzer on IBM Cloud to embed and use 2104 
in development workflows.  2105 

8.1.1 Getting Ready  2106 

No software installation is required to use Code Risk Analyzer on IBM Cloud. However, make sure you 2107 
have an active IBM Cloud account.  2108 

All the Tekton pipeline definitions for Code Risk Analyzer are open-sourced and publicly available. 2109 

We used this sample cloud native micro-service application to demonstrate the configuration and 2110 
analysis via a delivery pipeline. You need to fork this application under your authorized account for the 2111 
code repository. If you have any other micro-service application, you can use that as well. Make sure 2112 
you have WRITE access to the code repository that you plan to use. 2113 

8.1.2 Creating Your Toolchain 2114 

Follow these steps to create and populate your toolchain: 2115 

1. Login to your IBM Cloud account and from the service catalog on the left, select DevOps. This 2116 
will open the dashboard for Toolchains.  2117 

https://www.forescout.com/company/legal/activecare-maintenance-and-support-policy/
https://www.forescout.com/company/legal/activecare-maintenance-and-support-policy/
https://www.ibm.com/cloud/continuous-delivery
https://github.com/open-toolchain/tekton-catalog
https://github.com/nadgowdas/hello-containers
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2. Select Create toolchain > Build your own toolchain. Give a name to your toolchain and click 2118 
Create. 2119 

3. Once the toolchain is created, it needs to be populated with developer tools. Click the Add tool 2120 
button to add the following tools to the toolchain: 2121 

a. Github (code repository for Code Risk Analyzer Tekton definition): configure it as shown 2122 
below. Note: For a first-time user, it will ask you to authorize IBM Cloud to access your 2123 
code repository account. This one-time authorization is necessary. 2124 

 2125 

b. Github (code repository for our sample application): perform a similar integration as 2126 
above for your application repository. 2127 

c. DevOps Insights (required for authorization and integration): no configuration is 2128 
necessary, but make sure it is added to your Toolchain workspace. 2129 

d. Delivery Pipeline (automation engine for our pipeline): first give it a Name and select 2130 
“Tekton” as the Pipeline Type. The next section contains more detailed information on 2131 
pipeline configuration.  2132 

4. At this point, your toolchain workspace should have the tools depicted below. 2133 
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 2134 

8.1.3 Configuring Delivery Pipeline 2135 

The core logic of configuring Code Risk Analyzer is in the Delivery Pipeline. We need to perform four 2136 
sections of configuration:  2137 

1. Definition is where we specify the source for our Code Risk Analyzer pipeline definitions. To do 2138 
so, click Add multiple times to add the following list of locations for sources. When done, click 2139 
Save. 2140 
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 2141 

2. Worker allows us to select the cluster where the pipeline should execute. We used a managed 2142 
Kubernetes worker on IBM Cloud to run our pipeline. To do so, select IBM Managed workers 2143 
from the dropdown list. 2144 

3. Trigger allows us to specify “when” or on which events we want to execute a Code Risk Analyzer 2145 
scan on a code repository. To configure this, select our sample application code repository, then 2146 
enable the option to run when a pull request is opened or updated. 2147 
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 2148 

4. Environment Properties allows you to store name-value pairs for use in your pipeline. For this 2149 
build, specify a Secure value type named apikey with the API_KEY for your IBM Cloud account. 2150 
You can create a new API_KEY with Manage > Access (IAM) -> API Keys.  2151 

At this point, your pipeline is successfully created and configured to be executed. As per our trigger 2152 
configuration, it will be automatically executed on any “Pull Request” on our application repository.  2153 

8.1.4 Executing the Developer Workflow 2154 

To demonstrate the developer workflow execution, perform the following steps: 2155 

1. Switch to the application repository.  2156 

2. Make some code change and create a pull request against the “main” branch. This should 2157 
automatically trigger our Code Risk Analyzer pipeline on IBM Cloud. You can view the status of 2158 
our pipeline execution in our configured pipeline. 2159 

https://github.com/nadgowdas/hello-containers
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 2160 

3. Once all these pipeline tasks finish, they emit their findings as git-comments to your original pull 2161 
request.  2162 

8.1.5 Reviewing the Code Risk Analyzer Results 2163 

After successful execution of our pipeline, you can find the following updates in your pull requests: 2164 

 Deployment Configuration Analysis. If there are any Kubernetes deployment manifests 2165 
(*.yaml) in the code repository, they are scanned against Docker CIS Benchmarks to identify 2166 
any failures to follow best practices.  2167 

 Vulnerability Report. The Code Risk Analyzer allows you to discover vulnerabilities in your 2168 
application (Python, Node.js, Java, golang) and OS stack (base image) based on rich threat 2169 
intelligence from Snyk. It also provides fix recommendations, as the example below illustrates.  2170 
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 2171 

 Bill of Materials. The Code Risk Analyzer generates a Bill of Materials (BoM) accounting for all 2172 
the dependencies and their sources for your application. The BoM is produced in JSON format. 2173 
The image below shows a portion of a BoM example.  2174 
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 2175 

 Git Status. In addition to git comments describing the security findings, Code Risk Analyzer also 2176 
assigns Pass/Fail status to the pull request. This allows the application owner to enforce policy-2177 
based gates to automatically block code changes with security failures.  2178 

 Terraform Scan. Terraform is frequently used to define and configure cloud-based 2179 
infrastructure for proper application deployment. The Code Risk Analyzer also scans any 2180 
terraform provider files to detect compliance issues before actual deployment. Examples of 2181 
compliance checks include requirements for the minimum strength of passwords, and identity 2182 
and access management (IAM) requirements for users and services. Code Risk Analyzer 2183 
supports the configuration of a profile for terraform scans; this enables choosing rule 2184 
parameters and which rules to run. An embedded JSON file in the git repo can contain the 2185 
following properties, which are also illustrated in the screenshot below:  2186 

https://github.com/open-toolchain/tekton-catalog/blob/master/cra/README.md#cra-terraform-scan
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• “scc_goals” - SCC goals to evaluate by goal ID 2187 

• “scc_goal_parameters” - Parameter values for configurable SCC goals 2188 

 2189 

8.2 IBM MaaS360 with Watson Phase 1 2190 

IBM MaaS360 with Watson is a cloud-based platform that enterprises can utilize for enterprise mobile 2191 
device management (MDM) and desktop/laptop management. MaaS360 allows users to enroll 2192 
organization-owned and personal devices. Administrators can send enrollment requests to users, 2193 
centrally manage security policies, wipe corporate data, and push apps to devices. IBM MaaS360 is 2194 
operated using an online portal. The platform system requirements for IBM MaaS360 components like 2195 
client device OSs and web browsers are listed here. 2196 

Our build used this service for asset identification and assessment, routine patching and emergency 2197 
patching, emergency workarounds, and isolation of assets that cannot be patched. For the first phase of 2198 
our build, our managed devices were a MacBook Pro and a Windows 10 virtual desktop. For the second 2199 
phase of this project, Android and iOS mobile devices were managed. 2200 

MaaS360 provides a Quick Start guide for customers when logging in for the first time. The guide helps 2201 
with setting up device enrollment, establishing security policies, configuring corporate email, and 2202 
enrolling devices. For this lab, a corporate identifier was set up, as well as an internal AD (lab.nccoe.org), 2203 
as the default identification mode. The corporate identifier allows users to enroll their devices in 2204 
MaaS360. More information on configuration can be found here. 2205 

8.2.1 Enrolling Devices 2206 

IBM MaaS360 supports traditional endpoints running Windows 10 and up, as well as macOS endpoints. 2207 
Device enrollment is critical in helping enterprises register devices and apply device management 2208 
policies that are specific to their organization. The IBM MaaS360 Portal handles all enrollment settings 2209 
for devices, apps, and users. 2210 

The device enrollment process is as follows:  2211 

1. Select SETUP, then choose Settings. 2212 

https://www.ibm.com/docs/en/maas360?topic=saas-maas360-platform-system-requirements
https://www.ibm.com/docs/en/maas360?topic=SS8H2S/com.ibm.mc.doc/pag_source/concepts/quick_start_first_time_configuration.htm
https://www.ibm.com/docs/en/maas360?topic=portal-configuring-device-enrollment-settings-in-maas360
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2. Click Device Enrollment Settings and set the corporate identifier that users will utilize to enroll 2213 
devices. It will also be shown in the enrollment URLs. In our lab, we set the identifier to 2214 
“nccoelab”. Additional device enrollment settings can be found here. 2215 

3. Open a web browser and proceed to the MaaS360 enrollment URL. 2216 

4. Enter your credentials. 2217 

5. Review and accept the terms and conditions. 2218 

6. Install the MDM profile.  2219 

Figure 8-1 provides a sample of enrolled devices utilized in this lab.  2220 

Figure 8-1 Sample of Enrolled Devices 2221 

 

See the linked pages for detailed enrollment instructions, including bulk enrollment, for macOS devices 2222 
and Windows devices. 2223 

8.2.2 Cloud Extender Installation 2224 

The IBM MaaS360 Cloud Extender allows enterprises to integrate mobile devices with corporate on-2225 
premises and cloud-based resources. The Cloud Extender is installed on a Microsoft Windows server 2226 
behind the firewall to allow users and devices to use internal resources like directory services, file 2227 
shares, email, and applications.  2228 

In this lab, the Cloud Extender was installed on the AD server to allow users to log in with AD accounts. 2229 
The Maas360 portal provided links to the Cloud Extender software download, installation, and license 2230 
key generation; they were available on the SETUP menu under Enterprise Gateway, as Figure 8-2 shows. 2231 
The same line also pointed to a scaling tool that can aid administrators in calculating the number of 2232 
Cloud Extenders needed.  2233 

More information about the requirements and instructions on installing the Cloud Extender can be 2234 
found here. 2235 

https://www.ibm.com/docs/en/maas360?topic=portal-configuring-device-enrollment-settings-in-maas360
https://www.ibm.com/docs/en/maas360?topic=macos
https://www.ibm.com/docs/en/maas360?topic=windows
https://www.ibm.com/docs/en/maas360?topic=extender-scaling-cloud
https://www.ibm.com/docs/en/maas360?topic=extender-minimum-requirements-cloud
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Figure 8-2 IBM Maas360 Cloud Extender Download 2236 

 

8.2.3 App Catalog and Distribution 2237 

This lab build sought to demonstrate how a tool like MaaS360 could be helpful in allowing 2238 
administrators to more easily distribute applications required for business operations to users. MaaS360 2239 
provides the ability to push applications to users by allowing administrators to build a customizable app 2240 
catalog. An app catalog makes it easier to distribute custom apps created by the organization. Also, 2241 
multiple versions of the same app can be pre-released to specific groups as a test before a full 2242 
deployment.  2243 

Lastly, the app catalog allows for the remote distribution, installation, uninstallation, updating, and 2244 
configuring of applications. The ability to remotely control apps is an important step in managing 2245 
updates and security for an enterprise’s patch management process. In MaaS360, applications must be 2246 
added to the app catalog before they can be deployed to devices. The following outlines the steps:  2247 

1. From the Maas360 Portal’s APPS menu, select Catalog. 2248 

2. The image below is a sample App Catalog page from this project’s build. To add an application, 2249 
click Add. 2250 

 2251 

3. Next, select the kind of app that will be added. For this example, Windows Store App is 2252 
selected. 2253 
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 2254 

4. Enter the desired app in the App field (for example, Slack) and select Add to complete the 2255 
process. 2256 

To distribute an app after it is added to the app catalog, select it from the App Catalog list, then click 2257 
Distribute. 2258 

Additional information on the app catalog and app installation can be found here. 2259 

8.2.4 Deploying Patches 2260 

This build utilized the capability of MaaS360 to provide alerts about required patches and take action to 2261 
remedy the issues. MaaS360 listed alerts on a dashboard on the Home Page, as illustrated in Figure 8-3. 2262 
The first half of the page utilizes colored tiles to demonstrate items in compliance (green) and those that 2263 
need attention (red). The information listed on these tiles can be customized. Below the security alert 2264 
tiles, there is a My Advisor with Watson section. Watson is an artificial intelligence tool developed by 2265 
IBM that scans the internet and other resources for the most recent trends in malware. It then lists any 2266 
threats found that are linked to devices that are enrolled in MaaS360. Additional information about the 2267 
MaaS360 Portal Home Page is listed here. 2268 

https://www.ibm.com/docs/en/maas360?topic=apps-maas360-app-catalog-overview
https://www.ibm.com/docs/en/maas360?topic=guide-maas360-portal-home-page
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Figure 8-3 MaaS360 Portal Home Page 2269 

 

MaaS360 allows administrators to apply and distribute patches to a single device or multiple devices. 2270 
The patches page for Windows and macOS devices lists the patches that are missing from devices. 2271 
Administrators are also able to see current patching schedules. For example, these steps were followed 2272 
in the lab to use MaaS360 to schedule deployment of patches: 2273 

1. Select SECURITY, then click OS Patches (Windows). 2274 

2. Select the Windows machines to be patched, then click Distribute to apply the patches. 2275 

 

The options shown in Table 8-1 were utilized to schedule automated patching. 2276 
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Table 8-1 Values Specified for Scheduling Automated Patching 2277 

Distribution Setting Value Explanation 

Distribute to Devices Missing 
Patches 

Choose which device(s) to apply patching to. Select 
from Single Device, Device Groups, or All Devices. 

Start Date 12/04/2021 This field sets the date that the remediation step 
will happen. This field was set to a future date so 
that patches would be scheduled for deployment. 

Start Time (0-23 Hrs) 01 This establishes the time of day that distribution 
will start for selected devices. 

Distribute Over (0-24 Hrs) 15 This causes patching to be staggered to reduce 
network load by making updates available over a 
set amount of time, in this case 15 hours, instead of 
instantaneous availability for all users. 

Action Expiry (in days) 7 The action will automatically expire after seven 
days. 

 

To distribute patches out of schedule for emergency remediation needs, the following options were 2278 
utilized: 2279 

 Start Date: The current date was chosen 2280 

 Start Time (0-23 Hrs): Immediate (causes the patch to be deployed immediately) 2281 

 Distribute Over (0-24 Hrs): Immediate 2282 

 Action Expiry (in days): 7 2283 

 2284 
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More information about patch management with IBM MaaS360 is available here.  2285 

8.2.5 MaaS360 Maintenance 2286 

MaaS360 is a SaaS offering, so updates are continuously pushed out by IBM, who maintains the 2287 
platform. 2288 

8.3 IBM MaaS360 with Watson Phase 2 2289 

This section goes over phase 2 deployment of the lab instance utilizing MaaS360. The phase 2 build 2290 
utilized MaaS360 to administer Google Android and Apple iOS devices. 2291 

8.3.1 Enrolling Mobile Devices 2292 

In our build we enrolled mobile devices in both a supervised state (or corporate owned) and a BYOD 2293 
method. Corporate owned or supervised status means that organizations have full control over the 2294 
device, as opposed to BYOD where organizations only have control over the work applications on the 2295 
device. The following is an overview of how to enroll an iOS device in a supervised state using the Apple 2296 
configurator: 2297 

1. Select Devices > Enrollments > Other Enrollment Options and select Apple Configurator from 2298 
the dropdown menu. 2299 

2. Select the Non-DEP only Enrollment URL (Note: DEP stands for Device Enrollment Program), and 2300 
copy the URL from the With Authentication tab. 2301 

3. Connect the Apple iPhone or iPad device to a MacBook and start the Apple Configurator. 2302 

4. Follow the wizard through specifying the MDM Server URL and certificates, and assigning the 2303 
device to an organization. 2304 

For more information on enrolling iOS devices in MaaS360 using Apple Configurator, review the 2305 
following page. 2306 

The lab instance enrolled Android devices manually using a QR code during device setup. The following 2307 
steps provide an overview for how to do this: 2308 

1. Click on Devices > Enrollments > Other Enrollment Options > Android Enterprise QR Code 2309 
Provisioning. 2310 

2. Enter the requested information into the form that appears. Of note is the Android Enterprise 2311 
Mode options for Android Enterprise mode. The Device Owner option allows an organization to 2312 
have complete control over the device, while Work Profile on Corporate Owned allows 2313 
organizations to only manage apps under the work profile of the device. 2314 

https://www.ibm.com/docs/en/maas360?topic=devices-patch-management
https://www.ibm.com/docs/en/maas360?topic=ac-enrolling-non-dep-ios-11-devices-using-authentication
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3. During initial setup of the mobile device, tap the screen six times and then scan the QR code 2315 
displayed in the MaaS360 portal. 2316 

For more information on enrolling devices using a QR code, follow the information on this page. 2317 

While the lab instance utilized manual processes to enroll devices, MaaS360 also supports bulk 2318 
enrollment of Apple and Google devices. For information, consult the following links: 2319 

 Bulk Enrolling Android devices using Android Zero Touch enrollment 2320 

 Bulk Enrolling Apple devices using Apple Device Enrollment Program 2321 

8.3.2 Device Inventory 2322 

The Devices > Inventory tab lists all the devices that have been enrolled into MaaS360. The patching 2323 
instance utilized this tab to perform firmware and software discovery capabilities. 2324 

The firmware of enrolled devices is displayed directly on the device inventory list. The Operating System 2325 
field shows the detected OS on the device. Figure 8-4 shows the connected devices in the patching 2326 
instance with the OSes that were detected. 2327 

Figure 8-4 Example of Enrolled Device Inventory 2328 

 

More detailed information regarding the installed OS and hardware information can be found under 2329 
View > Device Summary > Hardware & OS. 2330 

The installed applications on enrolled devices can be found by going to Device Inventory > View > Apps 2331 
Installed. The Apps Installed list shows all installed applications on a device. Figure 8-5 gives an example 2332 
of installed applications on a device. The list allows user-installed applications to be uninstalled by 2333 
administrators. 2334 

https://www.ibm.com/docs/en/maas360?topic=mode-android-enterprise-qr-code-enrollment
https://www.ibm.com/docs/en/maas360?topic=mode-zero-touch-enrollment
https://www.ibm.com/docs/en/maas360?topic=devices-apple-dep-configuration-guide
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Figure 8-5 Example of Installed Apps on a Mobile Device 2335 

 

For more information regarding the device inventory page, please consult the following page.  2336 

 2337 

https://www.ibm.com/docs/en/maas360?topic=devices-managing-in-maas360-device-inventory
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8.3.3 Device Policies 2338 

The Security > Policies section of MaaS360 allows security policies and settings to be applied to devices 2339 
to make sure they comply with organizational policies. The lab instance utilized policies to ensure that 2340 
the Android devices had the MaaS360 and Lookout for Work applications, as well as to perform 2341 
automatic OS updates. Policies for Apple were configured to require the MaaS360 and Lookout for Work 2342 
applications. 2343 

To configure the Android Default Policy to support required apps and automatic updates, perform the 2344 
following steps: 2345 

1. Click Security > Policies. 2346 

2. Under Default Android MDM Policy, click View. 2347 

3. Under the Android Enterprise Settings field, click App Compliance. 2348 

4. Click the Edit button. 2349 

5. Select Configure Required Apps. 2350 

6. Under Application Name, type the following: 2351 

app:com.fiberlink.maas360.android.control 2352 

app:com.lookout.enterprise 2353 

7. Click on Android Enterprise Settings > System Update Settings. 2354 

8. Click the check box for Configure System Update Settings and fill out the information as shown 2355 
in the screenshot below. 2356 
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 2357 

To configure a default Apple policy to require the installation of MaaS360 and Lookout for Work, 2358 
perform the following steps: 2359 

1. Click Security > Policies. 2360 

2. Click on the Default iOS MDM Policy. 2361 

3. Under Device Settings, click on Application Compliance. 2362 

4. Click Edit and check the Configured Required Applications check box. 2363 

5. Under the application names, add Lookout for Work and IBM MaaS360. Note that typing in the 2364 
Application Name field will cause MaaS360 to search for the application. Click the application 2365 
when it appears in the search field. 2366 
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 2367 

6. Click the Save And Publish button. 2368 

8.3.4 Alerts 2369 

MaaS360 can alert via the My Alert Center dashboard on the home page. The My Alert Center 2370 
dashboard can have custom alerts added. The lab instance used this capability to alert administrators 2371 
when mobile devices might be running older firmware versions. For more information on building the 2372 
alert center, see the following page. 2373 

The following steps walk through creating an alert to show out-of-date Apple devices: 2374 

1. Click the Home tab of MaaS360. 2375 

2. Under the My Alert Center, click the plus icon. 2376 

3. Fill out the Search Criteria as shown below. This rule creates a search that looks for devices that 2377 
are currently active and fall under the category of smartphones and tablets. To make sure that 2378 
we only look at Apple devices, the first condition has been set to match devices that have been 2379 
manufactured by Apple. The second condition sets the OS version to be no less than 14.8. 2380 

https://www.ibm.com/docs/en/maas360?topic=guide-maas360-portal-home-page
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 2381 

4. Click Save. 2382 

5. The My Alert Center will update with the results of the search, as shown below. 2383 

 2384 

8.3.5 Firmware Updates 2385 

The MaaS360 tool can push out firmware updates to devices that are corporate owned or enrolled as 2386 
supervised devices. The lab instance utilized this feature to push firmware updates to devices to meet 2387 
the firmware patching scenario. 2388 

Android device patching was covered in Section 8.3.3. The policy that was previously configured will 2389 
have Android devices automatically install software updates during a defined maintenance window. 2390 
Administrators can set the policy to automatically install updates as soon as they are available instead of 2391 
waiting for a maintenance window. This can be used to provide immediate patching in the case of 2392 
emergencies. Please consult the following page for more information on configuring policy for Android 2393 
system updates. 2394 

https://www.ibm.com/docs/en/maas360?topic=device-system-update-settings
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Apple iOS devices do not have a way for policy to be configured to automatically push out system 2395 
updates. However, administrators can still push out iOS updates to supervised devices through a manual 2396 
process. To push out an Apple iOS update to a group of devices, perform the following steps: 2397 

1. From the MaaS360 Portal click on Devices > Groups. 2398 

2. Under the Groups list, find iOS devices. Note that other device groups are automatically 2399 
available, such as iPhones or iPads, if an administrator does not want to push out the update to 2400 
all iOS devices. 2401 

3. Under the More button, select Push iOS Update. 2402 

 2403 

4. The Push iOS Update window will appear. Select Download and Install, then click the Continue 2404 
button. 2405 
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8.4 IBM MaaS360 with Watson Reporting 2406 

IBM MaaS360 has the capability to create a variety of reports that may help administrators gain better 2407 
insight of the enterprise’s mobile environment. Reports are available for hardware inventory, network, 2408 
app inventory, mobile data usage, user endpoint management overview, and app security settings. 2409 
Administrators can also customize reports and opt to have reports delivered on a daily, weekly, or 2410 
monthly basis. Reports are refreshed every 24 hours, and they are available for data that is up to 180 2411 
days old. There are also filters available that may be helpful with managing the report data. 2412 

Reports can be accessed by selecting REPORTS from the MaaS360 Portal, then choosing the type of 2413 
report that is needed. For example, the sample report from the lab shown in Figure 8-6 broke down 2414 
devices by platform to provide an asset inventory.  2415 

Figure 8-6 Sample Report from MaaS360 2416 

 

Figure 8-7 demonstrates the administrator’s ability to create reports based on the Security State, 2417 
Vulnerability, Mailbox Approval State, MDM Policy, ActiveSync Policy, and Details Report. 2418 

Figure 8-7 IBM Maas360 Report Options 2419 

 2420 

Additional instructions concerning managing reports in MaaS360 are available here. 2421 

https://www.ibm.com/docs/en/maas360?topic=reports-managing-in-maas360-portal
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9 Lookout 2422 

Lookout Mobile Endpoint Security (MES) is a SaaS-based mobile threat defense solution that collects 2423 
information from devices via the Lookout for Work mobile application. In our build, it provided 2424 
vulnerability scanning, assessment, and reporting for Android and Apple mobile devices. Also, we 2425 
integrated Lookout MES with IBM MaaS360 to provide security policy enforcement actions. 2426 

9.1 Integrating Lookout with IBM MaaS360 2427 

Lookout MES device enrollment can be accomplished without third-party integration. However, to 2428 
enforce installation, the Lookout for Work client must be managed and pushed via an MDM to mobile 2429 
devices. In our build, the MDM was IBM MaaS360 with Watson. Detailed information regarding 2430 
integrating Lookout and MaaS360 can be found here. Please note that you will need an account to view 2431 
the documentation. The following steps provide a high-level overview of integrating Lookout MES with 2432 
MaaS360: 2433 

1. Create an API user in MaaS360: This step creates a user in MaaS360 with the correct 2434 
permissions that can then be used for Lookout MES to access the MaaS360 API.  2435 

2. Create custom attributes in MaaS360: Lookout MES passes device state information back to 2436 
MaaS360. Custom attributes will need to be set up in MaaS360 so that the information passed 2437 
by Lookout can be stored by MaaS360 and used in policy enforcement. The following attributes 2438 
are created: 2439 

 lookout_activation_state: This specifies whether the Lookout for Work app is installed and 2440 
activated on the device. 2441 

 lookout_device_state: This indicates the overall state of the device, such as secured, threats 2442 
detected, deactivated, or pending activation. 2443 

 lookout_disconnected: This indicates if there is a connection from the mobile device to 2444 
Lookout. 2445 

 lookout_threat_level: This categorizes the threat level of the device by none, low, medium, 2446 
or high. 2447 

 lookout_unreachable: This indicates if the Lookout MES server is reachable by the mobile 2448 
device. 2449 

3. Add the Lookout for Work app to the MaaS360 App Catalog. 2450 

4. Configure the MaaS360 connector from the Lookout Console. 2451 

https://esupport.lookout.com/s/article/Deploying-Lookout-with-IBM-MaaS360
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9.2 Adding Lookout for Work to the MaaS360 App Catalog 2452 

Adding the Lookout for Work iOS and Android applications to the MaaS360 App makes the application 2453 
available in the IBM MaaS360 app store. For supervised or corporate-owned devices, the application will 2454 
install automatically without further user interaction. More information for adding the Lookout for Work 2455 
App to MaaS360 can be found here. 2456 

The following steps provide an overview of the process of adding Lookout to MaaS360:  2457 

1. From the MaaS360 Portal, select APPS and then click Catalog. 2458 

2. Click Add and choose the OS required (iOS is chosen for this example). 2459 

 2460 

3. Next, select iTunes App Store App. Then enter Lookout Mobile Security in the search bar and 2461 
click Add. An example is found below. 2462 

https://esupport.lookout.com/s/article/Deploying-Lookout-with-IBM-MaaS360
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 2463 

4. Add the Lookout for Work configuration details so that when users open the application, it will 2464 
be automatically configured and connect to Lookout without further interaction. 2465 

9.3 Configuring MaaS360 Connector in the Lookout MES Console 2466 

To integrate Lookout MES with IBM MaaS360, perform the following steps: 2467 

1. Select Integrations in the Lookout MES console. 2468 

2. Enter the Label for the connection, MaaS360 URL, the API username and password, Access Key, 2469 
Apple ID, and Billing ID. An example is shown below. 2470 
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 2471 

After a successful integration, the Integration page should display the following: 2472 
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 2473 

9.4 Firmware Discovery and Assessment 2474 

Once Lookout for Work is activated, it collects details about devices that include the device’s OS version 2475 
and the patch level for Android devices, and then lists all CVEs associated with the device based on the 2476 
OS version and Android Security Patch Level (ASPL). The Lookout MES platform can discover firmware 2477 
(the OS running), and it displays this information under the Devices tab.  2478 

Once the Devices tab is chosen, a list of all connected devices are displayed in the window. Select a 2479 
device from the list to discover its firmware. Then information about the device’s firmware, including OS 2480 
and Security Patch level, can be found by scrolling down to the software section. An example of this 2481 
information is displayed in Figure 9-1. 2482 
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Figure 9-1 Example of Device Firmware Information 2483 

 

By click the View List button from the Unpatched CVEs section, administrators can see all CVEs that are 2484 
associated with the current OS and ASPL on the device. The Vulnerability Summary tab breaks down the 2485 
vulnerabilities associated with a device by severity. An example of this information is displayed in Figure 2486 
9-2. 2487 
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Figure 9-2 Example of Vulnerability Severity Information 2488 

 

9.5 Software Discovery and Assessment 2489 

The activation of the Lookout for Work client allows for the collection of running applications on the 2490 
device. For Android devices, Lookout collects an app inventory for the device which includes details 2491 
about app versions plus libraries and software development toolkits (SDKs) used by the apps. For iOS 2492 
devices, this information is obtained using the MaaS360 API. Lookout MES can also indicate if there are 2493 
vulnerabilities in the applications themselves.  2494 

The Lookout MES platform displays a risk grade which shows the risk that the app presents if it was 2495 
compromised. Lookout calculates this grade based on the application’s permission (what information it 2496 
can access). Each risk grade is on an A to F scale (A, B, C, D, or F). Lookout MES does not link applications 2497 
to specific devices unless a device fails a compliance check because of an installed application. For 2498 
example, if there is a rule that prohibits the installation of TikTok, only devices with TikTok installed will 2499 
be highlighted. 2500 

To view the applications that are installed on devices, select Apps from the Lookout MES dashboard. 2501 
Figure 9-3 shows a sample of the Apps page from our build. 2502 
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Figure 9-3 Lookout Apps Page Sample 2503 

 

9.6 Lookout MES Security Protections 2504 

Lookout MES allows organizations to set protection parameters for enrolled devices. Lookout comes 2505 
preconfigured with multiple templated rules that can be configured to meet organizational risk 2506 
tolerance. Policy enforcement can be accomplished through MES directly or via integration with an 2507 
MDM. 2508 

Our build utilized this feature to implement a rule to restrict network access to devices that had an out-2509 
of-date firmware level. The lab configured this rule by defining a minimum OS version and Android 2510 
security patch level and by choosing to alert the device’s user and block access to certain domains if the 2511 
minimum is not met. 2512 

To configure such a rule, perform the following steps: 2513 

1. Click on the Protection tab. 2514 

2. Scroll down to OS Out-of-date and select a risk level of High under the Risk Level dropdown. 2515 

3. Click the gear icon by the Risk Level dropdown menu. 2516 

4. Select the minimum compliant iOS and Android OS versions from the dropdown, as shown 2517 
below, then click Save changes. 2518 
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 2519 

5. From the Protections tab, click On-Device Threat Protection, and set Enable On-Device Threat 2520 
Protection to ON. 2521 

 2522 

6. Under the Response dropdown, choose Block domains and alert devices. 2523 

 2524 

7. Scroll down to Block specific domains and click a domain to add. 2525 
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8. Specify a domain that non-compliant devices should not access. Note that domains can be 2526 
added by CSV files. 2527 

9. Click Save changes. 2528 

9.7 Security Compliance Enforcement with IBM MaaS360 2529 

Lookout MES can pass custom attributes to MaaS360 for use in custom security compliance rules. This 2530 
integration was set up in Section 9.1. Our build utilized this capability to block access to corporate 2531 
resources for any device with a threat level of high by Lookout MES. Information on applying security 2532 
compliance rules for devices can be found here. 2533 

The following steps show how to create a security compliance rule using Lookout custom attributes: 2534 

1. Under the MaaS360 console click Security > Compliance Rules. 2535 

2. Click Add Rule Set. 2536 

3. Under the Rule Set Name Field, type in Lookout Custom Attributes and then click Continue. 2537 

4. Under the Basic Settings, ensure that the iOS and Android fields are checked, as depicted 2538 
below. 2539 

 2540 

5. Click on Custom Attribute Rules and fill out the following fields: 2541 

 Rule Name: Lookout Threat High 2542 

 Select Attribute: lookout_threat_level (this corresponds to the threat level that Lookout 2543 
assigns to a device, which was configured in section 9.6) 2544 

 Select Criteria: Equal To 2545 

 Choose Value: High 2546 

6. Under Enforcement Action, click to Alert and then Block as shown below. 2547 

https://www.ibm.com/docs/en/maas360?topic=security-applying-compliance-rules-devices


DRAFT  

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 121 

 2548 

7. Click Save. 2549 
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Appendix A List of Acronyms 2550 

AD Active Directory 

ANC Adaptive Network Control 

API Application Programming Interface 

BIOS Basic Input/Output System 

CA Certificate Authority 

CLI Command Line Interface 

CPU Central Processing Unit 

CSV Comma-Separated Values 

CVSS Common Vulnerability Scoring System 

DEP Device Enrollment Program 

DHCP Dynamic Host Configuration Protocol 

DNS Domain Name System 

EPEL Extra Packages for Enterprise Linux 

EULA End User License Agreement 

FMC (Cisco) Firepower Management Center 

FQDN Fully Qualified Domain Name 

FTD (Cisco) Firepower Threat Defense 

GB Gigabyte 

GUI Graphical User Interface 

HDD Hard Disk Drive 

HTTPS Hypertext Transfer Protocol Secure 

IP Internet Protocol 

ISE (Cisco) Identity Services Engine 

IT Information Technology 

LDAP Lightweight Directory Access Protocol 

MAC Media Access Control 

MDM Mobile Device Management 

MES (Lookout) Mobile Endpoint Security 

MNT Monitoring 

MSI (Microsoft) Windows Installer 
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NAT Network Address Translation 

NCCoE National Cybersecurity Center of Excellence 
NIST National Institute of Standards and Technology 

OS Operating System 

OVA Open Virtualization Appliance 

OVF Open Virtualization Format 

PCI Peripheral Component Interconnect 

RaaS Returner as a Service 

RADIUS Remote Authentication Dial-In User Service 

RAM Random-Access Memory 

REST Representational State Transfer 

RPM RPM Package Manager 

SaaS Software as a Service 

SCCM (Microsoft) System Center Configuration Manager 

SGT Security Group Tag 

SMBIOS System Management Basic Input/Output System 

SMS (Microsoft) Systems Management Server 

SNMP Simple Network Management Protocol 

SP Special Publication 

SQL Structured Query Language 

SSH Secure Shell 

SSL Secure Sockets Layer 

TLS Transport Layer Security 

URL Uniform Resource Locator 

VLAN Virtual Local Area Network 

VM Virtual Machine 

VPN Virtual Private Network 

VPR Vulnerability Prioritization Rating 

WAN Wide Area Network 

WSUS Windows Server Update Services 
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